Hazard categories and special symbols

Read these instructions carefully and look at the equipment to become familiar with the device before trying to install, operate, service or maintain it. The following special messages may appear throughout this manual or on the equipment to warn of potential hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety label indicates that an electrical hazard exists which will result in personal injury if the instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey all safety messages that follow this symbol to avoid possible injury or death.

### DANGER

**DANGER** indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

### WARNING

**WARNING** indicates a potentially hazardous situation which, if not avoided, can result in death or serious injury.

### CAUTION

**CAUTION** indicates a potentially hazardous situation which, if not avoided, can result in minor or moderate injury.

**CAUTION** used without the safety alert symbol indicates a potentially hazardous situation which, if not avoided, can result in equipment damage.

### NOTE

Provides additional information to clarify or simplify a procedure.

**Please Note**

Electrical equipment should be installed, operated, serviced and maintained only by qualified personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of the use of this material.
Notices

FCC part 15 notice

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures.

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This Class B digital apparatus complies with Canadian ICES-003.

Network compatibility notice for the internal modem

The internal modem in meters equipped with this option is compatible with the telephone systems of most countries in the world, with the exception of Australia and New Zealand. Use in some countries may require modification of the internal modem's initialization strings. If problems using the modem on your phone system occur, please contact Schneider Electric Technical Support.
## Table of contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Safety precautions</td>
<td>7</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Introduction</td>
<td>9</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Front panel</td>
<td>19</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Templates and firmware</td>
<td>35</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Basic setup</td>
<td>45</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Security</td>
<td>49</td>
</tr>
<tr>
<td>Chapter 7</td>
<td>Communications</td>
<td>79</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Third-party protocols</td>
<td>99</td>
</tr>
<tr>
<td>Chapter 9</td>
<td>Time</td>
<td>117</td>
</tr>
<tr>
<td>Chapter 10</td>
<td>Demand</td>
<td>121</td>
</tr>
<tr>
<td>Chapter 11</td>
<td>Inputs / Outputs</td>
<td>129</td>
</tr>
<tr>
<td>Chapter 12</td>
<td>Energy pulsing</td>
<td>137</td>
</tr>
<tr>
<td>Chapter 13</td>
<td>Logging</td>
<td>145</td>
</tr>
<tr>
<td>Chapter 14</td>
<td>Revenue</td>
<td>157</td>
</tr>
<tr>
<td>Chapter 15</td>
<td>Power quality</td>
<td>169</td>
</tr>
<tr>
<td>Chapter 16</td>
<td>Displays</td>
<td>175</td>
</tr>
<tr>
<td>Chapter 17</td>
<td>TEST Mode</td>
<td>185</td>
</tr>
<tr>
<td>Chapter 18</td>
<td>Resets</td>
<td>193</td>
</tr>
<tr>
<td>Chapter 19</td>
<td>Setpoints</td>
<td>199</td>
</tr>
<tr>
<td>Chapter 20</td>
<td>Reports</td>
<td>203</td>
</tr>
<tr>
<td>Chapter 21</td>
<td>Verifying accuracy</td>
<td>207</td>
</tr>
</tbody>
</table>
Chapter 1  Safety precautions

Installation, wiring, testing and service must be performed in accordance with all local and national electrical codes.

**DANGER**

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
- Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA or applicable local standards.
- This equipment must only be installed and serviced by qualified electrical personnel.
- Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
- Always use a properly rated voltage sensing device to confirm that all power is off.
- Do not perform Dielectric (Hi-Pot) or Megger testing on this device.
- Connect protective ground (earth) before turning on any power supplying this device.
- Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

**NOTE**

Do not perform Dielectric (Hi-Pot) or Megger testing on the ION8800 because its internal surge protection circuitry starts functioning at levels below typical Hi-Pot voltages. Contact your local Schneider Electric representative for more information on device specifications and factory testing.
Chapter 2  Introduction

This manual discusses the PowerLogic™ ION8800 meter features and provides configuration instructions.

By the time you are ready to use this guide, your meter should be installed, most basic setup should have been performed, and communications/basic operation should have been verified. If the unit is not yet installed and operational, refer to the Installation Guide shipped with the meter.

This chapter provides an overview of ION8800 meters and summarizes many of their key features.

In this chapter

- **ION8800 meters** ................................................................. 10
  The ION meter in an enterprise energy management system ........ 11
- **Meter features** ................................................................. 12
  Measured parameters .............................................................. 12
  Rack-mount installation .......................................................... 14
  Data display and analysis tools ................................................. 14
  Supported protocols ............................................................... 15
  Communications options ....................................................... 16
  IRIG-B GPS time synchronization ........................................... 16
  I/O options ............................................................................ 16
- **Additional information** ....................................................... 18
ION8800 meters

PowerLogic™ ION8800 meters provide revenue-accurate, true RMS measurements of voltage, current, power and energy, and are complemented by extensive I/O capabilities, comprehensive logging, and advanced power quality measurement and compliance verification functions. The meters come with an extensive selection of pre-configured data screens and measurements, so you can use the meters as they are shipped from the factory or customize them to fit your unique requirements.

You can integrate the meters with ION™ software such as ION Enterprise™ or with other energy management, SCADA, automation and billing systems, using multiple industry-standard communication channels and protocols including IEC 61850.

Common meter applications

- Transmission and distribution metering
- Revenue and tariff metering
- Power quality compliance monitoring
- Power quality analysis
- Load management
- System stability monitoring
- Energy pulsing and totalization
- Instrument transformer calculation
- Transformer/line loss calculation
- Real-time system loss measurements
The ION meter in an enterprise energy management system

You can use ION8800 meters as standalone devices, but their extensive capabilities are fully realized when used with ION software as part of an enterprise energy management (EEM) system.

EEM systems give energy suppliers, service providers, and large industrial and commercial energy consumers the tools to meet all the challenges and opportunities of the new energy environment. EEM systems use real-time information and control to directly address a broad range of requirements throughout the power delivery chain and across an entire enterprise. These systems offer an integrated solution to managing new billing structures, distributed generation, energy purchasing, energy cost control, operational efficiency, and power quality and reliability.

Applications that include the meter typically require additional equipment. Display and analysis software tools are almost always used to manage, interpret and distribute the data measured or logged by a meter. There are usually a variety of tools used, and often these tools are connected using different communications standards and protocols. In many cases, a meter must also provide control capabilities and device-level data sharing.

The meter can adapt to many situations. Advanced communications allow data to be shared simultaneously across multiple networks, built-in I/O provides monitoring and control capabilities, and a variety of display and analysis tools to help you get the most from your power system.

---

**Power system connections**
- Phase voltage, phase current, ground current, and neutral current from Wye, Delta, or single-phase power systems

**Onboard I/O**
- Pulses
- Breaker Status
- Control Signals
- Energy Pulses

**Internet connectivity**
- WebMeter functionality
- XML compatibility

**On-site data display**
- 240 by 64 pixel LCD

**Remote data display**
- Vista screens
- WebReach screens
- WebMeter screens

**Data analysis tools**
- Power Monitoring Network
- Third-Party Software for Modbus, DNP 3.00, Mv90, DLMS, COMTRADE

**Communications**
- RS-232 and high speed RS-485
- Internal Modem
- Front IEC optical port
- 10 Base-T and 10 Base-FL Ethernet
- Protocols: ION, Modbus Master, Modbus RTU, Modbus TCP, DNP 3.00, ModernGate (modem to RS-485 gateway), EtherGate (Ethernet to RS-485 gateway), GPS: Arbiter, GPS: True Time/Datum, DLMS, IEC 61850, FTP

---

© 2012 Schneider Electric. All rights reserved.
Meter features

The ION8800 offers three base models: ION8800A, ION8800B, and ION8800C.

- Feature Set C -- Energy/tariff meter
- Feature Set B -- Feature Set C + EN50160 and IEC 61000-4-30 edition 2 Class S compliant power quality monitoring
- Feature Set A -- Feature Set B + IEC 61000-4-30 edition 2 Class A and power quality analysis (waveforms and transient capture with 1024 samples/cycle resolution)

Measured parameters

All ION8800 meters provide bi-directional, 4-quadrant, revenue-accurate or revenue-certified energy metering. The following is a selection of some parameters measured by these meters.

Energy

The meters provide all common active, reactive and apparent energy parameters.

- kWh delivered and received
- kWh, kvarh, kVAh net (delivered - received)
- kWh, kvarh, kVAh total (delivered + received)
- kvarh, kVAh delivered and received
- Volt-hours and amp-hours
- Integration of any instantaneous measurement

Energy registers can be logged automatically on a programmed schedule.

All energy parameters represent the total for all three phases. Energy readings are true RMS. Maximum range of energy readings is 999,999,999. Beyond this value, readings roll over to zero (0).

Demand

The meters support all standard demand calculation methods, including block, rolling block, and predicted demand. They can measure demand on any instantaneous value and record peak (maximum) and minimum demand with date and time-stamps to the second. Peak demand registers can be reset manually (password protected) or logged and reset automatically on a programmed schedule. Measurements include:

- kW, kvar, kVA demand, min/max
- Amps, Volts demand, min/max
- Demand on any instantaneous measurement
**Instantaneous**

ION8800 meters provide a choice of high-accuracy 1 second, or high-speed 1/2 cycle measurements, including true RMS, per phase and total for:

- Voltage and current
- Active power (kW) and reactive power (kvar)
- Apparent power (kVA)
- Power factor and frequency
- Voltage and current unbalance
- Phase reversal

** Harmonics **

The meter offers harmonic distortion metering, recording and real-time reporting, up to the 63rd harmonic for all voltage and current inputs.

- Individual harmonics (including magnitude, phase and inter-harmonics for the ION8800A meter)
- Total even and odd harmonics
- K-factor, Crest factor

** Min/max recording **

The meters record each new minimum and new maximum value with date and time-stamp for the following parameters:

- Voltage and current min/max
- kW, kvar, and kVA min/max
- Power factor
- Frequency
- Voltage unbalance
- Plus any measured value

** Power quality **

The meters measure and record the following parameters:

- Sag/Swells
- Transients (feature set A only)

ION8800 meters with feature sets A and B comply with the following power quality standards:

- EN50160
- IEC 61000-4-30 edition 2 (class A for ION8800A, class S for ION8800B)
Rack-mount installation

The ION8800 meter easily installs into new or existing IEC/DIN 43862 19" racks. The meter’s rear Essailec connectors provide common voltage and current measurements and energy pulsing pin-outs for reduced installation costs.

Data display and analysis tools

Display and analyze meter data with a wide variety of tools.

The front panel

Use the meter’s front panel interface for local monitoring and standalone applications. The bright LCD display lets you view real-time values and perform basic device configuration. The front panel is often used in combination with an ION software system, providing an interface for field personnel.

WebMeter embedded web server feature

Ethernet-equipped meters include WebMeter™ functionality — an on-board web server that provides quick and easy access to real-time energy and basic power quality information without special software. The meter’s built-in web pages display a range of energy and basic power quality information via an Ethernet connection, and support basic meter configuration tasks.

Meter internal e-mail server feature

You can configure the meter to automatically email high-priority notifications or scheduled system-status update messages to anyone, anywhere within the facility or around the world. You can specify the type of event that triggers an email alert, such as power quality disturbances or logged data at any pre-determined interval, and have your ION system administrator program the meter to respond with an email message when these events occur. Meter email messages are received like any email message by a workstation, cell phone, pager, or PDA.

XML compatibility

Your meter can exchange information using industry-standard XML format. This simple machine-readable format supports easy integration with custom reporting, spreadsheets, databases, and other applications.

ION Enterprise software

ION Enterprise allows the meter to be part of a networked information system with other meters and local and wide-area computer networks. ION Enterprise is recommended for all power monitoring systems where advanced analysis and non-critical control capabilities are required.
ION Enterprise provides tools for managing your power monitoring network, logging data, analyzing real-time and logged data, generating power system reports, and creating custom functionality at the meter level.

ION Enterprise also offers ways to remotely view information through a web browser: for example, through the WebReach and Web Reporter components of ION Enterprise, and through Microsoft Terminal Services.

See the *ION Enterprise Help* for more information.

**ION Setup Software Support**

ION Setup is a software tool designed specifically to configure and test meters. ION Setup offers an graphical interface for performing basic meter setup, installing templates into meters, upgrading firmware, viewing real-time data, resetting accumulated values, verifying meter accuracy and measurements, and setting up advanced security. Versions 2.1 and later support ION8800 meters.

**IEC 61850**

IEC 61850 is an Ethernet-based protocol designed for electrical substations. It is a standard (vendor-independent) method of communications, developed to support integrated systems composed of multi-vendor, self-describing devices. When properly configured, the ION8800 acts as a server in an IEC 61850 system.

**Alerting**

The meter can be configured to send alerts in response to power system conditions that you define, such as a power quality problem in your energy system (including surges, sages and swells), changes in relays, or required equipment maintenance. This allows you to automatically advise key people of problems to allow quick remedial action, notify software so logs can be uploaded from the site that initiated the alert, or service equipment on schedule.

You can configure the meter to send alerts to email, pagers, or to software such as ION Enterprise.

For more information on configuring alerting on the meter, see the *ION meter alerts* technical note and the Alert module description in the *ION Reference*. For more information on configuring alerting in ION Enterprise, see the online *ION Enterprise help*.

**Supported protocols**

You can integrate the meter into various industry-standard networks. Measured meter data can be made available to other devices using Modbus RTU, Modbus/TCP, IEC 61850, FTP, DLMS and DNP 3.0 protocols, as well as the MV-90 translation system. You can also configure the meter to import and log data from other devices on these networks. With these advanced communications functions, the power of the meter can be utilized in most existing power monitoring systems.
Any data display and analysis software that works with Modbus RTU, IEC 61850 or DNP 3.0 devices should also function with the meter.

**Communications options**

The standard meter includes an IEC 1107 front optical port for communications in the field. Ordering options include a Communications Module which offers a high-speed RS-485 port, a selectable RS-232/RS-485 port, an Ethernet port or fiber-optic port, and a 56 kbps internal modem. Depending on the hardware options purchased, up to five separate ports can communicate simultaneously.

**NOTE**

The communications module can be retrofit – it can be installed or replaced while the meter is in the field.

**IRIG-B GPS time synchronization**

Meters ordered with the optional IRIG-B configuration can receive input from GPS receivers that output unmodulated IRIG-B time code data, to help enable time synchronization with an accuracy of up to +/- 1 millisecond.

**I/O options**

The meter’s digital inputs and outputs connect to the Essairec connector on the back of the meter. Two different I/O configurations are available, each providing different capabilities. Additionally, two infrared ports (and corresponding LEDs) on the front panel are configured by default for energy pulsing.

**WARNING**

**HAZARD OF UNINTENDED OPERATION**

Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death or serious injury or equipment damage.

**Digital inputs**

The meter can be ordered with externally-excited digital inputs capable of detecting a pulse rate of 20 pulses/second and timestamping transitions with 1 ms resolution. They can be used for tariff inputs or other pulse counting applications.
Relay outputs

The meter can be ordered with both form C and form A solid-state outputs; one mechanical form C relay is standard on all meters. Refer to your meter’s installation guide for specifications.
Additional information

For more information on the meter, including documentation downloads and software tools, visit www.schneider-electric.com. Available documentation includes:

**Installation Guide**
This document is shipped with each meter. It details the mounting, wiring and basic setup of the device.

**Online ION Setup help**
The online ION Setup help has in-depth information on installation, setup and security of ION Setup. It also includes instructions on using the Setup Assistant to configure devices.

**ION Reference**
The ION Reference describes ION architecture and provides detailed descriptions of all modules in all ION meters.

**Online ION Enterprise Help**
The ION Enterprise online help system provides information and instructions on using ION Enterprise components.

**Technical Notes**
Technical notes provide instructions for using meter features and for creating custom configurations.

**Protocol Documents**
Each protocol document contains information explaining how our products interact with a protocol, such as DNP 3.0, DLMS, Modicon Modbus, IEC 61850, and MV-90.

**ION device template reference**
This document lists the default ION modules and their default configuration in the shipping template for the most recent firmware releases of ION meters.
Chapter 3  Front panel

The front panel of the ION8800 provides a user-friendly interface from which you can view system data or configure meter settings. A scrollable display and three distinct modes (NORM, ALT and TEST) provide easy access to the meter's functions through a simple three-button keypad.

Another set of buttons, protected under a sealable cover, provides advanced functionality.

This chapter describes the front panel and explains how to use it to display data, perform tests, and set up basic configuration options.

In this chapter

◆ Front panel features ................................................................. 20
◆ Display screen types .............................................................. 23
◆ Modes of operation ................................................................. 26
◆ Configuring the meter with the front panel ................................. 28
  Setup menus ........................................................................ 29
Front panel features

The front panel of the ION8800 includes:

- a liquid crystal display with detailed graphics and text
- navigation buttons to move from screen to screen, and for basic setup procedures
- operational LEDs to indicate meter conditions
- energy pulser ports and LEDs to aid in meter testing
- IEC 1107 optical serial port
- protected (sealable) buttons for advanced meter configuration

This section outlines the features available on the front panel of the meter.

Meter display

The meter’s display shows numeric data screens, event logs, phasor diagrams, bar graphs and harmonics histograms. As the graphic above illustrates, the display screen is divided into two sections: the main display area and the status bar.

The main display area presents meter data, while the status bar provides time, date, phase, quadrant, and mode information. During normal operation, the main display area automatically cycles through a series of several displays. If you prefer, you can use the Up or Down arrow buttons to step manually through these displays. By default, the automatic scrolling will resume 60 seconds after you have last pressed a button.
Navigation buttons

The navigation buttons are the Up and Down arrow buttons and the round Alt/Enter button. Pressing the Up or Down arrow buttons to manually scroll back or forth through the available displays temporarily halts the display screen’s automatic scrolling function. Pressing Alt/Enter toggles between NORM and ALT display modes. The automatic scrolling function restarts 60 seconds after a button was last pressed.

Hold the Alt/Enter button for approximately three seconds to display the Setup menu. You can then use the navigation buttons to view the device’s configuration or edit communication settings. See “Setup menus” on page 29 for further instruction on modifying the device’s configuration using the front panel buttons.

Operational LEDs

Three operational LEDs are located to the left of the display screen.

Alarm (top): The alarm output flashes to alert maintenance personnel should any internal diagnostic errors occur. Contact Technical Support if this happens.

Indicator (middle): This LED is user programmable and is not linked by default.

Power (bottom): This LED indicates the meter is powered. The light should always remain on when the meter is in service.

Energy pulser ports and LEDs

Two red LED pulser located below the front panel display are used for energy pulsing. The Wh pulser is the one of the right, and the varh pulse is the one in the middle. On the left is the optical port.

These LEDs are preconfigured for energy pulsing. Located directly beneath each LED is an infrared output, which is connected to the LED and pulses at the same rate. Pulse rates can be adjusted by re-configuring the Calibration Pulser module; for a detailed description of LED pulser operation, see “Energy pulsing with infrared ports and LEDs” on page 139.

Optical port and LED

An optical port facilitates infrared communication with the device. For details on how to configure and use this port, see “Optical port connections (COM1)” on page 82 and your meter’s installation guide.

A green LED pulser, located above the optical port, flashes to indicate communications activity on the port.
The following buttons can only be accessed when the meter cover is open:

**Demand reset button (B1)**

The recessed Demand Reset button resets the peak demand values logged in the meter. When the meter is in TEST mode, the Demand Reset button resets the test demand parameters.

The ION setup register labeled Demand Lockout Time sets the minimum time allowed between consecutive demand resets; the meter ignores any attempts to reset the demand outside the bounds of the register. The default value for the Demand Lockout time is 25 days. For details on the Demand Lockout Time setup register, see “Demand and Peak Demand module overview” on page 124.

**TEST mode button (B2)**

The recessed TEST mode button is located under the meter's front cover; it places the meter into TEST mode. While in TEST mode, the meter ceases accumulation of billable quantities; energy and demand measurements are accumulated in TEST mode registers.

See “TEST mode” on page 27 for more details on this mode of operation. Billable quantities do not accumulate when the meter is in TEST mode.

**ALT Config button (B3)**

The recessed ALT Config button is located under the meter's front cover; press this button to access the Alternate Configuration menu.

Use the Alternate Configuration menu to configure setup access via the front optical port, lock and unlock the meter, and clear alarms.

**Master Reset button (B4)**

The recessed Master Reset button is located under the meter's front cover; it resets meter values. Use the Master Reset button to delete most accumulated values and all derived revenue measurements from the meter. Refer to “Resets” on page 193 for more information.

**Spare button (B5)**

This button is currently not used.
Display screen types

The front panel displays measurements, configured settings and configuration data in a variety of forms. The types of display screens are described below. For information on customizing the display on your meter, see “Configuring front panel displays” on page 176.

The status bar

The status bar runs along the bottom of the front panel display and contains information about the following settings:

- Date and time.
- Voltage phases present. The labels and rotation of phases correspond to the configuration of the power monitoring system. 12 31 is for Delta configuration and 123 is four wire Wye configurations.
- Quadrant where the system power factor resides.
- Mode (NORM, ALT or TEST).
- Time remaining in the Rolling Block Demand interval. If the interval has counted to zero the letters EOI (End Of Interval) appear on the status bar. If the interval is counting down then a time remaining indicator appears.

Numeric displays

All NORM mode data and some of the ALT mode display screens use numeric displays. Numeric displays show up to four parameters at a time. If no numeric values are available for a parameter, N/A is displayed.

The front panel automatically scales the units for basic measurements (i.e. voltage, current and power parameters). For example, a measurement of 2,000 Watts is displayed as 2 kW. A measurement of 2,000,000 Watts is displayed as 2 MW. The meter makes these conversions using your PT and CT Ratios.
Nameplate display and event log

Nameplate displays and event logs appear in ALT mode and are organized in tabular format. Nameplate displays show owner, meter and power system details:

```
OWNER: Best Utility
TAG 1: Substation 13A
TAG 2: Main Feed 13K
FW Rev. FEATURE SET: 8800V310, A
BATTERY LIFE: 96.9%
DIAG NUM: 40/999
15:36:54 12/09/2005 Q1 ALT 3:39m
```

The Event Log displays recent high priority events. You must use ION Setup or ION Enterprise software to retrieve all logged data:

```
DATE TIME EVENT CODE
12/08/2005 10:23:45 Shutdown SD25
12/08/2005 10:42:03 Power Up SD25
VIEW EVENT LOG THROUGH COMMUNICATIONS
9:36:54 12/09/2005 123 Q1 NORM
```

Histogram displays

Harmonic content is displayed in histogram format. The 2nd to the 63rd harmonics are displayed in the histogram. The total harmonic distortion (THD) is displayed above the histogram.

```
U1 HARMONICS
THD: 50%
9:36:54 12/09/2005 123 Q1 NORM
```

Phasor diagram displays

Phase information can be displayed in phasor diagram format. Phasor diagrams are accompanied by tables that show phase, voltage and current magnitudes. In cases where a phase vector is too small to be represented graphically, it is shown as a table entry only.

```
U1 84.5 kV 0
U2 88.5 kV 240
U3 84.6 kV 120
I1 200 A 20
I2 210 A 220
I3 204.5 A 120
9:36:54 12/09/2005 123 Q1 NORM
```
Disk simulator

This display simulates the behavior of a mechanical watt-hour meter indicating power received or delivered by the direction of the pulse.

![Disk simulator display](image)

Time and date

This display supports time and date formats, enabling displays with nothing but date and/or time and/or time remaining in the current interval.

![Time and date display](image)

Time-stamped values

Up to three timestamped parameters can display on the same screen. The timestamp indicates the time that the displayed parameter was last updated.

![Time-stamped values display](image)
Modes of operation

The ION8800 has three modes of operation: NORM, ALT and TEST. Both NORM and ALT are display modes, providing various power system data and meter properties screens. TEST mode is used to perform diagnostics and verify the meter’s calibration and function.

**NOTE**

If your meter has the optional hardware lock, you must open the meter’s cover to put it into TEST mode. See “Meter security features” on page 50 for more information.

Basic operation (NORM mode)

The ION8800 meter defaults to NORM mode when powered up, and remains in this mode until you manually switch to ALT or TEST.

**NOTE**

You can customize NORM mode display screens and alter the front panel’s scrolling characteristics by editing the configuration of the meter’s Display and Scroll modules – see “Display Setup menu” on page 32 and “Displays” on page 175 for more details.

If you have a meter *without* the hardware lock, all of the settings available in the front panel Setup menus can be configured while the meter is in NORM mode, provided you have the correct password. If you have a hardware-locked meter, only the basic communications parameters in the COM Setup menu can be changed in NORM mode. (You must unlock the meter to change other meter parameters on the hardware-locked meter — see “ALT Config menu” on page 34 for more details.)

ALT mode

ALT mode provides scrolling display screens that show power system data, billing information (including extensive Time of Use data) and meter properties such as Nameplate information.

See “ALT mode default display screens” on page 180 for a description of ALT mode screens.

Switching to ALT mode

Press the Alt/Enter button to switch to ALT mode. Press the Alt/Enter button again to switch back to NORM mode at any time. If no buttons are pressed, the meter automatically reverts to NORM mode after five minutes. As with any mode, pressing any button temporarily suspends display screen scrolling, allowing you to press the Up or Down arrow buttons to manually browse the available screens.
**TEST mode**

TEST mode is typically used for verifying meter calibration and function. The meter is usually reading data from a test power supply while these functions are performed.

All of the billing quantities that are recorded when the meter is in NORM and ALT mode will stop accumulating when the meter is switched to TEST mode — the data is sent to special TEST mode registers instead. The values accumulated in these test registers are displayed on the front panel (and in ION Setup or ION Enterprise software).

The regular NORM/ALT mode billing registers are unaffected while the meter is in TEST mode; accumulation of this data continues as soon as you exit TEST mode. All test registers are reset to zero when you exit TEST mode.

For detailed information on TEST mode, see “Switching to TEST mode” on page 186.

**NOTE**

The meter will always return to NORM mode when you exit TEST mode, even if you entered TEST mode from ALT mode.
Configuring the meter with the front panel

With the meter’s front panel, you can navigate through different menus to perform basic setup on your meter.

Accessing the setup menus

To access the Setup menu, press and hold the front panel's Alt/Enter button while the meter is displaying power system data. Within the Setup menu is a list of sub-menus that contain the meter’s configurable settings. Setup menu items are described in “Front panel features” on page 20.

Press the Up or Down arrow buttons to navigate through the menu. Highlight a menu item and press the Alt/Enter button. When you select an item from the Setup menu, you will be presented with another menu of the settings in the meter. You may need to navigate several layers of menus to access the setting you want to change.

The following diagram shows how the buttons are used to navigate the menus:

The settings contained in the main Setup menu are:

- **Basic Setup:** settings for the power measurement system basic configuration.
- **Demand Setup:** settings for Rolling Block/Sliding Window Demand.
- **COM1 Setup:** settings for optical port setup.
- **COM2 Setup:** settings for optional RS-485 port setup.
- **COM3 Setup:** settings for optional RS-232/RS-485 multiplexed port setup.
- **COM4 Setup:** settings for the optional modem.
- **Network Setup:** settings for the optional Ethernet port.
- **Format Setup:** settings for customizing the style and values appearing on the display screens.
- **Display Setup:** settings for customizing display appearance, update time, and demand lockout time.
- **Security:** settings that allow you to modify your password, disable the password, disable meter configuration with a web browser, and acknowledge alarms.

Another setup menu, the ALT Config menu, is accessed by pressing a sealed button. See “ALT Config menu” on page 34 for more information.
Returning to previous setup screens

Use the Up or Down arrow buttons to scroll through the menu items. When the setting you want to change is highlighted, press the Alt/Enter button.

To return to a previous screen, highlight the RETURN menu item and then press the Alt/Enter button.

Configuring parameters using the navigation buttons

Use the Up or Down arrow buttons to change the value (if numeric) or the setting (if enumerated) of the highlighted parameter.

To change the position of the cursor, press and hold the Up or Down arrow buttons for about one second. The Up arrow button moves the cursor one position to the left, and the Down arrow button moves the cursor one position to the right. Once you have the value you want, press the Alt/Enter button to select it.

NOTE

When setting Ethernet values (IP address, default gateway, etc.), press the Up arrow button to insert additional digit spaces. Press the Down arrow to remove digit spaces (see “Network Setup menu” on page 31 for more information).

Out of range screen

When editing numeric data the numbers below MIN and MAX indicate valid entry bounds. If you enter a value outside valid bounds, you will be presented with an OUT OF RANGE screen. You can then either return to the register you were editing or choose to exit.

Confirming configuration changes

The CONFIRM screen appears whenever you attempt to change the meter’s settings through the front panel. This allows you to abort an unwanted configuration change. The front panel also informs you when an entry is out of range. In either case, you must press the Alt/Enter button to return to the previous setup screen.

Setup menus

The following sections describe the various front panel setup menus.

Basic Setup menu

To view the Basic Setup menu via the meter’s front panel, press and hold the Alt/Enter button. Press the Up or Down arrow buttons to highlight Basic Setup then press the Alt/Enter button.

The Basic Setup menu lets you set volts mode, potential transformer (PT) and current transformer (CT) ratios and various other settings (such as I4 and voltage and current polarities) to help you ensure that your meter is adequately set for your application.
Many of the settings will be configured when the meter is initially put into service (the device will not operate properly until Volts mode and PT and CT ratios are set), but some settings may need to be changed to refine the device’s operation.

See “Basic setup” on page 45 for more information on the Basic Setup menu.

**Demand Setup menu**

To view the Demand Setup menu via the meter’s front panel, press and hold the **Alt/Enter** button. Press the **Up** or **Down** arrow buttons to highlight Demand Setup then press the **Alt/Enter** button.

The Demand Setup menu accesses the global settings for all of the revenue related Rolling Block (Sliding Window) Demand functionality in the ION8800 meter. The settings provided in the Demand Setup menu control the timing of these demand calculations.

See “Demand” on page 121 for more information on the Demand Setup menu.

**COM Ports Setup menu**

To make changes to communications settings via the meter’s front panel, hold down the **Alt/Enter** button for three seconds to enter the Setup menu, then press the **Down** arrow button to select the COM Setup you want. Depending upon the communications options ordered with your meter, the parameter settings available are as follows:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM1 Setup</td>
<td>Settings for the optical communications port.</td>
</tr>
<tr>
<td>COM2 Setup</td>
<td>Settings for the dedicated RS-485 port.</td>
</tr>
<tr>
<td>COM3 Setup</td>
<td>Settings for the selectable RS-232 or RS-485 communications port.</td>
</tr>
<tr>
<td>COM4 Setup</td>
<td>Settings for the modem.</td>
</tr>
<tr>
<td>Network Setup</td>
<td>Settings for the Ethernet communications port.</td>
</tr>
</tbody>
</table>

**Serial COM settings**

There are three main parameters that you must set or verify if your meter is connected to a serial network (including modem communications): **Unit ID**, **Baud Rate**, and **Protocol**.

**NOTE**

Other parameters, such as **TRANSMIT DELAY**, are used in advanced configuration or fine-tuning your system. Settings for the parameters mentioned above are commonly required to get your meter communicating.
Network Setup menu

There are two main parameters that you must set or verify if your meter is connected to an Ethernet network: IP address and Subnet mask address.

NOTE

There are other parameters, such as GATEWAY ADDRESS and SMTP ADDRESS, that are used in advanced configuration or in fine tuning your system. The parameters discussed here are the most common parameters required to get your meter communicating.

Configuring network settings through the front panel

Typically, your Network Administrator will provide you with the appropriate IP Address for the meter. The Subnet Mask and Gateway settings are only required if you have communications between multiple Ethernet networks and if subnetting is implemented.

NOTE

Configuring the IP Address, Subnet Mask, and Gateway registers incorrectly can cause network disruptions. See your network administrator for more information.

Use the navigation buttons to edit the values of the network settings so that they match your system addresses. As you configure the network addresses, the front panel automatically discards unnecessary leading zeroes from each three-digit grouping. The hidden leading zeroes appear (and disappear again) as you move the position of cursor across the network address.

In the example above, the highlighted zero is discarded as soon as you change the position of the cursor.

NOTE

Your meter’s MAC address is displayed for information purposes and is read-only.

See “Communications” on page 79 for more information on the communications menus.

Format Setup menu

Format Setup contains the following values that set labeling and formatting preferences.
### Display Setup menu

You can configure the following display preferences within Display Setup.

For more information, see “Displays” on page 175.

### Security menu

The settings in the front panel Security menu item allow you to:

- modify the existing meter password or reset it to the factory default
- disable the password security check
- enable web browser configuration on the meter
- acknowledge alarms

You require the valid password to enter the Security Settings menu. The default password is 0 (zero).
For more information, see “Security” on page 49.

NOTE
The password enables users to change the configuration of the meter. It is recommended that you change your password from the default when you put the meter into service.

If you have not yet entered your password, the meter’s front panel requires that you enter it before you can view the Security Setup menu. Use the Navigation buttons to enter numerical data. If you enter an incorrect password, the front panel will display an “invalid password” message and you will have to try again.

Modify password sub-menu
Use this sub-menu to change the password or to reset the password to the factory default (0).

From the meter’s front panel select SECURITY, then MODIFY PASSWORD. Two choices appear: MODIFY PASSWORD or FACTORY DEFAULT. Use the Up button to select MODIFY PASSWORD, or the Down button to select FACTORY DEFAULT.

Disable security sub-menu
Use this sub-menu to enable and disable password security on the ION8800. Disabling the password allows changes to all the meter’s settings through the front panel without a security check.

NOTE
It is highly recommended that any meters in the field have the password security check enabled. Non-secure access to critical settings in the meter, such as PT and CT ratios, is not advisable.

When you re-enable password security, the password is reset to the factory default of 0 (zero). You should re-enter a custom password at this point.

Disabling the password security check is necessary to write to the meter when it is a Modbus Slave device. See “The meter as Modbus slave” on page 101 for details about configuring your meter for third-party systems.

Web Config
Use this setting to enable/disable web browser configuration of the meter. See “Enabling and disabling web config access” on page 56 for more information.

Ack alarms
Selecting this acknowledges alarms; it is not a configuration setting.
ALT Config menu

This advanced menu is accessible by pressing the ALT Config button, located under the meter cover.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Range (Values)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR Config</td>
<td>Allows meter configuration via the front optical port</td>
<td>Disabled or Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Meter Lock¹</td>
<td>When meter is locked, most meter configuration is prevented, as are meter resets</td>
<td>Locked or Unlocked</td>
<td>Locked²</td>
</tr>
<tr>
<td>Clear Alarms</td>
<td>Sends a pulse to clear alarms when pushed</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

¹ After a meter is unlocked, it automatically relocks if you do not perform any configuration for 30 minutes. This function is not available on non-hardware lockable meters.

² Default = 'Locked' on meters ordered with Hardware Lock option.
   Default = 'Unlocked' on all other meters (setting is non-functioning).
Chapter 4 Templates and firmware

Your meter comes installed with a pre-configured default template. This template contains various frameworks which provide all the power measuring and analyzing functionality of the meter. Templates and frameworks can be used immediately without any user configuration. They can also be customized, reconfigured, and pasted from one meter to another.

For more information on templates, frameworks and ION modules, see the ION Reference.

Your meter’s operating system is known as firmware. When newer firmware is available for your meter, simply upgrade to the latest version for all the added features and functionality.

NOTE

Firmwares and templates for the various meter types (ION8800A, ION8800B and ION8800C) are not interchangeable. When upgrading firmware or re-installing templates, make sure that you choose the correct files for your meter type.

In this chapter

◆ Factory information ............................................................. 36
  Factory module settings .................................................... 36
  How to tag your meter ......................................................... 36

◆ Updating or restoring the template ................................. 37
  Meter I/O module behavior ............................................... 37
  Using the front panel ......................................................... 37
  Using ION Setup .............................................................. 37
  Using Designer ................................................................. 38

◆ Upgrading your meter ....................................................... 40
  General upgrading considerations .................................. 40
  Upgrading to compatible firmware and template versions .... 40
  Using a laptop computer to upgrade .................................. 40
  Upgrading devices via a ModemGate connection ................. 40
  Meter behavior when an upgrade fails ................................ 41
  Meter I/O module behavior ............................................... 41
  Upgrading firmware using ION Setup ............................... 41

Upgrading firmware using ION Enterprise .......................... 42
  Before using Device Upgrader ........................................... 42
  Using Device Upgrader ..................................................... 42
Factory information

The Factory module displays firmware version, serial number and other device information in read-only setup registers (read-only registers can be viewed but not changed).

Factory module settings

The device information provided is as follows:

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>A device type identifier (e.g. “8800” for the ION8800)</td>
</tr>
<tr>
<td>Compliance</td>
<td>A statement of whether the device is ION compliant or not</td>
</tr>
<tr>
<td>Options</td>
<td>Shows model number of meter</td>
</tr>
<tr>
<td>Revision</td>
<td>The meter’s firmware version</td>
</tr>
<tr>
<td>Serial Num</td>
<td>The meter’s serial number</td>
</tr>
<tr>
<td>ION Version</td>
<td>The ION version supported by the device</td>
</tr>
<tr>
<td>Template</td>
<td>The name of the template (framework) installed on the device at the factory</td>
</tr>
<tr>
<td>Device Namespace</td>
<td>This configurable string is used as the namespace attribute in the</td>
</tr>
<tr>
<td></td>
<td>GeneratedBy and Device elements of XML attachments.</td>
</tr>
<tr>
<td>Device Name</td>
<td>This configurable string is used as the name attribute in the GeneratedBy</td>
</tr>
<tr>
<td></td>
<td>and Device elements of XML attachments.</td>
</tr>
<tr>
<td>Nom Freq</td>
<td>The expected frequency of the power system being monitored</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Media Access Control address.</td>
</tr>
</tbody>
</table>

1 The MAC address of your meter cannot be changed, and is for information only.

The Factory module also contains numerous read-only setup registers that hold the calibration constants used at the factory.

How to tag your meter

Three configurable setup registers are provided for you to enter your company name and other text information you want stored in the meter:

Owner - This is a text register for storing user information (e.g. company name); it can be up to 255 characters in length.

Tag 1 - This is a text register for storing user information (e.g. device location); it can be up to 15 characters in length.

Tag 2 - This is a text register for storing user information (e.g. device number or identifier); it can be up to 15 characters in length.

Use ION Setup to configure these registers.
Updating or restoring the template

You may need to update or restore the meter’s template:

- If there is a new template with additional features or if you have configured one meter and want to configure others with the same settings.
- If you have made changes and want to return to the original configuration. The basic setup of the device can be retained, so the meter does not need to be taken out of service for a long period of time.

**NOTE**

If you restore the factory configuration, all recorded data and any custom features that you have created (such as custom alarms or custom data records) are lost.

Use ION Enterprise or ION Setup software to upgrade or restore the template.

**Meter I/O module behavior**

Your meter’s I/O state may change during an upgrade. The meter’s I/O will revert to their previous settings after the upgrade is complete.

**WARNING**

HAZARD OF UNINTENDED OPERATION

Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury or equipment damage.

**Using the front panel**

You cannot restore the factory configuration from the meter’s front panel.

**Using ION Setup**

1. Download your device’s latest template from www.schneider-electric.com. Save the .DCF file in the .../ION Setup/TEMPLATE folder for easy access.
2. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
3. Select **Setup Assistant > Template**.
4. Click the **Send to Meter** tab and click **Send**.
5. Select the .DCF file from the TEMPLATE folder and click **Open**.

6. The Template Paste Options screen appears. Select the check boxes for the settings you want to retain (not overwrite) and click **OK**.

Rapid Meter Programming pastes the template onto your meter. A dialog box confirms the paste was successful.

**Using Designer**

1. Display the meter’s main Configuration screen in Designer.

2. Select **Edit > Select All** then press **Delete**.

   The confirmation dialog box appears explaining that some modules will not be deleted (core modules cannot be deleted — scroll down in the dialog to see which standard modules will be deleted).

3. Click **OK** on the confirmation dialog box.

   After a brief wait the modules are deleted and the main meter Configuration screen is blank except for the Frameworks folder in the Advanced Setup area. (The Frameworks folder contains the folder of Core modules which cannot be deleted.)
4. Select **Edit > Select All** to select the Frameworks folder. This selects all subfolders and modules within the folder.

5. Select **Edit > Paste from Framework**, then select the appropriate .fwn file from the folder ...\ION Enterprise\config\fmwk\nd\. Click **OK**.

   The Factory module’s Default Template register tells you the filename for the default factory framework. (For details about framework files, contact Technical Support or visit www.schneider-electric.com.)

6. Click **Open**. The Paste Summary window appears.

7. Click on the first module, scroll down to the last module, hold the **Shift** key and click on the last module. This selects all of the modules.

8. While holding the Shift key, click on the check box to the left of the module name so you see a lock icon with a green check mark.

   **NOTE**

   Persistent modules can be overwritten in Designer. When pasting a default framework onto a meter, use lock-paste on the Persistent modules, not free-paste. A list of Persistent modules is available from Technical Support.

9. Select “Maintain external inputs” and click **OK** on the confirmation dialog box.

   A message appears indicating that Designer is pasting modules. All modules are selected when the paste is complete. Click anywhere in the background of the node diagram to deselect all of the modules.

10. Click the Power Meter shortcut in the Basic Configuration area to select it. Once selected, click **Reset** in the Designer toolbar or select **Edit > Reset**. This reverts the Power Meter to the settings it had before you deleted any modules (retaining the basic setup you previously had).

11. Select **File > Send & Save**. The factory configuration is now restored and any custom functionality you created is removed.

   **NOTE**

   The time required to complete steps 3, 5, and 11 may vary depending on your connection and the meter configuration.

See the Designer section in the ION Enterprise online help for more information.
Upgrading your meter

You can upgrade the firmware (operating software) and template on your meter using either ION Enterprise or ION Setup.

General upgrading considerations

Upgrading to compatible firmware and template versions

Ensure that the firmware version that you are upgrading to is compatible with your meter and that the version number is greater than your existing firmware (or else you will downgrade your meter).

Ensure that the template you are upgrading to matches the feature set of your meter (in other words, if your meter is an ION8800A, the template must be an A-variant template). The variant is indicated in the template filename.

You can download meter firmware and templates from www.schneider-electric.com.

Using a laptop computer to upgrade

Laptop computers generally have different default power properties than desktop computers. Incorrect power options can adversely affect device upgrading because the connection between the laptop and the device must be maintained in order to complete the upgrade successfully. If the laptop’s hard disk shuts down or the laptop enters system standby mode, this connection is broken and the upgrade procedure must be restarted.

If you are upgrading a meter using a laptop computer, follow these guidelines:

- Plug the laptop computer into a wall outlet. Do not run the laptop on its battery.
- Configure the hard disks so that they do not shut down after a certain period of time (for example, set to "never").
- Turn off power suspension (for example, system stand-by) and hibernate options.
- Disable options that power down the laptop when it is closed. This prevents a shut down if the laptop is accidentally closed.
- Disable the screen saver; screen savers can burden the CPU.

Upgrading devices via a ModemGate connection

The maximum acceptable baud rate for upgrading via ModemGate is 56.6 kbps. Ensure that the baud rate on the ModemGate communications port and the baud rate on the meter to be upgraded are set to this or lower.
Meter behavior when an upgrade fails

The meter allows three consecutive attempts to upgrade the meter. If the third attempt fails, an error is generated and you must power cycle the meter before you try again. Wait 30 seconds for the meter to reset after power cycling it before you try to upgrade again.

Meter I/O module behavior

The state of your meter’s I/O modules may change during an upgrade. They will revert to previous settings after the upgrade is complete.

⚠️ WARNING

HAZARD OF UNINTENDED OPERATION

Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury or equipment damage.

Upgrading firmware using ION Setup

Performing a device upgrade in ION Setup involves:

- upgrading the device firmware, and
- upgrading the device template.

You can download your device’s latest firmware and template from www.schneider-electric.com. Save the files in the ../ION Setup/TEMPLATE folder for easy access.

Upgrading the device firmware and template

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Template screen.

3. Click the Firmware Upgrade tab and click Upgrade. Enter your meter password (if prompted) and click OK.

⚠️ NOTE

If you want to retain customized meter template settings, other than those listed in the Template Paste Options dialog box (see Step 6), click on the Save to PC tab and click Save. Save your template as a .DCF file. Select this file in Step 5 instead of the file obtained from the website.

4. Browse to the .UPG file (device firmware) that you downloaded from the website and click Open. Type your ION Setup password when prompted and click OK.

5. Browse to the .DCF file (device template) that you downloaded from the website (or saved from your meter in Step 3) and click Open. The Template Paste Options dialog box appears.
6. Clear any options that you do not want to retain then click **OK**.
7. Track the progress of the upgrade.
   After the firmware download is complete, ION Setup attempts to verify the firmware. If the verification fails, contact Technical Support.
8. Click **Exit** when you get a message that the upgrade is complete.

### Upgrading firmware using ION Enterprise

ION Enterprise software includes a device upgrade utility named Device Upgrader. You access the Device Upgrader utility from the Management Console.

**NOTE**
Supervisor-level access (level 5) is required to upgrade the device.

### Before using Device Upgrader

Data stored in the meter's memory is lost during the firmware upgrade. This includes waveforms, Min/Max values, and information stored in the Data Recorder and Integrator modules. Ensure you save your meter’s data before you upgrade your meter.

You need the applicable upgrade (.upg) files for your meter, which are available from www.schneider-electric.com. Save these files in a folder that is accessible from your ION Enterprise computer.

For more information about using Device Upgrader, refer to the ION Enterprise online help.

### Using Device Upgrader

1. Stop the ION Log Inserter Service and the ION Virtual Processor Service.
2. Start Management Console.
3. Select **Tools > System > Device Upgrader**. Type your username and password in the login prompt.
   A dialog box displays recommendations and warnings regarding the upgrade operation. Make sure you read and understand these warnings before you click **OK**. If you need to implement any changes because of the recommendations and warnings, close Device Upgrader, make the changes then re-open Device Upgrader and continue.
   The Device Upgrader utility appears.
4. Select your meter type from the **List Devices of Type** box.
5. Select the appropriate meter from **Select Devices to Upgrade** box. To select multiple devices, hold down CTRL while clicking each device.
6. Click **Select File** in the **Select Revision** section. Locate and select the upgrade (.upg) file that you downloaded from the website, then click **Open**.
7. Select or clear the **Save/Restore Framework** check box (selected by default). If selected, this keeps a copy of your current framework template during the upgrade. After the firmware upgrade is complete, Device Upgrader restores your framework template.

**NOTE**

Device Upgrader loads new meter firmware that does not contain any framework templates. If you want to preserve customizations that you have made to your device framework, make sure you select **Save/Restore framework**. However, if you intend to replace the existing meter framework with a new one (for example, a new default meter template that you downloaded), clear **Save/Restore framework**. If you intend to replace the meter’s framework configuration with a new template, it is recommended that you upgrade using ION Setup. See “Upgrading firmware using ION Setup” on page 41 for information.

8. Specify how Device Upgrader responds to an unsuccessful upgrade in the **Failure Handling** section (you only need to do this if you are upgrading multiple devices):

   - Select **Halt After**, then enter a number in the box to specify how many attempts you want Device Upgrader to make before stopping during an unsuccessful upgrade. By default, the utility is set to stop after the first unsuccessful upgrade.

   - Select **Ignore All** to attempt to upgrade all of the selected devices regardless of the number of devices that do not upgrade successfully.

**NOTE**

Firmware upgrade error codes are described in the ION Enterprise online help.

9. Click **Select File** in the **Select Revision** section. Navigate to the upgrade (.upg) file that you want to use and click **Open**.

   This file will be downloaded to all the devices that are highlighted in the **Select Devices to Upgrade** list.

10. Click **Upgrade** to upgrade the selected device(s).

    The **Upgrade Status** box shows each stage in the upgrade process. The completed progress bar indicates what percentage of the upgrade is complete. Each completed upgrade is noted in the Upgrade Status box.

11. Restart the ION Log Inserter Service and the ION Virtual Processor Service.

**NOTE**

If the connection to the device is lost, or if power to the device is interrupted during an upgrade, restart the Device Upgrade utility procedure.
Chapter 5  Basic setup

This chapter explains how to perform basic meter setup using the front panel or ION Setup or ION Enterprise software.

In this chapter

♦ Introduction ......................................................... 46
  Configuring Basic Setup ........................................ 46
  Using the front panel ........................................... 46
  Using ION Setup .................................................. 47
  Using Designer .................................................... 47
  Power Meter module settings ................................. 48
Introduction

Basic configuration of the meter is provided by the Power Meter module. The Power Meter module is the main connection between the power system measurements and all other ION modules in the device. This module reports the values for all voltage, current and power measurements. The Power Meter module’s setup registers describe details of the power system being monitored. Many of the Power Meter module’s setup registers are configured when the meter is initially put into service, although the device cannot operate properly until the Volts Mode and PT and CT ratios are set. Some registers may need to be changed to refine the device’s operation.

See the *ION Reference* for more details on the Power Meter module.

Configuring Basic Setup

Use the front panel or ION Setup or ION Enterprise software to perform basic meter setup.

**Using the front panel**

The Basic Setup menu item provides access to the following power system settings.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting</th>
<th>Description</th>
<th>Range (values)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Setup</td>
<td>Volts Mode</td>
<td>The power system’s configuration – WYE, DELTA, etc.</td>
<td>4W-WYE DELTA 3W-WYE SINGLE DEMO</td>
<td>4W-WYE</td>
</tr>
<tr>
<td></td>
<td>PT Primary</td>
<td>The Potential Transformer’s primary winding voltage rating</td>
<td>1 to 999 999 999</td>
<td>120.00</td>
</tr>
<tr>
<td></td>
<td>PT Secondary</td>
<td>The Potential Transformer’s secondary winding voltage rating</td>
<td>1 to 999 999 999</td>
<td>120.00</td>
</tr>
<tr>
<td></td>
<td>CT Primary</td>
<td>The Current Transformer’s primary winding current rating</td>
<td>1 to 999 999 999</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>CT Secondary</td>
<td>The Current Transformer’s secondary winding current rating</td>
<td>1 to 999 999 999</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>I4 Primary</td>
<td>Primary rating for the I4 current transformer</td>
<td>1.0 - 999 999,00</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>I4 Secondary</td>
<td>Secondary rating for the I4 current transformer</td>
<td>1.0 - 999 999,00</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>U1 Polarity</td>
<td>The polarity of the Potential Transformer on U1</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>U2 Polarity</td>
<td>The polarity of the Potential Transformer on U2</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>U3 Polarity</td>
<td>The polarity of the Potential Transformer on U3</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>I1 Polarity</td>
<td>The polarity of the Current Transformer on I1</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>I2 Polarity</td>
<td>The polarity of the Current Transformer on I2</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>I3 Polarity</td>
<td>The polarity of the Current Transformer on I3</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>I4 Polarity</td>
<td>The polarity of the Current Transformer on I4</td>
<td>Normal or Inverted</td>
<td>Normal</td>
</tr>
<tr>
<td></td>
<td>Phase Rotation</td>
<td>Power system’s phase rotation</td>
<td>123, 132</td>
<td>123</td>
</tr>
</tbody>
</table>
Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.

2. Select **Basic Setup**.

3. Click the **PT/CT Ratios** tab.

4. Configure each register as required by selecting the parameter and clicking **Edit**.

Using Designer

Open your meter in Designer and navigate to the Core Modules. Right-click on the Power Meter module to edit.
Power Meter module settings

The Power Meter module contains the following setup registers:

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volts Mode 1</td>
<td>The power system’s configuration – WYE, DELTA, Single, etc</td>
<td>4W-WYE</td>
</tr>
<tr>
<td>PT Prim 1</td>
<td>The Potential Transformer’s primary winding rating for U1, U2, U3, and U4</td>
<td>120</td>
</tr>
<tr>
<td>PT Sec 1</td>
<td>The Potential Transformer’s secondary winding rating for U1, U2, U3, and U4</td>
<td>120</td>
</tr>
<tr>
<td>CT Prim 1</td>
<td>The Current Transformer’s primary winding rating for I1, I2 and I3</td>
<td>5</td>
</tr>
<tr>
<td>CT Sec 1</td>
<td>The Current Transformer’s secondary winding rating for I1, I2 and I3</td>
<td>5</td>
</tr>
<tr>
<td>I4 CT Prim 1</td>
<td>The Current Transformer’s primary winding rating for I4</td>
<td>5</td>
</tr>
<tr>
<td>I4 CT Sec 1</td>
<td>The Current Transformer’s secondary winding rating for I4</td>
<td>5</td>
</tr>
<tr>
<td>U1 Polarity</td>
<td>The polarity of the Potential Transformer on U1</td>
<td>Normal</td>
</tr>
<tr>
<td>U2 Polarity</td>
<td>The polarity of the Potential Transformer on U2</td>
<td>Normal</td>
</tr>
<tr>
<td>U3 Polarity</td>
<td>The polarity of the Potential Transformer on U3</td>
<td>Normal</td>
</tr>
<tr>
<td>I1 Polarity</td>
<td>The polarity of the Current Transformer on I1</td>
<td>Normal</td>
</tr>
<tr>
<td>I2 Polarity</td>
<td>The polarity of the Current Transformer on I2</td>
<td>Normal</td>
</tr>
<tr>
<td>I3 Polarity</td>
<td>The polarity of the Current Transformer on I3</td>
<td>Normal</td>
</tr>
<tr>
<td>I4 Polarity</td>
<td>The polarity of the Current Transformer on I4</td>
<td>Normal</td>
</tr>
<tr>
<td>Phase Order</td>
<td>The expected rotation of the voltage phases (ABC or ACB)</td>
<td>ABC</td>
</tr>
<tr>
<td>Phase Lbls</td>
<td>The phase label format assigned to the outputs (ABC, RST, XYZ, RYB, RWB or 123)</td>
<td>123</td>
</tr>
<tr>
<td>kVA tot Method</td>
<td>The method used to calculate kVA total (VECTOR SUM or SCALAR SUM)</td>
<td>Vector Sum</td>
</tr>
</tbody>
</table>

1 The registers are typically set when the device is commissioned. Changing the values of these registers while the device is in service is not recommended.

Once basic setup is performed (i.e. the PT/CT and Volts mode settings), typically there is no need to make further changes to the Power Meter module’s setup registers. Refer to the ION Reference for a detailed description of the Power Meter module’s setup registers.
Chapter 6  Security

All ION8800 meters offer Standard and Advanced meter security. Standard security is enabled by default from the factory. Advanced security allows you to configure more specific security settings, such as communications lockouts to limit the number of invalid login attempts, and to add up to 16 users, each with unique access privileges. Procedures for changing Standard and Advanced security settings using the front panel, ION Enterprise and ION Setup are detailed in this chapter.

There are also security features available for revenue meters.

In this chapter

◆ Meter security features ..................................................... 50
◆ Recommendations and best practices ................................. 51
  Time synchronization security considerations .......................... 52
◆ Standard meter security .................................................... 53
  Configuring Standard security using the front panel ...................... 53
  Configuring Standard security using ION Setup ......................... 57
  Configuring Standard security in Designer ................................. 59
◆ Configuring Advanced meter security ................................. 61
  Configuring Advanced security using ION Setup ......................... 61
  Configuring Advanced security using ION Enterprise ...................... 68
  Device security access for ION Enterprise services ....................... 69
◆ Factory access ............................................................... 71
  Configuring the Factory Address Minutes setup register ............... 71
  Factory access and Standard security .................................. 72
  Factory access and Advanced security .................................. 72
  Factory access examples ..................................................... 73
◆ Additional revenue metering security ................................. 75
  Hardware lock security option ............................................ 75
  Meter seals ................................................................. 76
Meter security features

NOTE
Do not lose your meter’s front panel or user password information. If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and erases all logged data.

Your meter includes the following security features:

Front panel security
Whether your meter has Standard or Advanced security, when you make configuration changes using the front panel of your meter you must enter a front panel password. Front panel password protection can be disabled, but this is not recommended. See “Configuring Standard security using the front panel” on page 53.

Meter security
Whether your meter has Standard or Advanced security, the protocol lockout, session timeout, meter access event logging and factory access features apply to the meter. By default, after eight invalid login attempts, the meter locks out (disables) access over that communication port or protocol. Invalid login attempts and lockouts are logged by default in the meter’s event log.

NOTE
Use the ION Setup’s Advanced security wizard or the advanced mode of ION Setup to configure these settings. Factory access can only be configured using the advanced mode of ION Setup.

Standard meter security
Anytime you make configuration changes to your meter you must enter a password. Standard security is enabled by default from the factory. See “Standard meter security” on page 53.

Advanced meter security
Advanced security allows configuration of up to 16 users (and the Factory user), each with unique access rights to the meter. Use the ION Setup Advanced security wizard to configure meter security settings that apply to both Standard and Advanced meter security. See “Configuring Advanced meter security” on page 61.

Revenue meter security
Your revenue meter can be protected by hardware locking and anti-tamper sealing. See “Additional revenue metering security” on page 75.

Software security
ION Setup or ION Enterprise software security adds access-level security to the meter. With ION Setup or ION Enterprise software, you can configure the meter to accept multiple users with different passwords and specify their access rights on the meter. ION Setup or ION Enterprise software security only applies to users who are accessing the meter via ION Setup or ION Enterprise software. ION Setup and
ION Enterprise software can also be configured with users that have specific rights to use the software; refer to the software's online help for more information. See “Device security access for ION Enterprise services” on page 69.

Recommendations and best practices

Recommended meter configuration

1. Enable front panel security.
2. Enable Advanced security.
   - Disable web server programming to help prevent configuration access to your meter over the web.
   - Disable Modbus programming to help prevent configuration access to your meter using Modbus.
   - Configure protocol lockouts to help minimize access to your meter.
   - Disable the Factory user.
   - Configure users and passwords to help minimize access to your meter.

**NOTE**

If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.

Password best practices

1. Change your meter’s front panel password from the default factory value of 0 (zero).
2. Make all meter passwords as complex as possible.
3. Record the meter’s front panel and user passwords in a secure location.

**NOTE**

If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.

4. Schedule regular changes to your meter’s front panel and user passwords.

Additional recommendations

1. Ethernet meters must be protected by a properly configured firewall that prevents Telnet access over port 23.
2. Device communication ports must be set to the Factory protocol only when necessary to permit access to Schneider Electric Technical Services and returned to their original settings as soon as possible.
3. The meter’s time synchronization source must be set to a secure communications port, and time synchronization is disabled on all other ports. Refer to “Configuring Standard security using ION Setup” on page 57.
4. For the highest level of security, use a hardware-locked, sealed meter with Advanced security enabled and configured.

**Time synchronization security considerations**

Depending on ION Setup and ION Enterprise settings, a workstation that connects to an ION8800 device can send a time synchronization signal and synchronize the meter's internal clock with the workstation's clock. This could cause overlaps in the Demand intervals, and timestamps in the data logs may not be accurate.

Ensure that the *TimeSync Source* setup register in the Clock module is set to a secure communications port. By default, the *Time Sync Source* setup register in the Clock module is set to COM1 - the optical port. Time synchronization broadcasts are only accepted through the optical port in this configuration. Use the Clock Setup Assistant in ION Setup to change this setting.

![Select CL1 Time Sync Source](image)

Ensure that time synchronization is disabled on all other ports.
Standard meter security

Standard meter security is enabled by default on all ION8800 meters; all configuration functions in the front panel are password-protected. The default password is factory-set to 0 (zero). By default, the meter locks out a protocol for 24 hours after eight invalid login attempts. If you have modified protocol lockout settings using the Advanced security wizard, those settings will be used in Standard security even if Advanced security is not enabled. These settings can also be modified using the advanced mode of ION Setup to edit the register values in the Security Options module.

If you make configuration changes to the meter via the front panel, the meter prompts you for its password before accepting any configuration changes. Similarly, if you make any configuration changes via ION Setup or ION Enterprise, you are prompted by the meter for its password (in addition to the password used to access ION Setup or ION Enterprise). Once you enter the correct meter password and confirm the new configuration, the change is set on the meter.

Configuring Standard security using the front panel

Navigate to the Security Setup menu. The following settings are available:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting</th>
<th>Description</th>
<th>Range (values)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>Modify Passwd</td>
<td>Modifies standard password</td>
<td>0 to 999 999 999</td>
<td>0</td>
</tr>
<tr>
<td>Security</td>
<td>Disable Security</td>
<td>Disables meter security</td>
<td>Disabled or Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Security</td>
<td>Web Config</td>
<td>Allows configuration through web server interface</td>
<td>Disabled or Enabled</td>
<td>Enabled</td>
</tr>
<tr>
<td>Security</td>
<td>Ack Alarms</td>
<td>Sends a pulse to acknowledge alarms when pushed</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Note that the front panel prompts you for the meter password before you make your first configuration change. You do not need to re-enter the password for each subsequent change. However, if you perform no additional configuration changes for five minutes, you will need to re-enter the Setup menu and provide the valid meter password to resume making changes. This is because the meter returns from setup mode to data display mode after five minutes of inactivity.

The meter password allows access to the meter's configuration through ION Setup or ION Enterprise and the front panel. The default password is 0 (zero).

Entering the password

The first time you try to make a change to any setting, you are presented with the password screen (shown below).
To enter the password:

1. To change the value of the highlighted digit, use the arrow buttons. The Up arrow increments the number and the Down arrow decrements it.
2. To change the position of the cursor, hold down an arrow button for about one second. The Up arrow moves the cursor left one position and the Down arrow moves the cursor right one position.
3. Once you have the value you want, press the **Alt/Enter** button.

### Changing the password

By default, the meter’s front panel password is set to 0 (zero) in the factory. The password can be changed to any number up to eight digits. Change the password from the default value to help improve meter security. To change the password:

1. Hold down the **Alt/Enter** button to access the Setup menu.
2. Scroll through the menu items using the arrow buttons, highlight SECURITY.
3. Press the **Alt/Enter** button to select SECURITY.

4. Enter the current meter password (see “Entering the password”, above). Once you enter the password, you are presented with the “MODIFY PASSWD” screen, as seen below:

5. Change the meter password.

---

**Note**

If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.
To change the value of the highlighted digit, use the arrow buttons. The Up arrow increments the number and the Down arrow decrements it.

To change the position of the cursor, hold down an arrow button for about one second. The Up arrow moves the cursor left one position and the Down arrow moves the cursor right one position.

6. Once you have the value you want, press the Alt/Enter button. You are prompted for your current password before the new password is saved.

**Enabling & disabling the password security check**

Disabling the password disables Standard security, allowing changes to all the meter's settings through the front panel or via communications without a security check. This procedure should only be used if the communications interface you are using does not support the meter's security protocols, and you have ensured your meter's configuration and data security using other means.

---

**NOTE**

Non-secure access to the meter is not advisable. It is highly recommended that any ION8800 devices in the field have the password security check enabled.

---

**Disabling the password security check**

Follow these steps to disable the password security check:

1. Press the Alt/Enter button to enter the Setup menu. Scroll down the menu with the arrow button. Press Alt/Enter again when SECURITY is highlighted.

2. Enter the valid meter password at the password prompt. You are then presented with the Security menu.

3. Scroll down and highlight the DISABLE SECURITY menu item and press the Alt/Enter button.

4. Select PROCEED then select YES at the following prompt.

A message appears on screen notifying you of how to re-enable password security (refer to “Enabling the password security check” on page 56). Your
5. Press the Alt/Enter button to return to the Setup menu.

Enabling the password security check

When you re-enable the password security, you are required to enter a new password. To re-enable password security:

1. Press and hold down the Alt/Enter button to enter the Setup menu. Scroll down the menu and select SECURITY.
2. Select MODIFY PASSWD and press the Alt/Enter button. The Modify Password Screen appears.
3. The message FAC DEFAULT appears in the middle of the Modify Password screen. If you want to use the factory default password, press the Alt/Enter button. If you want to set the password to a different number, use the instructions in “Changing the password” on page 54.

NOTE
Refer to “Password best practices” on page 51 for recommendations on how to configure your meter’s passwords.

4. Once you have entered your new password, press the Alt/Enter button.
5. Select YES to confirm the change and return to the Setup menu.

The password security check is re-enabled and all changes to the device’s configuration require the new meter password.

Enabling and disabling web config access

By default, remote configuration of the device via web browser is disabled, which is the recommended setting for improved meter security. Follow these steps to enable or disable your meter’s web configuration access.

1. Press the Alt/Enter button to enter the Setup menu. Scroll through the menu with the arrow buttons. Press Alt/Enter again when SECURITY is highlighted.
2. Enter the valid meter password at the password prompt. You are then presented with the Security menu.
3. Scroll down and highlight the WEB CONFIG menu item and press the Alt/Enter button.
4. Select ENABLED or DISABLED as required.

NOTE
Disable web config access unless you are actively using this feature.

5. Confirm the change and select RETURN to go back to the Setup Menu.
Configuring Standard security using ION Setup

You must be logged into ION Setup with supervisor authority in order to configure security on your meter.

**NOTE**

If you are writing to Modbus registers on your meter, use Advanced security.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.


3. Select Security Mode and click Edit (or double-click to edit). The Open File dialog box appears.

4. Select the Standard.scf file and click Open to edit. The configuration screen appears.
5. Select the check boxes of the security options you want enabled. Some options may be disabled (grayed out) because of existing security settings.

- To change the password, type a new meter password, then confirm the new password by typing it again. Refer to “Password best practices” on page 51 for more information.

**NOTE**

By default, after eight invalid login attempts, the meter locks out (disables) access over that communication port or protocol. Use the Advanced security wizard or the advanced mode of ION Setup to configure invalid login attempts and protocol lockout duration. The configured settings will be used for both Standard and Advanced security.

- **Allow Web Server programming** is disabled (cleared) by default. Disable web-based meter configuration for improved meter security.
NOTE
Changing communications port settings with the Allow Front Panel Programming setting cleared (unchecked) may cause loss of communications with your meter, and render it inoperable. In this case a factory reconfiguration of your meter is required, which resets your meter to its factory defaults and destroys all logged data.

6. Click Finish when you are done.
7. When prompted, you can save your security settings in a file.
   - Click Yes to save the settings in the default file or in a new file.

NOTE
The default security configuration files are set to read-only by default. To overwrite, right-click on the file in the Save As screen and select Properties. In the General tab, remove the checkmark beside the Read-only attribute and click OK. You should now be able to overwrite the default security configuration file.

   - Click No if you do not want to save the changes.

Configuring Standard security in Designer

1. Launch Designer with Supervisor access.
2. Select Options > Show Toolbox if the toolbox is not displayed.
4. Enter the meter password when prompted. You must enter the existing meter password before you can change security settings (the default is 0 [zero]). Click OK.
5. Type a new numeric password and confirm by re-typing in the Confirm Password field; refer to “Password best practices” on page 51.

NOTE
If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.

6. If you want to disable Standard security, select the Disable Standard Meter Security check box. Disable standard security only if the communications interface you are using does not support the meter’s security protocols, and you have ensured your meter’s configuration and data security using other means.

NOTE
Non-secure access to the meter is not advisable. It is strongly recommended that any ION8800 devices in the field have the password security check enabled.

7. Click OK to save your changes.
NOTE

Do not disable security unless it is absolutely necessary. Disabling Standard security leaves your meter configuration open to tampering (intentional or unintentional) through communications and the front panel.
Configuring Advanced meter security

Advanced meter security is available on ION8800 meters. Advanced security allows you to:

- Enable or disable Modbus, front panel and web programming.
- Add up to 16 users, each with unique access privileges.
- Configure communications protocol lockouts to limit the number of invalid login attempts permitted for a user using a particular password, protocol and communications method combination.
- Set the priority of login-related meter events.

NOTE

Use ION Setup or ION Enterprise to configure Advanced security. ION Setup has a Setup Assistant that guides you through Advanced security setup.

Entering an Advanced security user name and password in ION Setup or ION Enterprise

When you attempt to view data or make a change to a meter that has advanced security enabled, you are prompted for a user name and password.

1. Select a user or enter a valid Advanced security user name.

   NOTE
   
   User names are fixed as USER1 through to USER16. There is also a FACTORY user which is intended for Schneider Electric Technical Support and must be disabled when not in use.

2. Enter the appropriate password and click OK.

   NOTE
   
   If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.

Configuring Advanced security using ION Setup

Use ION Setup to configure Advanced security on your meter.
Step 1: Set basic security options

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select the Security screen.


4. Select the Advanced.scf file and click Open to edit. The Advanced Options dialog box appears.

5. On the Advanced Options configuration screen, select the check boxes of the security options you want enabled. Some options may be disabled (grayed out) because of existing security settings.
   - To change the meter's password, type a new meter password, then confirm the new password by typing it again. Refer to "Password best practices" on page 51 for more information.
   - Allow Web Server programming is disabled (cleared) by default. Disable web-based meter configuration unless you are actively using this feature.
   - Allow Modbus programming is disabled (cleared) by default. Disable Modbus programming unless you are actively using this feature.

6. Click Next. The Select protocol lockout options screen appears; see “Step 2: Configure communications protocol lockout options” on page 63.
Step 2: Configure communications protocol lockout options

The communications protocol lockout Advanced security feature allows you to set the number of invalid login attempts that each user can make using a particular protocol and communications method before being locked out (a user is defined as a user login and password combination). For protocols that are not session-based (ION and HTTP), you can configure how often the meter registers invalid login attempts. You can also configure the lockout duration for all configurable protocols. By default, all protocols are set to eight invalid attempts and a 24 hour lockout duration.

Once a user is locked out, the meter will not accept login attempts from that user on that protocol and communications method until the lockout duration has passed. For example, once USER01 has been locked out using ION over Ethernet, USER01 cannot access the meter using ION over Ethernet until the lockout duration has passed, even if USER01 enters the correct password. However, if the user enters the correct USER/password combination before being locked out, the invalid attempt counter is reset to zero. Invalid login attempts accumulate until the user has completed a valid login or been locked out.

You can also configure the event priority for meter access and protocol lockout events, so they can be viewed in the meter’s event log. By default, the Invalid login event priority is set to 128 and the lockout event priority is set to 255.

Configuring communications protocol lockout

See “Communications protocol lockout examples” on page 64 for examples of how these settings affect login and communications.

1. Select the check boxes beside the protocols for which you want to enable communications protocol lockout. By default, all protocols are selected.

2. Highlight a selected protocol and click Edit to modify the lockout values for that protocol.

   - Protocol lockout attempts specifies the number of invalid login attempts allowed per user/password combination before access is denied to that user over that protocol and communications method. This value can range from 0 to 255.

   **NOTE**

   If Invalid logins is set to 0, there is no limit to the number of invalid login attempts and that protocol will never be locked out. However, the invalid login attempt events are recorded if the meter access events are configured to record invalid access attempts.

   - Session timeout specifies the active duration for a protocol; during this time, repeated invalid login attempts using the same USER/password combination are not registered (repeated invalid attempts with different combinations are still registered). This only applies to protocols which not session-based, and send credentials with each packet. Configuring this setting helps prevent accidental lockouts and the meter’s event log from being filled with protocol access events. This value can range from 1 minute to 43200 minutes (30 days).
Click OK. Repeat for all protocols on which you want to enable communications protocol lockout.

3. Type the lockout duration, in minutes. The lockout duration specifies how long the meter ignores communication attempts by a user that is locked out. The lockout duration value applies to all lockout-enabled protocols, and has a default value of 24 hours.

Once a user is locked out, the user cannot access the meter using the same protocol and communications method, regardless of whether or not the user enters the correct USER/password combination.

4. Click Events to enter the event priority for valid login attempts, invalid login attempts and protocol lockouts. The event priorities apply to all lockout-enabled protocols. Enter “0” (zero) to disable event logging for a particular type of login attempt. By default, valid login events are zero, invalid login events are 128 and lockout events are 255.

5. Click Next. The Define individual users/passwords screen appears. Refer to “Step 3: Configure users” on page 66 for the next step in configuring Advanced security, and “Communications protocol lockout examples” on page 64 for scenarios describing protocol lockout behavior.

Communications protocol lockout examples

In the following examples:

◆ The configured users and their valid passwords are:
  ◆ USER01/password 11
  ◆ USER02/password 22

◆ For the ION protocol:
  ◆ Protocol Lockout is configured to allow 3 invalid login attempts by a particular user/password combination before locking the user out.
  ◆ Session timeout is set to 30 minutes.
For all protocols that can be locked out:
  - Lockout duration is set to 1440 minutes (one day).
  - The meter is configured to log invalid event entries and lockouts.

Scenario 1
This example illustrates what happens when a user repeatedly enters the same incorrect password when attempting to access the meter.

1. An access attempt is made using ION over Ethernet by USER01 but with a password of 0.
   The user is informed of the invalid attempt and cannot access the meter. The invalid attempt is logged in the event log and the counter of invalid attempts is incremented to 1.

2. The user attempts to access the meter again 10 minutes later with USER01/password 0.
   The user cannot access the meter but the event is not logged and the counter of invalid attempts is not incremented, because the session timeout has not elapsed.

3. The user attempts to access the meter again with the invalid USER01/password 0 combination 30 minutes after the initial attempt.
   Because the session timeout has elapsed, the event is logged and the counter of invalid login attempts is incremented to 2.

   - If the user attempts to login again after 30 minutes has elapsed with the same invalid USER01/password 0 combination, the event is logged and the counter of invalid attempts is incremented to 3. USER01 is locked out for the duration of the lockout time (1440 minutes), and cannot connect to the meter using ION over Ethernet, regardless of whether or not they subsequently try to login with the correct user/password combination. The lockout event is logged by the meter. USER01 can access the meter through another communications method (for example, ION over serial) if the user enters the correct USER/password combination.

   - If the user attempts to login with USER01/password 11, the access is allowed and the invalid login counter is reset to 0.

Regardless of the invalid attempts of USER01, USER02 can access the meter using ION over Ethernet if they enter the correct password; they are not affected by the lockout.

Scenario 2
This example illustrates what happens when different invalid combinations of user and password are entered.

1. An access attempt is made using ION over Ethernet by USER01 but with a password of 0.
   The user is informed of the invalid attempt and cannot access the meter. The invalid attempt is logged in the event log and the counter of invalid attempts is incremented to 1.

2. The user attempts to access the meter again with USER01/password 3.
The user is informed of the invalid attempt and cannot access the meter. In this case, this is considered a new invalid attempt because it is a different combination of user and password. It is logged in the event log and the counter of invalid attempts is incremented to 2.

3. The user attempts to access the meter again with USER01/password 4.

   The user is informed of the invalid attempt and cannot access the meter. Once again, this is considered a new invalid attempt and it is logged in the event log and the counter of invalid attempts is incremented to 3. The meter logs a lockout event.

   USER01 is locked out for the duration of the lockout time (1440 minutes), and cannot connect to the meter using ION over Ethernet, regardless of whether or not they subsequently try to login with the correct user/password combination. USER01 can access the meter through another communications method (for example, ION over serial) if they enter the correct USER/password combination.

Regardless of the invalid attempts of USER01, USER02 can access the meter using ION over Ethernet if they enter the correct password; they are not affected by the lockout.

**Step 3: Configure users**

Advanced security allows configuration of up to 16 users, each with unique access rights to the meter.

1. Select the check boxes of the users you want to configure (USER01 through USER16). Select the appropriate access for each user:
   - **Timesync**: set time on the meter.
   - **Read**: view any parameter except the security configuration.
   - **Peak Demand Reset**: perform a reset of peak demand values (for example, sliding window demand for kW, kVAR, kVA etc.).
   - **TEST Mode**: put the meter into Test mode.
   - **Full Meter Configuration**: configure any programmable register on the meter except for registers related to the security setup, registers that result in a demand reset, or actions that place the meter in Test mode.
◆ **Security Configuration:** configure Advanced security for the meter; full meter configuration must also be set to YES.

When configuring users, in most cases, you must set Read access to YES. However, you can set up a user without read access; for example, you can create a user who can only timesync the meter. In some cases (such as Advanced security configuration access), you must set multiple access options to YES. When you are configuring Advanced security, the software rejects unacceptable user configurations.

2. Select a user, then click **Password** to set a password for that user. Refer to “Password best practices” on page 51 for more information. Type the password in the **New Password** and **Confirm new password** fields and click **OK**.

**NOTE**

If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.
3. Click Finish when you are done configuring users. A prompt appears asking if you want to save your security settings in a file.
   - Click Yes to save the settings in the default file or in a new file.

   **NOTE**

   The default security configuration files are set to read-only by default. To overwrite, right-click on the file in the Save As screen and select Properties. In the General tab, remove the checkmark beside the Read-only attribute and click OK. You should now be able to overwrite the default security configuration file.

   - Click No if you do not want to save the changes.

### Configuring Advanced security using ION Enterprise

If you are using Designer software follow the instructions below.

1. Launch Designer software with Supervisor access. Select File > Open and select the meter you want to configure with Advanced security.

2. If the toolbox is not displayed, select Options > Show Toolbox.

3. If you do not want to allow front panel programming using the Standard security meter password then double-click on the Display Options module and change the Front Panel Programming register to disallow.

   **NOTE**

   Changing communications port protocols with the Allow Front Panel Programming setting unchecked may cause loss of communications with your meter. A factory reconfiguration of your meter may be required, which will return your meter to its factory defaults and remove all logged data.
**NOTE**
If you allow front panel programming when you set up Advanced security, the meter password (used in Standard security) is still active through the front panel. You may need to allow front panel programming if someone installs the meter in the field and needs to make setup modifications. Once the meter is installed, you can disallow front panel programming so that Advanced security user names and passwords must be used to view or change meter information.

4. Open the Meter Security Setup grouping window.
   For each user you want to configure, drag out a Security module from the Toolbox, and modify the appropriate access level setup registers.

5. Click **Change Password** at the bottom left of the module setup screen to configure a password. Refer to “Password best practices” on page 51 for more information. The default password is 0 (zero).

**NOTE**
If your meter’s front panel or user passwords are lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.

Click **OK** when you have configured the users.


7. Double-click on any setup register and use the drop-down menu to change the register setting or label.
   You must set the **Enable Advanced Security** register to Enabled. Refer to the Security Options module description in the **ION Reference** for more details.

8. Select **File > Send & Save**. Advanced security is now enabled on the meter.

---

**Device security access for ION Enterprise services**

If you are using your meter with ION Enterprise, some ION Enterprise services need constant access to the meter. These services include the ION Log Inserter Service, the ION Virtual Processor Service and ION Site Service.

When advanced meter security is enabled, these services may not have sufficient access rights to perform their operations. You must specify a user with sufficient access rights for these services.

For more information on these services, see the online ION Enterprise Help.

**NOTE**
You can configure a separate user for accessing services. If you encounter difficulties with ION Enterprise accessing the meter, it is likely that these services either do not have access rights or the original user name and password have changed; see the online ION Enterprise help for more information. The user configured to allow the services access to the meter may also be locked out as a result of invalid login attempts.
Allowing ION Enterprise services access to meters with advanced security enabled
2. Select the device (or select multiple devices) that has advanced security enabled, right-click and select Security. The Meter Security Settings dialog box appears.
3. Select the username you want from the dropdown list. The Match Password button becomes active. Select the check box if you want to allow this user to send time synchronization signals to the meter. Click OK.
4. Enter the valid password, re-type the password to confirm and click OK.

Allowing ION Enterprise services access to meters with standard security enabled
ION Enterprise services can automatically access meters with standard security when the meter is added to Management Console.
Factory access

Factory access is restricted to Schneider Electric Technical Support, and should only be enabled when requested by Schneider Electric authorized personnel.

The factory access security feature interacts with Standard and Advanced security to enable factory-level access to the device for the specific period of time entered in the Factory Access Minutes setup register, located in the Security Options module. The Factory Access Minutes register value can range from one minute to 19 years, and is set to 0 (zero) by default, which disables all factory access. The Factory Access Minutes setup register is only available on ION8800 firmware version v340 or later.

If the meter uses Standard security, when you press any of the meter’s front panel buttons, power cycle the meter, or edit the Factory Access Minutes setup register, factory-level access is enabled on the meter for the duration specified in the Factory Access Minutes setup register. If the meter has Advanced security enabled, the Factory user must also enabled. The meter will only permit factory-level access, with the correct login credentials, during this period and at no other time.

Configuring the Factory Address Minutes setup register

You must use ION Setup in advanced mode or the Designer component of ION Enterprise to configure the Factory Access Minutes setup register, located in the Security Options module.

Using ION Setup:

1. Connect to your meter in advanced mode.
2. Navigate to the Security Options Modules folder and double-click on the module in the right-hand pane.
3. Select the Setup Registers tab.
5. Enter the desired duration (in minutes) for factory access to be enabled.

**Tip**

Select Elapsed Interval Format from the drop-down list to enter day and hour and minute values.
Factory access and Standard security

If a user tries to login to factory-level access (using Telnet or Hyperterminal), on a meter with Standard security, both of the following conditions must be met before the meter can proceed with subsequent checks:

1. Factory Access Minutes setup register is not 0 (zero).
2. The user and password information for factory-level access has been entered correctly.

If both conditions are met, the meter checks the following to determine if access will be granted:

- Front panel button: if the time since one of the meter’s front panel buttons was pushed is less than the Factory Access Minutes register value, the user is given access.
- Power cycle: if the time since the meter was powered up is less than the Factory Access Minutes register value, the user is given access.
- Factory Access Minutes edit: if the time since the Factory Access Minutes register value was edited is less than the Factory Access Minutes value, the user is given access.

If any one of these conditions are met, the user is given access. If none of these conditions are met, the user is not given factory-level access on meters with Standard security even if they have entered appropriate user and password information.

Factory access and Advanced security

If a user tries to login to factory-level access (using Telnet or Hyperterminal) on a meter with Advanced security, all three of the following conditions must be met before the meter can proceed with subsequent checks:

1. Factory Access Minutes setup register is not 0 (zero).
2. The user and password information for factory-level access has been entered correctly.
3. The ION Factory user has been enabled.

NOTE
The Factory user can be enabled and disabled in the ION Setup Advanced security wizard, user configuration screen.

If all three of these conditions are met, the meter checks the following to determine if access will be granted:

◆ Front panel button: if the time since one of the meter’s front panel buttons was pushed is less than the Factory Access Minutes register value, the user is given access.

◆ Power cycle: if the time since the meter was powered up is less than the Factory Access Minutes register value, the user is given access.

◆ Factory Access Minutes edit: if the time since the Factory Access Minutes register value was edited is less than the Factory Access Minutes value, the user is given access.

If any one of these conditions are met, the user is given access. If none of these conditions are met, the user is not given factory-level access on meters with Advanced security even if they have entered appropriate user and password information.

Factory access examples

Scenario 1
This example illustrates how factory access functions on a meter using Standard security, with a Factory Access Minutes setup register value of 10, over a protocol that is not session-based.

NOTE
A protocol that is not session-based actively communicates login credentials while you are connected to the meter (for example, ION and HTTP).

1. The user pushes a front panel button on the meter (T=0). This starts the factory access duration of ten minutes.

2. Two minutes after the button press (T=2), Schneider Electric Technical Services requests factory-level access to the meter, with the correct login credentials, over HTTP. Factory-level access is granted.

3. Ten minutes after the button press (T=10), factory-level access is automatically logged out.

Any attempt to connect to the meter using factory-level access is now denied.

Scenario 2
This example illustrates how factory access functions on a meter using Advanced security, with a Factory Access Minutes setup register value of 5, over a serial port (a session-based protocol).
1. The user connects to the meter using ION Setup with Supervisor-level access.
   - In the Advanced security wizard, he enables the ION Factory user.
   - In the Communications tab, he sets the appropriate serial port protocol to Factory.

2. The user power cycles the meter (T=0). This starts the factory access duration of five minutes.

3. Two minutes after the power cycle (T=2), Schneider Electric Technical Services requests factory-level access to the meter, with the correct login credentials, over the serial port. Factory-level access is granted.

4. An hour after the power cycle (T=60), Schneider Electric Technical Services logs off factory-level access.

**NOTE**

With session based protocols, once factory-level access has been granted, it does not matter if the logged-in time exceeds the value of the Factory Access Minutes setup register.

The factory-level access period has expired, and must be restarted by pushing one of the meter’s front panel buttons, power cycling the meter, or modifying the Factory Access Minutes setup register.

5. The user connects to the meter using ION Setup with Supervisor-level access.
   - In the Advanced security wizard, he disables the ION Factory user.
   - In the Communications tab, he changes the serial port protocol from Factory back to its original setting.

**Scenario 3**

This example illustrates how remote factory access functions on a meter using Advanced security, over a protocol that is not session-based.

**NOTE**

A protocol that is not session-based actively communicates login credentials while you are connected to the meter (for example, ION and HTTP).

1. The customer contacts Schneider Electric Technical Services to request that they connect to a meter using factory-level access using the following information:
   - the username and password of an Advanced security user that has meter security configuration access, and the front panel password of the meter.
   - the meter’s Ethernet connection information.

2. Technical Services connects to the meter using ION Setup, entering the Advanced security username and password provided.
   - In the Advanced security wizard, he enables the ION Factory user.
   - Using the advanced mode of ION Setup, he changes the Factory Access Minutes setup register from 0 (default) to 30 (T=0).
3. Two minutes after editing the Factory Access Minutes setup register (T=2), Schneider Electric Technical Services requests factory-level access to the meter, with the correct login credentials, over HTTP. Factory-level access is granted.

4. Twenty minutes after editing the Factory Access Minutes setup register (T=20), Schneider Electric Technical Services finishes working on the meter and logs out of factory-level access.

5. Technical Services connects to the meter using ION Setup, entering the Advanced security username and password provided.
   - In the Advanced security wizard, he disables the ION Factory user.
   - Using the advanced mode of ION Setup, he changes the Factory Access Minutes setup register back to its default value of 0.

Schneider Electric Technical Services contacts the customer to indicate they are finished working on the meter and have restored the security settings, and recommends that the customer update their Advanced user password information and store their password information in a secure location.

**Additional revenue metering security**

Security features depend on the meter ordering options.

**All ION8800 meters**

All ION8800 meters come with traditional anti-tamper mechanical sealing points on the meter case and cover in addition to the ability to enable and configure Standard and Advanced security on the meter.

**ION8800 meters with Revenue Security Option**

ION8800 meters with the Revenue Security option have an additional hardware-locked security system that prevents modification of revenue quantities after the meter is sealed.

**Hardware lock security option**

To make configuration changes to billing parameters on a hardware-locked meter, you must first unlock the meter. The Meter Lock setting is located in the ALT Config menu, which is reached by pressing the **ALT Config** button under the anti-tamper sealed cover. You must physically press this button if you have a hardware locked meter; you cannot access the Alt Config menu through software.

Typical values that are protected include:

- kWh, kvarh, kVAh delivered, received, del-rec, del+rec.
- kW, kvar, kVA Sliding Window demand min and max values.
- Digital Outputs controlling the energy pulsing applications.
- All Power system settings, including PT and CT ratios.
For a complete list of locked values specific to your meter and its firmware, refer to the ION Device Template Reference.

**Meter seals**

The meter incorporates sealing bars and chassis screws with through-holes, through which traditional lead/wire seals can be inserted. When utilized, these lead/wire seals can help prevent unauthorized personnel from gaining access to meter internals or to buttons under the cover.

These seals are installed as follows:

1. Insert the sealing wire through **both** the screw hole and sealing bar.
2. Twist the wire and crimp the lead sealing tab on to the wire.
Chapter 7  Communications

This chapter includes general instructions for connecting and configuring all the communication ports on your meter.

For specific meter installation steps and specifications, consult your meter’s installation guide.

In this chapter

◆ Communications overview ........................................... 80
◆ Communications connections ........................................ 81
  Optical port connections (COM1) .................................. 82
  RS-485 connections (COM2 and COM3) .......................... 83
  RS-232 connections (COM3) ........................................ 85
  Ethernet connections ................................................. 86
  Internal modem connections (COM 4) ............................ 87
◆ Configuring meter communications ................................. 88
  Serial Communications Setup ...................................... 89
  Ethernet communications setup ................................... 91
  Modem communications setup ................................... 93
◆ Internet connectivity .................................................. 95
  WebMeter feature ..................................................... 95
  Meter email feature .................................................. 95
  FTP for IEC 61850 and COMTRADE ............................. 96
◆ Communications LEDs .............................................. 97
Communications overview

The following illustration shows all the possible communications connections to the meter.

COM1:
Optical port serial connection
COM1 provides an IEC 1107 Optical port (located on the front of the meter) that is used for serial communications. It supports these protocols: ION, Factory, Modbus RTU, DLMS and DNP 3.00

Ethernet port
This connection provides optional Ethernet or fiber optic communications.

COM2:
Selectable RS-485 serial connection
COM 2 provides an RS-485 serial port on either the Essailec connector or the Communications Module. It supports ION, GPS, EtherGate, ModemGate, Modbus RTU, DLMS, DNP 3.00, Modbus Master, and Factory protocols.

COM3:
Selectable RS-232 or RS-485 serial connection
COM3 is actually two ports: RS-232 for direct connections and RS-485 for serial connections. Both ports support these protocols: ION, Factory, EtherGate, GPS, ModemGate, Modbus RTU, Modbus Master, DLMS, and DNP 3.00. Note: you cannot use the RS-232 and RS-485 ports on COM3 simultaneously. Note: Modbus Master is only available on ION8800A and B meters.

COM4:
Internal modem
COM4 provides an optional internal modem, and supports these protocols: ION, Factory, Modbus RTU, DLMS, GPS, and DNP 3.00

ION8800 meters have numerous communication possibilities depending on your ordering options. See the table below for details.

<table>
<thead>
<tr>
<th>COM port</th>
<th>Interface type</th>
<th>Meter only</th>
<th>Meter with communications module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Optical</td>
<td>Standard</td>
<td>Standard</td>
</tr>
<tr>
<td>2</td>
<td>Selectable RS-485 (Essailec or Communications Module)</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>3</td>
<td>Selectable RS-232 or RS-485</td>
<td>N/A</td>
<td>Optional</td>
</tr>
<tr>
<td>4</td>
<td>Internal modem</td>
<td>N/A</td>
<td>Optional</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Selectable Ethernet or fiber</td>
<td>N/A</td>
<td>Optional</td>
</tr>
</tbody>
</table>
Communications connections

The following section provides reference for connecting to the meter’s various communication ports. For the most current communication specifications, see your meter’s Installation Guide.

Communications connections are made to the Essailec connector and the Communication Module, both found on the rear of the meter. Optical connections are made to the port on the front of the meter. See below for details.

NOTE

Meters ordered with I/O options B and C do not have RS-485 connections on the Essailec connector.

⚠️ DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA or applicable local standards.
• This equipment must only be installed and serviced by qualified electrical personnel.
• Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
• Always use a properly rated voltage sensing device to confirm that all power is off.

Failure to follow these instructions will result in death or serious injury.
Optical port connections (COM1)

The front optical port is designed to accept IEC 1107 magnetic couplers. It can be used to communicate real-time measurements to a portable PC or for basic meter configuration.
To enable communications from the optical port, configure the Comm 1 Communications module. The Protocol, the Baud Rate and Unit ID setup registers must properly match your system. When creating an ION site, ensure that RtsCts is disabled (set to No) in the COM1 serial site.

Refer to the Management Console section in the online ION Enterprise help for more details about adding serial sites.

**NOTE**
To allow meter configuration via the optical port, you must ensure IR Configuration is set to Enabled. See “ALT Config menu” on page 34 for more information.

**RS-485 connections (COM2 and COM3)**

RS-485 connections are made to the Essailec connector and the optional Communications Module, both found on the rear of the meter.

**NOTE**
COM2 is a selectable channel, which allows RS-485 communications via the Essailec connector OR the Communications Module. You cannot use both ports at the same time.

Up to 32 devices can be connected on a single RS-485 bus. Use a good quality, shielded twisted pair cable for each RS-485 bus. The overall length of the RS-485 cable connecting all devices cannot exceed 1219 m (4000 ft.). The RS-485 bus can be configured in straight-line or loop topologies:

**Straight-line topology**
Loop topology

General bus wiring considerations

Devices connected on the bus, including the meter, converter(s) and other instrumentation, must be wired as follows:

- Connect the shield of each segment of the cable to ground at one end only.
- Isolate cables as much as possible from sources of electrical noise.
- Use an intermediate terminal strip to connect each device to the bus. This allows for easy removal of a device for servicing if necessary.
- Install a ¼ Watt termination resistor ($R_t$) between the (+) and (-) terminals of the device at each end point of a straight-line bus. The resistor should match the nominal impedance of the RS-485 cable (typically 120 ohms – consult the manufacturer’s documentation for the cable’s impedance value).

RS-485 connection methods to avoid

Any device connection that causes a branch in the main RS-485 bus should be avoided. This includes star and tee ($T$) methods. These wiring methods cause signal reflections that may result in interference. At any connection point on the RS-485 bus, no more than two cables should be connected. This includes connection points on instruments, converters, and terminal strips. Following this guideline helps ensure that both star and tee connections are avoided.
RS-232 connections (COM3)

An RS-232 connection is made to the male DB9 connector (COM3) on the optional Communications Module, at the back of the meter. The meter acts as a DTE device in all RS-232 connections. Use a null modem cable for connecting a meter to a workstation or use a standard straight-through RS-232 cable for connecting to an external modem. In either case, one end of the cable must be equipped with DB9 female connector for mating with the meter. The maximum cable length is 15.2 m (50 feet).

**NOTE**

For RS-232 communications, COM3 hardware mode must be set to ‘RS-232’.

Computer connections

![Computer connections diagram](image)

Meter connections

![Meter connections diagram](image)
External modem connections

There are two Ethernet port ordering options available: Ethernet or fiberoptic. Both types of connectors plug into the Communications module on the back of the meter. The meter supports a maximum of eight simultaneous generic Ethernet connections with additional dedicated connections for Modbus Master over TCP/IP and IEC 61850.

- The optional Ethernet port:
  - is capable of data rates up to 10 Mbps

Ethernet connections

There are two Ethernet port ordering options available: Ethernet or fiberoptic. Both types of connectors plug into the Communications module on the back of the meter. The meter supports a maximum of eight simultaneous generic Ethernet connections with additional dedicated connections for Modbus Master over TCP/IP and IEC 61850.

- TCP/IP Modbus Mastering dedicated TCP connection. Connect with up to 10 Modbus slave IP addresses. Refer to “Third-party protocols” for Modbus information.
- 8 simultaneous connections. Protocols include ION, DNP, Modbus, etc.
- IEC 61850 dedicated connection for up to 4 IEC 61850 clients.
- 1 FTP connection
- SMTP Server (email) outgoing only.

The optional Ethernet port:
- is capable of data rates up to 10 Mbps
supports TCP/IP, ION, Telnet, DNP 3.0, IEC 61850, FTP and Modbus/TCP protocols.

**NOTE**

Ethernet connection should be made to **either** the Fiber port or RJ45 port, not both, or communications conflicts may result.

The EtherGate feature provides communications through an Ethernet connected device to a connected serial network (see “The EtherGate protocol” on page 92). Only one EtherGate connection is allowed per meter port at any given time.

**Internal modem connections (COM 4)**

The meter’s optional internal modem is manufactured for use in most countries — refer to the Notices at the start of this document for more details.

Modem connections are made to the Communication module on the back of the meter, via an RJ11 connector.

To enable communications through the meter’s internal modem, you must configure the Comm 4 Communications module. The **Baud Rate**, **Unit ID**, and **Protocol** setup registers must properly match your system, and the initialization string for the internal modem must be set up using the **ModemInit** register. See “Modem communications setup” on page 93 for more information.
Configuring meter communications

Communication settings are typically configured when the meter is initially put into service. A single Communications module controls each communications port on the meter. The modules’ setup registers define the parameters used for each port; these parameters vary according to the type of communications channel selected (i.e. RS-232, RS-485, Modem, Optical, Ethernet).

The Communication modules configure the following channels:

<table>
<thead>
<tr>
<th>Module name</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comm 1</td>
<td>Optical port on COM1</td>
</tr>
<tr>
<td>Comm 2</td>
<td>Selectable RS-485 port on COM2</td>
</tr>
<tr>
<td>Comm 3</td>
<td>Selectable RS-232 or RS-485 port on COM3</td>
</tr>
<tr>
<td>Comm 4</td>
<td>Internal modem on COM4</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Selectable Fiber or Ethernet port</td>
</tr>
</tbody>
</table>

Use the meter’s front panel or ION Setup to initially configure the meter’s communications. Once communication is established, Vista or Designer can also be used to make changes.

**NOTE**

Altering some settings of a communications channel that is in use can cause a loss of communications with the meter.

Refer to the Communications module description in the ION Reference for details about the setup registers in the Communications module.

**Communications protocols**

By default, all communication ports are configured to use the ION protocol. Using other protocols requires configuration of the Protocol setup register for the Communications module that controls the port you want to use. Not all protocols are available on all ports or on all meter types.

**Protocols Available - ION8800**

- ION
- Modbus RTU
- Modbus Master
- DNP 3.0
- DLMS
- GPS
- EtherGate
- ModemGate
Serial Communications Setup

Serial communications are available on COM1, COM2, COM3, and COM4. To enable communications through the meter’s serial ports, configure the applicable Communications module. The Protocol, Tran Delay, Baud Rate and Unit ID setup registers must properly match your system and can be set through the meter’s front panel or ION Setup or ION Enterprise software.

**NOTE**

The total number of possible serial connections is limited by the number of physical serial ports on the meter. The ION8800 has two physical serial ports.

Using the Front Panel

The current configuration of the meter’s communication ports are found in the various COM Setup menu items. Ethernet settings are located under Network Setup.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting</th>
<th>Description</th>
<th>Range (values)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM1</td>
<td>Protocol</td>
<td>Specifies which protocol is active</td>
<td>ION, Modbus RTU, DNP, DLMS, Factory</td>
<td>ION</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>Specifies COM port baud rate during serial communications</td>
<td>1 200 to 19 200</td>
<td>9 600</td>
</tr>
<tr>
<td></td>
<td>Transmit Delay</td>
<td>Specifies the meter’s transmit delay setting (in seconds)</td>
<td>0 to 1,0</td>
<td>0,010</td>
</tr>
<tr>
<td></td>
<td>Unit ID</td>
<td>Identifies the meter during serial communications</td>
<td>1 to 9 999</td>
<td>From serial number2</td>
</tr>
<tr>
<td></td>
<td>Serial Port</td>
<td>Parity and stop bits for the port</td>
<td>8N1,8N2,8E1,8E2,8O1,8O2</td>
<td>8N1</td>
</tr>
<tr>
<td>COM2</td>
<td>Protocol</td>
<td>Specifies which protocol is active</td>
<td>ION, Modbus RTU, Modbus Master3, DNP, DLMS, EtherGate, ModemGate, GPS: Truitive/Datum, GPS: Arbiter, GPS: Arbiter/Vorne, Factory</td>
<td>ION</td>
</tr>
<tr>
<td></td>
<td>Baud Rate</td>
<td>Specifies COM port baud rate during serial communications</td>
<td>300 to 57 600</td>
<td>9 600</td>
</tr>
<tr>
<td></td>
<td>Transmit Delay</td>
<td>Specifies the meter’s transmit delay setting (in seconds)</td>
<td>0 to 1,0</td>
<td>0,010</td>
</tr>
<tr>
<td></td>
<td>Unit ID</td>
<td>Identifies the meter during serial communications</td>
<td>1 to 9 999</td>
<td>From serial number2</td>
</tr>
<tr>
<td></td>
<td>Serial Port</td>
<td>Parity and stop bits for the port</td>
<td>8N1,8N2,8E1,8E2,8O1,8O2</td>
<td>8N1</td>
</tr>
<tr>
<td></td>
<td>Port Location</td>
<td>Specifies physical connection point for COM2</td>
<td>Essailec or Comm Module</td>
<td>Essailec</td>
</tr>
</tbody>
</table>
### Chapter 7 - Communications

#### PowerLogic ION8800 user guide

Page 90 © 2012 Schneider Electric. All rights reserved.

---

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting</th>
<th>Description</th>
<th>Range (values)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>COM3</strong></td>
<td>Protocol</td>
<td>Specifies which protocol is active</td>
<td>Same as COM2</td>
<td>ION</td>
</tr>
<tr>
<td></td>
<td>Baud Rate¹</td>
<td>Specifies COM port baud rate during serial communications</td>
<td>300 to 115 200</td>
<td>9 600</td>
</tr>
<tr>
<td></td>
<td>Transmit Delay</td>
<td>Specifies the meter’s transmit delay setting (in seconds)</td>
<td>0 to 1.0</td>
<td>0.010</td>
</tr>
<tr>
<td></td>
<td>Unit ID</td>
<td>Identifies the meter during serial communications</td>
<td>1 to 9999</td>
<td>From serial number²</td>
</tr>
<tr>
<td></td>
<td>Serial Port</td>
<td>Parity and stop bits for the port</td>
<td>8N1,8N2,8E1,8E2,8O1,8O2</td>
<td>8N1</td>
</tr>
<tr>
<td></td>
<td>RS232 or RS485</td>
<td>Specifies RS-232 or RS-485</td>
<td>RS-232, RS-485</td>
<td>RS-232</td>
</tr>
<tr>
<td></td>
<td>RTS/CTS Handshake</td>
<td>Specifies if hardware flow control is used during RS-232 communication</td>
<td>RTS with delay RTS/CTS</td>
<td>RTS + delay</td>
</tr>
</tbody>
</table>

| COM4 | Protocol | Specifies which protocol is active | ION, Modbus RTU, DNP, DLMS, GPS: Truetime/Datum, GPS: Arbiter, GPS: Arbiter/Vorne, Factory | ION |
| | Baud Rate¹ | Specifies COM port baud rate during serial communications | 300 to 115 200 | 9 600 |
| | Transmit Delay | Specifies the meter’s transmit delay setting (in seconds) | 0 to 1.0 | 0.010 |
| | Unit ID | Identifies the meter during serial communications | 1 to 9999 | From serial number² |

¹ 300 baud rate is only intended for paging applications.

² The factory set Unit ID is based on the serial number of the meter, using the last four numbers before the dash. For example, if the serial number is PA-0009B263-01, the Unit ID is set in the factory to 9263. After a factory reset, the unit ID number will default to 100.

³ Modbus Master is only available on ION8800A and ION8800B meters.

---

**Using ION Setup**

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.

2. Select **Communications > Serial Settings**.

3. Click on the various tabs to configure the four serial ports (Com1, Com2, Com 3 and Com4). To change a setting, select the parameter and click **Edit**.

---

![Setup Assistant](image-url)
Using Designer

Use Designer to enable serial communications on a meter port by configuring the associated Communications module.

1. Open your meter in Designer. Navigate to the Communications Setup framework.
2. Right-click the Communications module for the Com Port you want to configure and configure the setup registers to match your system.

Ethernet communications setup

To enable communications through the meter’s Ethernet port, configure the Ethernet Communications module. The *IP Address*, *Subnet Mask*, *Gateway*, and *SMTP Address* setup registers must properly match your system and can be set through the meter’s front panel or ION Setup or ION Enterprise software.

Using the front panel

The current configuration of the meter’s communication ports are found in the various COM Setup menu items. Ethernet settings are located under Network Setup.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting</th>
<th>Description</th>
<th>Range (values)</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Setup</td>
<td>IP Address</td>
<td>Specifies TCP/IP Ethernet address</td>
<td>000.000.000.000 to 255.255.255.255</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Mask</td>
<td>Specifies Subnet Mask</td>
<td>0.0.0.0 to 255.255.255.0</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Gateway</td>
<td>Specifies Ethernet gateway (if used)</td>
<td>000.000.000.000 to 255.255.255.255</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>SMTP Address</td>
<td>Specifies location of SMTP Server</td>
<td>000.000.000.000 to 255.255.255.255</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>MAC Address</td>
<td>Machine Access Control address</td>
<td>hexadecimal</td>
<td>N/A¹</td>
</tr>
</tbody>
</table>

¹ MAC address is factory set and is for reference only.

Use the front panel navigation buttons to edit the values of the network settings so that they match your system addresses.

As you configure the network addresses, the front panel automatically hides unnecessary leading zeroes from each three-digit grouping. The hidden leading zeroes appear (and disappear again) as you move the position of cursor across the network address.

89.123.40.056

In the example above, the highlighted zero is hidden as soon as you change the position of the cursor.

Using ION Setup

1. Open ION Setup and connect to your meter, using Basic Mode.
2. In the Setup Assistant, navigate to the Communications folder.
3. Click on the Network Settings folder to configure Ethernet communications.

4. Click on the various tabs to configure the meter’s TCP/IP, DNS, NTP and SMTP settings. To change a setting, select the parameter and click Edit.

Using Designer
1. Open your meter in Designer.
2. Navigate to the Communications Setup framework.
3. Right-click the Ethernet Communications module and configure the setup registers to match your system.

Meter network configuration and ION Enterprise
After you have wired your meter to the Ethernet network and performed basic setup, add the meter to your ION Enterprise network using the Management Console.

See the Management Console section in the online ION Enterprise Help for details.

The EtherGate protocol
When a meter installed on the Ethernet network has EtherGate enabled, a master device (such as a workstation running ION Enterprise software) can communicate through the meter to a serial network of devices wired to the meter’s COM port. EtherGate is available on serial ports COM2 and COM3. The protocol permits the direct transfer of data from up to 62 devices (31 devices per COM port).
Once you have the chain of serial devices installed, use ION Setup or the meter’s front panel to change the COM2 or COM3 Protocol setting to EtherGate. The transfer of data between protocols is then handled automatically.

Refer to *The ION Meter as an Ethernet Gateway* technical note for information on configuring your meter for EtherGate.

**Modem communications setup**

See “Serial Communications Setup” on page 89 for configuring COM4. Additional modem configuration required is explained in the following section.

**ModemInit setup register**

The *ModemInit* string register defines the initialization string for the internal modem, with a maximum of 47 characters. Edit the *ModemInit* register and enter the initialization string desired. The string is sent to the modem as soon as you download the COM4 module. Note that the string is also sent to the modem whenever the meter is powered up, or whenever the baud rate in the Comm 4 Communications module is changed. Any changes to the *Modem Init* or *Baud Rate* setup registers while the modem is online will cause the modem to disconnect from the phone line.

**Modem initialization strings**

Refer to the *Modem AT Commands* technical note for a complete list of AT commands for your modem.

**Adjusting the modem initialization string for CTR-21 compliant modems**

The table below shows the strings to add to the end of your modem configuration string setup register for each of three possible problems.
If your local modem (not the internal modem) is not already set up, configure it with the Remote Modem Configuration Utility according to the instructions in the online help. After the meter is installed and the internal modem is connected to the telephone network, the Com4 module can be configured using the meter’s front panel or ION software. To learn how to connect the internal modem to the telephone network, consult your meter’s Installation Guide.

### Adding a meter and a modem site to your ION Enterprise network

In the Management Console, add the meter with the internal modem and a modem site to your ION Enterprise network.

Consult the online ION Enterprise Help for details on commissioning an ION network, managing modem connections, setting up periodic dial-out, and configuring remote site event notification.

### The ModemGate protocol

The ModemGate feature creates a communications connection between the telephone network and an RS-485 serial network of devices. When you specify the protocol for a meter’s COM port as MODEMGATE, all data received by the meter’s internal modem is automatically transferred to the serial network. ModemGate is available on either COM2 and COM3, but you cannot use the protocol on both ports simultaneously.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Add to modem initialization string</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does not answer (modem does not detect ring tone)</td>
<td>*NC70</td>
</tr>
<tr>
<td>Does not dial (modem does not detect dial tone)</td>
<td>In order of preference: *NC70, *NC70X0, *NC8 (Italy only)</td>
</tr>
<tr>
<td>Does not detect busy signal</td>
<td>*NC70</td>
</tr>
</tbody>
</table>

ModemGate connections do not connect a workstation with ION Enterprise (or other master device) to the gateway meter’s COM2 or COM3 port, but rather the gateway meter’s internal modem port (COM4).
Internet connectivity

Ethernet-equipped ION8800 meters allow you to connect to the internet so that you can receive meter emails, view real-time data, and configure your system through a web browser from anywhere in the world. Your meter provides the following internet connectivity options:

- **WebMeter feature** — this onboard web server allows you to view real-time data and configure the meter through a web browser.
- **Meter internal email server feature** — receive data logs and email alerts from the meter.

WebMeter feature

WebMeter-enabled meters have an on-board web server. Built-in web pages display certain energy and basic power quality information and also support basic meter configuration tasks. A meter with the WebMeter feature can be connected to your corporate Ethernet network like any other network device, and you can access it with a standard web browser like Internet Explorer.

Refer to the *WebMeter Internal Web Server Feature* technical note to learn how to:

- view your WebMeter data on the Internet
- configure your WebMeter-enabled meter
- set up your network for the WebMeter feature
- enable/disable web browser configuration of the meter

Meter email feature

The meter e-mail feature allows your meter to send data logs as email attachments to a workstation, pager, cell phone, or PDA. In addition to the log export function, your meter can send email alerts.

Refer to the *Meter Internal Email Client Feature* technical note to learn how to:

- view meter email data
- set up your network for meter email data
- configure your meter to use meter email
  - set up the meter for your SMTP Server
  - set up the meter email feature to send alerts
  - set up the meter email feature to send data logs
FTP for IEC 61850 and COMTRADE

The meter can function as an FTP server, supporting IEC 61850 protocols and COMTRADE formatted waveform files. The FTP timeout period is 90 seconds on a control port. Only one simultaneous FTP transfer connection is permitted. To connect to your meter, ensure that your FTP software is configured to only use a single FTP connection. The recommended FTP software is Windows Explorer or WinSCP running on a Windows-based machine.

NOTE

To connect to your meter using Windows Explorer, you must include the login and password in the FTP connection string. For example, with Standard meter security (no user configured) and a front panel password of 2, to connect to a meter with an IP address of 123.45.6.78, the Windows Explorer connection string would be ftp://0:2@123.45.6.78.

The meter communicates via FTP on the following port:

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>Incoming commands connections</td>
</tr>
<tr>
<td>20</td>
<td>Active data connections</td>
</tr>
<tr>
<td>3000-3020</td>
<td>Passive data connections</td>
</tr>
</tbody>
</table>

File names are limited to ASCII characters that do not contain a blank space or /, \, *, ?, <, >, and have a maximum length of 64 characters.

For more information about using FTP for IEC 61850 or COMTRADE, refer to the IEC 61850 and ION Technology protocol document or the COMTRADE and ION Technology technical note.
The following table explains what the flashing LED lights on the back of the Communications module signify.

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet ACTIVITY</td>
<td>Green</td>
<td>Flashes as signals are transmitted and received for both Ethernet and Fiber ports</td>
</tr>
<tr>
<td>Ethernet LINK</td>
<td>Green</td>
<td>On as long as there is an active connection to either the 10 Base-T or 10 Base-FL ports</td>
</tr>
<tr>
<td>Internal Modem DCD</td>
<td>Green</td>
<td>Carrier Detect – Indicates the presence of a carrier signal (active connection to the modem)</td>
</tr>
<tr>
<td>Internal Modem RI</td>
<td>Green</td>
<td>Flashes when the modem detects rings (Ring Indicator)</td>
</tr>
<tr>
<td>COM4 TRANSMIT</td>
<td>Red</td>
<td>Flashes as signals are transmitted from the COM4 internal modem</td>
</tr>
<tr>
<td>COM4 RECEIVE</td>
<td>Red</td>
<td>Flashes as signals are received on COM4 internal modem</td>
</tr>
<tr>
<td>COM2 TRANSMIT</td>
<td>Red</td>
<td>Flashes as signals are transmitted from the COM2 RS-485 loop</td>
</tr>
<tr>
<td>COM2 RECEIVE</td>
<td>Red</td>
<td>Flashes as signals are received on COM2 RS-485 loop</td>
</tr>
<tr>
<td>COM3 TRANSMIT</td>
<td>Red</td>
<td>Flashes as signals are transmitted from the COM3 RS-232 connection or the COM3 RS-485 loop</td>
</tr>
<tr>
<td>COM3 RECEIVE</td>
<td>Red</td>
<td>Flashes as signals are received on COM3 RS-232 connection or the COM3 RS-485 loop</td>
</tr>
</tbody>
</table>

1 LED colors may differ from the standard red and green.
Chapter 8  Third-party protocols

This chapter explains how Modbus, IEC 61850 and DNP 3.0 protocols are implemented on the meter.

For instructions on using the meter with Modbus, DLMS, IRIG-B, IEC 61850 and MV-90 protocols, see the following documents:

- Modbus protocol and register map for ION devices protocol document
- Modbus and ION Technology technical note
- DLMS/COSEM and ION technology protocol document
- IRIG-B GPS Time Synchronization technical note
- IEC 61850 and ION technology protocol document
- MV90 and ION technology technical note

In this chapter

- Overview ................................................. 100
  Communications protocol configuration .................................. 100
- The meter as Modbus slave ................................................. 101
  Using the Modbus RTU protocol ........................................... 101
  Using the Modbus/TCP protocol ........................................... 102
  Configuring the meter as a Modbus slave ................................ 102
  Modbus slave modules ....................................................... 104
- The meter as Modbus Master .................................................... 105
  The factory Modbus Master configuration ................................ 105
- Configuring the meter as Modbus Master .................................... 106
- Using the DNP 3.0 protocol ..................................................... 109
  Configuring DNP 3.0 .......................................................... 109
- Using the IEC 61850 protocol .................................................. 111
  The default IEC 61850 configuration ....................................... 111
  Configuring IEC 61850 ........................................................ 111
Overview

All ION8800 meters support DNP 3.0, Modbus RTU and Modbus/TCP protocols; only ION8800A and ION8800B meters support Modbus Mastering, and only meters with Ethernet support IEC 61850.

While your meter is factory configured to send data (acting as Modbus Slave), it is not ready to receive data as a Modbus Master until you set up the necessary framework. The meter is also pre-configured to send DNP 3.0 data to a DNP Master. To configure your meter to act as an IEC 61850 server, you must load an IEC 61850 configuration file into the meter and configure and enable the IEC 61850 client connections.

Most Modbus and DNP slave modules, and IEC 61850 mapping modules on the meter are factory pre-set and only require basic configuration, such as communications setup.

NOTE

Changing the default factory third-party protocol frameworks and modules (or creating new frameworks to enable receive functionality) is an advanced setup procedure that requires an understanding of the protocol, as well as an understanding of the meter’s internal operation. Refer to the DNP modules, IEC 61850 modules and Modbus modules descriptions in the ION Reference, as well as the technical notes Multiport DNP 3.0 and ION technology, IEC 61850 and ION technology and Modbus and ION technology, as well as the protocol documents Modbus protocol and register map for ION devices, IEC 61850 and ION technology and the ION8800 DNP 3.0 Device Profile before proceeding.

Communications protocol configuration

In order to use the factory Modbus or DNP configuration, you must first assign the communications channel you want to use. By default, all communications ports are configured to use the ION protocol. Choose the 3rd-party protocol you want from the list of available protocols in the Communications module’s Protocol setup register. See “Communications” on page 79 for instructions.

Modbus RTU is available on each of the meter’s communications ports, and multiple ports can communicate using Modbus simultaneously. Up to three ports can use the DNP 3.0 protocol at any one time. Additional configuration is required to enable DNP slave functionality on multiple ports, beyond selecting the protocol on a communications port (see the Multiport DNP 3.0 and ION technology technical note for more information). IEC 61850 has dedicated Ethernet communications connections, and the IEC 61850 configuration process is detailed in the IEC 61850 and ION technology protocol document.
The meter as Modbus slave

All ION8800 meters can act as a Modbus Slave, using both the Modbus RTU and Modbus/TCP protocols.

See the Modbus and ION Technology technical note for more information on using your meter as a Modbus slave, and the Modbus protocol and register map for ION devices protocol document.

Using the Modbus RTU protocol

ION8800 meters acting as Modbus Slave devices can make any real-time data available through the Modicon Modbus RTU protocol. Modbus Master devices connected to the meter can access (read) this data or write data to the meter’s ION registers to make device configuration changes.

The factory Modbus slave configuration

The meter makes data available to Modbus Master devices using pre-configured Modbus Slave modules. These modules are linked to other modules in the meter that provide the energy, power and demand data. Once a communications channel is configured to use Modbus RTU protocol, the data is available to Modbus Master devices.

**NOTE**

Connect to TCP Port 7701 for Modbus RTU communications over Ethernet. The default Modbus unit ID of the meter over Ethernet is 100 but it can be changed to any value.

As the data available through the Modbus Slave modules is in a specific format, knowledge of the Modbus protocol and an understanding of the settings used in the meter are required to interpret the data provided.
Changing the Modbus configuration

If the factory Modbus configuration does not suit your needs, the existing Modbus Slave modules can be relinked to other parameters that you want to access through Modbus.

If your Modbus Master device requires data in a format different than that provided by the factory Modbus configuration, you can edit the setup registers in the Modbus Slave modules. These setup registers specify the Modbus format, scaling and base address settings. Refer to the ION Reference for details on the Modbus Slave module.

Using the Modbus/TCP protocol

Modbus/TCP defines the packet structure and connection port (port 502) for the industry standard TCP/IP protocol. The structure of a Modbus/TCP packet is very similar to the Modbus RTU packet except that it has an extra six-byte header and does not require the cyclic redundancy check (CRC). Modbus/TCP retains the Modbus RTU limit of 256 bytes to a packet.

Modbus/TCP communications

You can communicate to the meter using Modbus/TCP. Your meter must have the optional Ethernet port. Configure the meter to connect using port 502 to use Modbus TCP communications protocols.

NOTE

You cannot make an EtherGate connection to the Modbus/TCP network.

Configuring the meter as a Modbus slave

Using the front panel

You cannot configure Modbus through the meter’s front panel; you can only assign the Modbus protocol to communication ports (see “Communications” on page 79 for details).

Use ION Setup or ION Enterprise software to perform full Modbus configuration.
Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
3. Click the Modbus Slave tab.
4. Select the map name (in this example, the Default) and click Edit. Enter the meter password, if prompted. The Default map is displayed.

5. Edit, add, delete or set the name of Modbus Slave module registers as required.

Using ION Enterprise

Use Designer to configure Modbus slave functionality on your meter.

1. Open your meter in Designer.
2. Open the Modbus folder in the Third-Party Protocols section of your framework. Right-click on the Modbus Slave module you want to configure. The ION Module Setup dialog box appears. Select the setup register you want to change and click Modify, or double-click on the register.
3. Link the module inputs and outputs as required.

4. Click OK and select File > Send & Save when you are finished to save your changes.

See the online ION Enterprise Help for more information on modifying and linking modules in Designer and the ION Reference for details on the Modbus Slave module.

Modbus slave modules

Your meter is pre-configured with five modules. (ION8800 meters with the EN50160 ordering option have 11 additional modules). The Modbus registers and their parameters are described in the Modbus protocol and register map for ION devices protocol document, available from www.schneider-electric.com.

Importing data using Modbus RTU

It is possible to bring data into the meter using Modbus. Various ION registers can be written by Modbus Master devices by correlating the Modbus register number with the address of the ION register you want to write. When a Modbus register is written with a value, the corresponding ION register will be written, provided the Modbus RTU protocol is active on the communications channel that connects the Modbus Master to the meter.

You can use the Modbus RTU protocol to write values into ION external numeric, pulse and Boolean registers, allowing you to enable, disable and reset meter functions. You can also use the Modbus protocol to change setup register values in various ION modules to configure the meter’s operation.

**Note**

To bring data into the meter with Modbus RTU, you must disable the meter’s Standard (password) security.

**Note**

Writing to ION external Boolean or external numeric registers via communications at a high rate (faster than once per minute) can cause loss of data in the event of a power failure. Use of an uninterruptible power supply (UPS) is recommended for such heavy logging configurations.
The meter as Modbus Master

ION8800A and ION8800B meters can act as a Modbus Master using the Modbus RTU and Modbus/TCP protocols, and can support Modbus Mastering through serial connections between the ION8800 meter’s COM2 and COM3 ports and the Modbus Slave devices. Firmware versions 332 (v332) and later allow your meter to Modbus Master over TCP/IP using up to ten available TCP sockets.

The ION meter acting as Modbus Master can write data to (export) and read data from (import) Modbus Slave devices, using various ION modules. The data can be processed by the meter and sent out using other communications methods (email, ION Setup or ION Enterprise software, etc.). The meter can also send control commands or data directly to other devices on a Modbus network.

The factory Modbus Master configuration

There is no pre-configured framework for Modbus mastering on your meter. This functionality must be enabled by configuring the following modules in your meter’s framework.

ION modules for Modbus Mastering

Several ION modules work together to create Modbus mastering functionality on the meter. Your meter has some or all of these modules, depending on the model and firmware version. See the ION Reference for more information on these and other ION modules:

- **Modbus Master Device module**: reads data from a Modbus slave, which can be an ION meter or third-party device. This imported data can be used by other ION modules. The Modbus Master Device module references a Modbus Master Map module setup register to specify the Modbus format, scaling, and base address settings.

- **Modbus Master Map module**: provides a common place to hold setup information (used to decode a Modbus response) for specific device types. This information can then be referenced by multiple Modbus Master Device modules.

- **Modbus Master Options module**: maps any serial connection or Ethernet TCP socket from the Modbus Import, Modbus Export and Modbus Master Device modules to any serial communications port or unique IP address and port number.

- **Modbus Export module**: provides write functionality.

- **Modbus Import module**: provides read functionality. This data can then be used by other ION modules.

See the *Modbus and ION Technology* technical note for more information on configuring Modbus mastering.
Configuring the meter as Modbus Master

Using the front panel

You cannot configure Modbus through the meter’s front panel; you can only assign the Modbus protocol to communication ports (see “Communications” on page 79 for details).

Use ION Setup or ION Enterprise software to perform full Modbus configuration.

Using ION Setup

The Modbus Setup Assistant helps you configure Modbus Master functionality for your meter.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
3. Click on the Modbus Master tab.
4. Click Add to add a Modbus Slave device or Edit to modify an existing device. The Modbus Device screen appears.

5. Enter the Slave device’s name and a label suffix, and select the device type of the slave device (in this example, an ION6200).
6. Click **Connections** to edit the connection used by the Modbus Master to connect to this Slave device.
   - Serial Connections: Select the appropriate port from the drop-down list.

**NOTE**

The total number of possible serial connections is limited by the number of physical serial ports on the meter that support Modbus Mastering. The ION8800 has two physical serial ports that support Modbus Mastering.

- TCP Connections: Enter the IP address of the Modbus slave device, followed by the IP port (502). Up to ten unique IP addresses can be entered.

**NOTE**

The meter as a Modbus Master over TCP/IP will attempt to communicate to a slave for up to 100 seconds (as per the RFC1122 standard) before moving on to the next slave device.

7. Click **OK** to add the Slave device. The device now appears in the list. Continue adding devices by clicking **Add** until all your devices are entered.

See the *Modbus and ION Technology* technical note for more information.

**Using ION Enterprise**

Use Designer to configure Modbus master functionality on your meter.

1. Open your meter in Designer.

2. Update the Modbus Master Options module with the connection information for your Modbus slave device. Right-click on the module to access the ION Module Setup dialog. Configure the setup registers by selecting the setup register you want to change and clicking **Modify**, or by double-clicking on the register.

   - Serial Connections: Select the appropriate port from the drop-down list.
   - TCP Connections: Enter the IP address of the Modbus slave device, followed by a colon and then the IP port (502). Up to 10 unique IP addresses can be entered.
NOTE
The total number of possible serial connections is limited by the number of physical serial ports on the meter that support Modbus Mastering. The ION8800 has two physical serial ports that support Modbus Mastering.

3. Create a new Modbus Master Map module. The Modbus Master Map module has two setup registers:
   - Device Type: Enter the name of the device that you want to map. This name is referenced by the Modbus Master Device module.
   - Device Map: This is the data you want to access from the Modbus slave device, in the form of text strings containing the parameter label, register value, data format, etc.

4. Create a new Modbus Master Device module. Configure the setup registers in the Modbus Master Device module, ensuring that the Device Type value matches the setup register in the Modbus Master Map module.

5. Link the module inputs and outputs as required.

6. Select File > Send & Save when you are finished.

See the online ION Enterprise help for more information on creating, modifying and linking modules in Designer, and the ION Reference for details of module setup and output registers.
Using the DNP 3.0 protocol

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used in the electric utility industry for communications and interoperability among substation computers, Remote Terminal Units (RTUs), Intelligent Electronic Devices (IEDs, e.g. meters), and Master Stations.

The ION8800 meter can be integrated into a DNP network as a DNP Slave, using the DNP Slave Import, DNP Slave Export and DNP Slave Options modules. For more information on the various DNP modules, see the ION Reference.

Your meter supports a maximum of three concurrent connections (or “sessions”) using the DNP 3.0 protocol; one for each serial port, up to three using Ethernet, or a combination of both. Available combinations depend on the meter’s communications options. A session consists of all incoming and outgoing DNP Master/Slave traffic on one of the meter's communications ports.

Consult the DNP User's Group at http://www.dnp.org/ to learn more about the protocol.

The factory DNP 3.0 configuration

Your meter is pre-configured with a DNP framework that allows for basic DNP Slave functionality. DNP Slave Export modules are used to send data to the DNP Master while DNP Slave Options modules provide per-session settings such as communications options. Although some minor setup of the framework is necessary before it becomes enabled (assigning the DNP protocol to the communications ports etc.), most module settings should not require alteration.

For information on your meter’s default DNP map and factory configuration, see the ION8800 DNP 3.0 Device Profile.

Importing data using DNP 3.0

Data can be imported into the meter from a DNP control relay or analog output device. DNP Slave Import modules are used to take a DNP Analog output or Binary output object and map them into ION registers.

NOTE

DNP Slave Import modules are not part of the factory DNP framework and must be added manually. Refer to the DNP Slave Import module description in the ION Reference for details.

Configuring DNP 3.0

If the factory DNP configuration does not suit your needs, you can relink the existing DNP Slave Export modules to access a different set of parameters through DNP. Alternately, you can add additional DNP Slave Export modules and link the desired ION parameters to them.
If your DNP network requires data in a format different than that provided by the
factory DNP configuration, you can edit the setup registers in the DNP Slave Export
modules and the DNP Slave Options modules. Do not make any changes to the
DNP Slave Options modules’ setup registers unless you understand the effects
each change will cause. Refer to the ION Reference for complete details on DNP
Slave Export and DNP Slave Options module function.

For detailed information on configuring your meter to use DNP, see the Multiport
DNP 3.0 and ION Technology technical note.

Using the front panel

You cannot configure DNP through the meter’s front panel. You can only assign
the DNP 3.0 protocol to communication ports. See “Communications” on page 79.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup help for
instructions.


3. Click the DNP 3.0 tab.

4. Select the DNP feature you want to configure (Parameter Map in this example)
and click Edit.

5. The Setup Assistant guides you through DNP configuration. See the ION Setup
Online Help for more information.
Using the IEC 61850 protocol

IEC 61850 is an Ethernet-based protocol designed for electrical substations. It is a standardized method of communications, developed to support integrated systems composed of multi-vendor, self-describing IEDs (intelligent electronic devices) that are networked together to perform monitoring, metering, and real-time, non-critical protection and control.

**NOTE**
You must have an Ethernet connection on your meter to use IEC 61850.

Your meter can be integrated into an IEC 61850 system as an IED (or server), supporting a maximum of four concurrent IEC 61850 client connections and one FTP connection (used for transferring data or configuration files).

Use ION Setup to enable IEC 61850 control of your meter’s optional I/O ports and to map additional meter values into IEC 61850. See “Configuring IEC 61850” on page 111 for more information and safety precautions. All other IEC 61850-specific configuration is done using an IEC 61850 configuration tool and your IEC 61850 client software.

Additional information
For more information, refer to the following:

- **IEC 61850 and ION Technology** protocol document provides more information about how IEC 61850 is implemented on your meter.
- **ION Reference** describes the IEC 61850 ION modules.
- The IEC (International Electrotechnical Commission) website at www.iec.ch provides general information about the IEC 61850 protocol.

The default IEC 61850 configuration

Your meter’s factory template includes an IEC 61850 framework already configured with a default set of meter data mapped into IEC 61850. This default set of meter data is used in the default data sets and reports in the ICD files available from the website.

You must load a valid IEC 61850 configuration (CID) file into the meter in order to activate the IEC 61850 features of your meter.

Your meter has four (4) dedicated IEC 61850 client connections and one FTP connection.

Configuring IEC 61850

No meter port configuration is required for IEC 61850, but the meter must have an operating Ethernet connection for IEC 61850 client connections and for FTP transmission of configuration and data files.
Configuring additional ION data into IEC 61850

The IEC 61850 ICD file for your meter contains a comprehensive set of default data values. Additional meter data values can be made available in IEC 61850 by mapping the ION data to the GGIO Custom Analog or GGIO Custom Digital modules.

Using the front panel

You cannot configure IEC 61850 through the meter’s front panel.

Using ION Setup

In ION Setup:

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select Communications > 3rd Party Protocols and select the IEC 61850 tab.

   The CID status line indicates whether the meter has received and validated an IEC 61850 CID file and is operating as an IEC 61850 server:
   - **IEC 61850 stack running**: the meter has received and validated an IEC 61850 CID file and is operating as an IEC 61850 server.
   - **Missing CID file**: no IEC 61850 CID file is loaded into the meter.
   - **Invalid CID file**: the IEC 61850 CID file is invalid.

3. Select the custom option that matches the data you want to map and click Edit.

   Custom Analog allows you to map additional numeric (analog) values, and Custom Digital allows you to map additional Boolean/binary (digital) values into IEC 61850.

   **NOTE**

   Because Custom Analog and Custom Digital are ION modules, they can be configured at any time, regardless of CID status.

4. Expand the Available registers list and select the meter’s analog or digital value that you want to map into IEC 61850. Highlight the IEC 61850 leaf you want to
map onto and click the >> button to map the meter’s value to IEC 61850. Click the << button to remove the value. Select **Show all available registers** to show all the ION modules and their registers. Click **OK** to send your changes to the meter.

![Custom Analog](image)

### Configuring meter digital I/O control via IEC 61850

By default, your meter's I/O status values are available via IEC 61850. You can configure the meter to provide IEC 61850 control of the meter's optional digital output hardware ports by configuring the GGIO Onboard module (in ION Setup advanced mode) and the Digital Output module (through the ION Setup Assistant).

**NOTE**

Refer to "Configuring inputs and outputs" on page 135 for details on how to configure your meter’s digital inputs and outputs.

To control your meter’s digital outputs via IEC 61850, you must configure the Digital Output module’s *Source* register to be the IEC 61850 digital status value (*SPCS.stVal*) output register. This output register is written by the IEC 61850 system into the IEC 61850 GGIO Onboard module. You must also disconnect the Digital Input module’s *Status* output register from the IEC 61850 GGIO Onboard Digital Output Status input register or else you will create a circular reference and the modules will go offline. Refer to the **ION Reference** for details of the IEC 61850 GGIO Onboard module.

**WARNING**

HAZARD OF UNINTENDED OPERATION

- Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

*Failure to follow these instructions can result in death, serious injury or equipment damage.*
Using ION Setup

1. Connect to your meter in Advanced Mode. See the ION Setup Help for instructions.

2. Navigate to the GGPIO Onboard folder and double-click on the module in the right-hand pane.

3. Select the Setup Registers tab.

4. Select the SPCS Control Mode register that corresponds to the digital output you want to control through IEC 61850 and click Edit. A dialog box appears.

5. Select IEC 61850 CTLVAL from the dropdown list and click OK.

6. Select the Inputs tab.

7. Select the digital output Status register for the digital output that you want to control through IEC 61850. Click Delete.

**NOTE**

The digital input Status register must be deleted in order to prevent a circular reference that will cause the affected modules to go offline.

8. Click Send to send your changes to the meter.

9. Open the Setup Assistant for your meter. See the ION Setup help for instructions.

10. Select either:

   - **Onboard I/O > Form A Outputs** to configure a form A digital output for IEC 61850 control.

   - **Onboard I/O > Form C Outputs** to configure a form C digital output for IEC 61850 control.

11. Click the tab corresponding to the digital output that you want to control through IEC 61850.

12. Select Source and click Edit. The Input Selection screen appears.
13. Navigate to the IEC 61850 GGO Onboard module and select the `SPCS.stVal` output register that corresponds to the digital input.

![Image of Input Selection Window]

14. Click **OK** and **Send** to save your changes to the meter.
Chapter 9  Time

This chapter covers the meter’s clock and time synchronization.

In this chapter

◆ Meter clock ................................................. 118
  Configuring the meter clock ................................. 118
    Using the front panel .................................. 118
    Using ION Setup ...................................... 118
    Using Designer ...................................... 119
◆ Time synchronization .................................. 119
◆ Meter battery ........................................... 119
Meter clock

The Clock module controls the meter’s internal clock, which provides timestamps for data logged by the device. The clock needs to be configured properly to help ensure that logged data has accurate timestamp information. The Clock module also receives the time synchronization signals sent to it by the workstation running ION software, updating the device’s clock when required.

The Clock module’s Clock Source setup register defines how the meter’s internal clock auto-correction drift from its internally calculated time. A separate time source (such as a GPS receiver or a DNP Master) can be used to synchronize the clock through a communications channel. By default, the clock is set to synchronize from the line frequency.

See the ION Reference for more information on the Clock module.

NOTE
References to NTP in ION devices or documentation should be interpreted as SNTP.

Configuring the meter clock

Use ION software to change the meter’s clock settings.

Using the front panel
You cannot configure the time via the meter’s front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select Clock.
3. Click the Timezone tab to configure your meter’s clock settings. Select a parameter and click Edit to change.

4. Click the DST Settings tab to configure your meter’s daylight savings periods for up to 20 years. Select a parameter and click Edit to change.

**NOTE**

Typically, the DST Start and DST End registers do not have to be reconfigured for users in North America. The factory defaults are the DST start and end dates for 20 years, in UNIX time (the number of seconds since 00:00:00 UTC on Jan. 1, 1970).

**Using Designer**

Open your meter in Designer and navigate to the Meter Clock Setup framework. Right-click on the Clock module to edit. Refer to the ION Reference for detailed information on the Clock module registers.

**TIP**

When modifying setup registers of the Clock module, use the Format option to convert between UNIX and conventional time. Refer to the description of the Clock module in the ION Reference for more details.

**Time synchronization**

Time synchronization lets you synchronize your meter’s internal clock with all of the other meters, devices, and software in a network. Once synchronized, all data logs have timestamps that are relative to a uniform time base. This helps you achieve more precise sequence-of-events and power quality analyses. Use ION software to broadcast time signals across the network or utilize an external source (such as an NTP server or DNP Master) to synchronize your meter’s clock.

Refer to the Time Synchronization & Timekeeping technical note for more information on implementing time synchronization.

Refer to the DLMS/COSEM and ION Technology protocol document for information on time synchronization with DLMS.

For meters with the IRIG-B ordering option, refer the IRIG-B GPS Time Synchronization technical note that came with your meter.

**Meter battery**

The battery in the ION8800 meter keeps the real-time clock running when supply power is lost. Replace the battery if the meter has been stored for an extended period of time without power (longer than two years). If the meter will be without...
power for an extended length of time, disconnect the battery cable to help the battery maintain its shelf life of up to 10 years.

Refer to your meter’s *Installation guide* for instructions on replacing the meter battery.

**Event Screen/Event Log confirmation (unpowered meter)**

On an unpowered meter, the battery powers the internal clock. Removing the old battery effectively stops the meter’s clock until the battery is replaced. Once replaced, the clock restarts at its last known power-down time. The ION8800 logs this as an event, which can be viewed from the Event Log on the meter’s front panel (see “ALT mode default display screens” on page 180 for more information on navigating to the Event Screen). The Event Log appears as the following screen:

<table>
<thead>
<tr>
<th>DATE</th>
<th>TIME</th>
<th>EVENT</th>
<th>CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/08/2005</td>
<td>10:42:03</td>
<td>Information</td>
<td>450</td>
</tr>
<tr>
<td>9:36:54</td>
<td>12/09/2005</td>
<td>Q1 ALT</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**

Error codes are written at the time of power up, as indicated by their ION event timestamp.

The meter records the following event codes after battery replacement on an unpowered meter:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Explanation</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>450</td>
<td>Seen only in combination with a ‘600’ event.</td>
<td>Refer to 600, below.</td>
</tr>
<tr>
<td>600</td>
<td>Loss of up to 10 minutes of billing data and time late by as much as 10 minutes</td>
<td>Connect to the meter with ION software and synchronize the meter’s internal clock. See “Configuring the meter clock” on page 118 for more information. Double-check battery installation (if required).</td>
</tr>
</tbody>
</table>

For details on resetting the meter’s internal clock, see “Configuring the meter clock” on page 118.
Chapter 10  Demand

This chapter explains how to configure and view demand values on your meter.

In this chapter

◆ Configuring demand ................................................................. 122
  Using the front panel .............................................................. 122
  Using ION Setup .................................................................. 122
  Using Designer ..................................................................... 123
  Sliding Window Demand module settings .............................. 123

◆ Demand Forgiveness ............................................................... 124
  Additional information ........................................................... 126
  Configuring Demand Forgiveness .......................................... 127
  Using the front panel .............................................................. 127
  Using ION Setup .................................................................. 127
Chapter 10 - Demand

Introduction

Demand is a measure of average power consumption over a fixed time interval. Peak (or maximum) demand is the highest demand level recorded over the billing period. Sliding Window Demand modules are configured to calculate the average current demand and kW, kvar and kVA demand. The setup registers in the demand modules define time intervals for demand calculations, setting the sensitivity of the module’s operation.

See the ION Reference for more information about these modules.

Configuring demand

Use the front panel or ION software to change your meter’s demand settings.

Using the front panel

1. Press and hold the Alt/Enter button for a few seconds to access the Setup Menu.
2. Scroll using the Up or Down arrow buttons to select Demand Setup. Press the Alt/Enter button to access the Demand Setup menu.
3. Scroll to the desired parameters using the Up or Down arrow buttons. Press the Alt/Enter button to access each parameter.
   Use the Up or Down buttons to edit the value of each parameter.

   NOTE

   You may be prompted for the meter’s password the first time you attempt to change any values.

4. Select YES to confirm the change.

Using ION Setup

The Demand Setup Assistant helps you configure Sliding Window Demand. This screen also contains two registers used for configuring Sliding Window Demand while the meter is in TEST mode.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Click Demand.
3. Click the **Rolling Block** tab.

4. Select a parameter to configure and click **Edit** (or double-click a parameter to edit).

**Using Designer**

Open your meter in Designer and navigate to the Demand Setup framework. Right-click on a Sliding Window Demand module to edit.

For Time-of-Use Demand setup, navigate to the Time-of-Use Framework folder.

**Sliding Window Demand module settings**

Sliding Window Demand is often referred to as Rolling Block Demand. To compute sliding window demand values, the Sliding Window Demand module uses the sliding window averaging (or rolling interval) technique which divides the demand interval into sub-intervals. Refer to the ION Reference for a detailed description.

The demand is measured electronically based on the average load level over the most recent set of sub-intervals. This method offers better response time than fixed interval methods.

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Intvl</td>
<td>The time, in seconds, in the sliding window demand sub-interval.</td>
<td>Varies</td>
</tr>
<tr>
<td>#SubIntvls</td>
<td>The number of sub-intervals in the sliding window.</td>
<td>3</td>
</tr>
<tr>
<td>Pred Resp</td>
<td>The speed of Predicted Demand calculations; use higher values for faster prediction (70 to 99 recommended).</td>
<td>70</td>
</tr>
<tr>
<td>Update Rate</td>
<td>Defines the update rate of the SWinDemand output register</td>
<td>End of sub-interval</td>
</tr>
</tbody>
</table>
Demand Forgiveness

Demand Forgiveness is the time programmed to the meter during which demand (and therefore peak demand) will not be calculated in the power restoration period following a total power outage.

During power-up following a complete power outage, customer equipment consumes a higher than normal amount of power. The Demand Forgiveness feature lets a utility forgive the customer for peak demand penalties that may arise from power-up following a power outage (should the outage exceed a user-specified period of time).

Demand and Peak Demand module overview

Power utilities generally bill commercial customers based on their peak usage levels, called peak demand (in kW), and energy consumption (in kWh). Demand is a measure of average power consumption over a fixed time interval, typically 15 minutes. Peak (or maximum) demand is the highest demand level recorded over the billing period. Sliding window/rolling block demand is one method of measuring demand.

To compute sliding window demand values, the Sliding Window/Rolling Block Demand module uses the sliding window averaging (or rolling interval) technique which divides the demand interval into sub-intervals. The demand is measured electronically based on the average load level over the most recent set of sub-intervals.

In the following diagram, the Sliding Window/Rolling Block module labeled “Demand” calculates demand from the power input by measuring and averaging the power over a set interval. The demand value is then output to a Maximum module labeled “Peak Demand” that records the highest demand value over time (peak demand).

For information on ION modules, refer to the online ION Reference.

Demand and Peak Demand module behavior during Demand Forgiveness

A peak demand value is the highest demand value since the last peak demand reset. The Demand Forgiveness framework sets the Sliding Window/Rolling Block module inputs to zero during a Demand Forgiveness period. This method allows demand interval data to accurately reflect a complete interval that includes data:

- prior to an outage
- during the Demand Forgiveness period (zero values)
- after the Demand Forgiveness period
**NOTE**

During a Demand Forgiveness period, Demand module inputs are set to zero and do not reflect actual demand. *These values should not be used to calculate energy for billing purposes.* Energy values are not affected and will reflect actual energy consumption during the Demand Forgiveness period.

The settings listed below must be made for Demand Forgiveness functionality. These settings can be accessed from ION Setup software; see “Using ION Setup” on page 127.

- *Minimum Outage Duration* lets you specify the amount of time (in seconds) that the power must be out before the Demand Forgiveness period begins.
- *Demand Forgiveness Duration* lets you specify the amount of time (in seconds) that demand is forgiven (demand inputs are zero).
- *Update Rate* lets you define the update rate of the SWinDemand output register and is set to EVERY SECOND by default for revenue-related demand modules. With this setting, demand value measured is updated once per second.
- *Outage Voltage* (line-to-line average in unscaled meter units) lets you define a voltage level that is considered an outage. This is set to 20 volts by default.

![Diagram](image)

A: The specified amount of time that the power must be out before demand is forgiven  
B: The specified amount of time that demand is delayed during the Demand Forgiveness period

The preceding diagram shows an example of a meter that is set up for Demand Forgiveness. The Sliding Window/Rolling Block Demand module is averaging demand values at 15 minute intervals. During interval #1, the meter has a power outage that lasts for 18 minutes. The power outage is defined by a system voltage of 20 volts which has been specified in the *Outage Voltage* setting. The *Minimum Outage Duration* setting is specified as 10 minutes, so this is amount of time that the power must be out before demand can be forgiven. The *Demand Forgiveness Duration* setting is specified as 1800 seconds (30 minutes), so for 30 minutes following power restoration, demand inputs are zero. The power is restored during interval #2, where the surge of power consumption during power-up is included in the Demand Forgiveness period and has a value of zero.
Additional information

The following points are important to note:

- The following demand input values are zero for kQ, kW, kVA, and kvar during the Demand Forgiveness period:
  - Delivered
  - Received
  - Delivered + received
  - Delivered – received
  - Q1, Q2, Q3, Q4

- If a new peak is set prior to a power outage, it will persist.

- Even though demand is zero during the Demand Forgiveness period, a new peak could be set if the demand was very high prior to the power outage or after the Demand Forgiveness period ends.

- Demand Forgiveness works for both single-phase and 3-phase powered meters.

- All ION modules in the Demand Forgiveness framework are fully locked.

- If a Demand Forgiveness period is initiated and another power outage occurs that is less than the time specified in the Minimum Outage Duration setting, the Demand Forgiveness period continues. If a second outage is greater than the time specified in the Minimum Outage Duration setting, the Demand Forgiveness period restarts.

- Both the power outage downtime and the Demand Forgiveness downtime are stored within the Demand Forgiveness framework. The Store modules preserve a timestamp that is viewable in Vista.

- The Sliding Window/Rolling Block demand module Update Rate setup register must be set to EVERY SECOND (default).

- If Demand Forgiveness is enabled on a single-phase powered meter and there is no power from the line, the meter assumes that this is an outage. When power is applied from the line again, demand is forgiven for the specified time.

- If Demand Forgiveness is enabled and the meter is unplugged for servicing or other reasons, the Demand Forgiveness framework assumes there was an outage and demand is forgiven for the specified time.

- For meters where Demand Forgiveness is enabled at the factory (e.g. RMICAN Canadian revenue meters), demand will not be measured when the meter is first put into service. Instead demand is forgiven for the specified time.
Configuring Demand Forgiveness

Demand Forgiveness is disabled by default. To enable Demand Forgiveness, use ION Setup software to set the:

- External Boolean module named “Demand Forgiveness Enable” to ENABLE.
- minimum outage duration.
- demand forgiveness duration.
- outage voltage.

**NOTE**

If Demand Forgiveness is enabled, do not use demand values to calculate energy for billing purposes.

Using the front panel

You cannot enable or edit Demand Forgiveness settings via the front panel.

Using ION Setup

ION Setup version 1.1 and later supports the Demand Forgiveness feature:

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Click Demand.
3. Click the Demand Forgiveness tab.
4. Select Demand Forgiveness Enable.
   
   Click Edit (provide a password if requested) and select ON.
5. Select Min Outage Duration, and click Edit.
   
   Select either Elapsed Interval Format or Numeric Bounded Format then enter the amount of time that the power must be out before the Demand Forgiveness period starts. Click OK.
   
   - Elapsed Interval Format: Enter the amount of time in days, hours, minutes and seconds.
   - Numeric Bounded Format: Enter the amount of time in seconds.
6. Select Demand Forgiveness Duration and click Edit.
   
   Select either Elapsed Interval Format or Numeric Bounded Format from then enter the amount of time that demand is forgiven (demand inputs are zero). Click OK.
   
   - Elapsed Interval Format: Enter the amount of time in days, hours, minutes and seconds.
   - Numeric Bounded Format: Enter the amount of time in seconds.
7. If required, select Outage Voltage and click Edit.
Type the minimum voltage (line-to-line average in unscaled meter units) that is considered an outage (this is set to 20 volts by default but you can adjust this.)
Chapter 11  Inputs / Outputs

This chapter provides information on the meter’s various inputs and outputs (I/O).

All I/O connections are made to the meter’s Essailec connector, located on the rear of the meter. Refer to your Installation Guide for instructions on wiring inputs and outputs and for the general meter I/O specifications.

In This Chapter

◆ Digital I/O ......................................................... 130
  Specifying an I/O port in a module ........................................ 130
  Using the digital outputs .................................................. 132
  Using the digital inputs .................................................. 134
    Digital Input modules .................................................. 134
◆ Configuring inputs and outputs ...................................... 135
  Using the front panel .................................................. 135
  Using ION Setup ..................................................... 135
  Using Designer ......................................................... 136
Digital I/O

ION8800 meters offer a variety of I/O combinations depending on the option ordered. The following options are available:

<table>
<thead>
<tr>
<th>I/O order option</th>
<th>Outputs</th>
<th>Digital inputs</th>
<th>Com</th>
</tr>
</thead>
</table>
| A                | ● 8 digital Form A solid-state outputs  
                 ● 1 Form C mechanical relay  
                 ● 4 Form C solid-state outputs | None | One RS-485 port on Essailec connector |
| B                | ● 8 digital Form A solid-state outputs  
                 ● 1 Form C mechanical relay  
                 ● 4 Form C solid-state outputs | 3 Low voltage | None |
| C                | ● 8 digital Form A solid-state outputs  
                 ● 1 Form C mechanical relay  
                 ● 4 Form C solid-state outputs | 3 High voltage | None |
| D                | ● 1 Form C mechanical relay  
                 ● 4 Form C solid-state outputs  
                 ● IRIG-B | 3 Low voltage | One RS-485 port on Essailec connector |
| E                | ● 1 Form C mechanical relay  
                 ● 4 Form C solid-state outputs  
                 ● IRIG-B | 3 High voltage | One RS-485 port on Essailec connector |

Two front panel infrared/LED outputs are also standard for all meters.

The digital inputs are ideal for monitoring status or counting pulses from external dry contacts. Use the Form A outputs for performing end of interval pulsing, load control and alarm annunciation, and the Form C solid-state outputs for load switching applications. The infrared/LED outputs are used for energy pulsing (watt-hours and var-hours).

Digital Input modules control the meter’s digital inputs. The meter’s outputs can be controlled by Digital Output modules, Pulser modules, or Calibration Pulser modules. All of these modules act as intermediaries between the hardware port and the other modules in the meter; they define the characteristics of outgoing signals or tell the meter how to interpret incoming signals.

Refer to the *Digital and Analog I/O* technical note for more information on digital inputs and outputs.

**Specifying an I/O port in a module**

For detailed information regarding Digital Output, Digital Input and Calibration Pulser modules, see the *ION Reference*.

Configure the Digital Output, Digital Input and Calibration Pulser modules’ *Port* setup registers to specify which port handles the outgoing or incoming signals. To assign a port to one of these modules, simply modify the *Port* setup register by picking a port from the enumerated list. This can be done with both Designer and ION Setup.
Be aware that the enumerated list only displays those ports that are not yet assigned to another module. To make a port available, you must first locate the module controlling the port and set its Port setup register to NOT USED (or delete the module entirely). The port now appears in the enumerated list.

The following table describes the ports that can be configured (in the Digital Output, Digital Input, and Calibration Pulser modules) to handle digital outgoing or incoming signals.

**NOTE**

You must confirm the meter’s I/O options to determine which of the following apply to your meter.

<table>
<thead>
<tr>
<th>ION module type</th>
<th>ION module name</th>
<th>Port name (ION label)</th>
<th>Meter port (installation guide)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Input</td>
<td>Digital In 1 to Digital In 3</td>
<td>Port DI1 to Port DI3</td>
<td>Digital Input DI1 to Digital Input DI3</td>
<td>The Digital Input modules are created and assigned to the hardware ports in the default framework.</td>
</tr>
<tr>
<td>Digital Output</td>
<td>DO1-C to DO4-C</td>
<td>Port DO1 (Form C) to Port DO4 (Form C)</td>
<td>Form C output DO1 to Form C output DO4</td>
<td>The Digital Output modules are created in the default framework, but the ports are not assigned (set to NOT USED). These ports can also be assigned to Calibration Pulser modules for energy pulsing.</td>
</tr>
<tr>
<td></td>
<td>DO5-A to DO12-A</td>
<td>Port DO7 (Form A) to Port DO12 (Form A)</td>
<td>Form A output DO5 to Form A output DO12</td>
<td>The Digital Output modules are created in the default framework, but the ports are not assigned (set to NOT USED).</td>
</tr>
<tr>
<td>AlarmLED</td>
<td>Alarm LED</td>
<td>Alarm LED (located on front panel)</td>
<td></td>
<td>This Digital Output module is created and assigned to the front panel Alarm LED in the default framework.</td>
</tr>
<tr>
<td>Power Up Alarm</td>
<td>Alarm Relay</td>
<td>Form C mechanical relay Alarm</td>
<td></td>
<td>This Digital Output module is created in the default framework, but the port is not assigned (set to NOT USED).</td>
</tr>
<tr>
<td>Calibration Pulser</td>
<td>varh del pulse</td>
<td>Port DO1 (Form C) to Port DO4 (Form C)</td>
<td>Form C output DO1 to Form C output DO4</td>
<td>The Calibration Pulser modules are created in the default framework, but the ports are not assigned (set to NOT USED). These ports can also be assigned to Digital Output modules. Refer to the “Energy pulsing” chapter for more information.</td>
</tr>
<tr>
<td></td>
<td>varh rec pulse</td>
<td>Port DO1 (Form C) to Port DO4 (Form C)</td>
<td>Form C output DO1 to Form C output DO4</td>
<td>These Calibration Pulser modules are created and assigned to the front panel LED pulsers in the default framework. Refer to the “Energy pulsing” chapter for more information.</td>
</tr>
<tr>
<td></td>
<td>Wh del pulse</td>
<td>Port DO1 (Form C) to Port DO4 (Form C)</td>
<td>Form C output DO1 to Form C output DO4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wh rec pulse</td>
<td>Port DO1 (Form C) to Port DO4 (Form C)</td>
<td>Form C output DO1 to Form C output DO4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>varh Pulse LED</td>
<td>kvarh Pulse/LED</td>
<td>varh LED (located on front panel)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wh Pulse LED</td>
<td>kWh Pulse/LED</td>
<td>Wh LED (located on front panel)</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td>None</td>
<td>Indicator LED (located on front panel)</td>
<td>Indicator LED (located on front panel)</td>
<td>This port can be used in a custom framework.</td>
</tr>
</tbody>
</table>
Using the digital outputs

Use the meter’s digital outputs for hardware relay control or pulse counting applications. For example, your meter’s digital outputs can provide on/off control signals for capacitor banks, generators, and other equipment. The digital output ports can also send out status signals or Wh pulses, if the receiving device determines energy usage by counting pulses or monitoring functions.

All digital outputs can deliver a continuous signal or a pulse.

Contact Schneider Electric for complete information regarding relay applications.

Digital Output modules

**WARNING**

HAZARD OF UNINTENDED OPERATION
Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury or equipment damage.

The meter’s outputs can be controlled by Digital Output modules, Pulser modules, or Calibration Pulser modules, depending on the application. For relay and control, use the Digital Output module. For pulsing applications, the Calibration Pulser or Pulser modules are generally used.

**CAUTION**

HAZARD OF MISAPPLICATION (MISUSE)
Because mechanical relays have limited lifetimes, mechanical KYZ relays are typically not suitable for energy pulsing applications. For energy pulsing applications, use a Form A output in KYZ mode.

Failure to follow these instructions can result in equipment damage.

Digital Output and Calibration Pulser modules are already created in the meter’s default framework, you just need to assign the appropriate port and configure the module to match your requirements using ION Setup or the Designer component of ION Enterprise. You can use the existing modules, or create and configure other modules to control the output ports.

- **Calibration Pulser modules** allow you to generate high accuracy energy pulses for calibration testing purposes. They integrate instantaneous power appearing at their inputs.
- **Digital Output modules** accept Boolean inputs, and output a continuous signal or pulses.
- **Pulser modules** convert instantaneous pulses to pulses or transitions.

Refer to the *ION Reference* for more information about these ION modules.
Configure the settings of the controlling module to match your requirements. The settings in these modules are as follows:

**NOTE**

You must confirm the meter I/O options to determine which of the following apply to your meter.

<table>
<thead>
<tr>
<th>ION module</th>
<th>Setup registers</th>
<th>Available settings</th>
<th>Creation default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Output</td>
<td>Port</td>
<td>Refer to “Specifying an I/O port in a module” on page 130.</td>
<td>The output hardware channel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PulseWidth</td>
<td>0 to 2000000</td>
<td>0</td>
<td>Pulse Width, in seconds (0 for continuous pulse)</td>
</tr>
<tr>
<td></td>
<td>Polarity</td>
<td>Inverting or Non-Inverting</td>
<td>Non-Inverting</td>
<td>Inverted or non-inverted output</td>
</tr>
<tr>
<td></td>
<td>EvLog Mode</td>
<td>Log On or Log Off</td>
<td>Log Off</td>
<td>Whether or not to log status changes in the Event Log</td>
</tr>
<tr>
<td>Calibration Pulser</td>
<td>Port</td>
<td>Refer to “Specifying an I/O port in a module” on page 130.</td>
<td>The output hardware channel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pulse Width</td>
<td>0.010 to 1.000</td>
<td>0.05</td>
<td>Pulse Width, in seconds</td>
</tr>
<tr>
<td></td>
<td>Kt</td>
<td>0.01 to 1000000000</td>
<td>1.8*</td>
<td>Watts per pulse</td>
</tr>
<tr>
<td></td>
<td>Int Mode</td>
<td>Forward, Reverse, Absolute, or Net</td>
<td>Depends (see section below)</td>
<td>Integration modes that may be selected</td>
</tr>
<tr>
<td></td>
<td>OutputMode</td>
<td>Pulse or KYZ</td>
<td>Pulse</td>
<td>Full pulse or KYZ (transition pulse)</td>
</tr>
<tr>
<td>Pulser</td>
<td>Port</td>
<td>Refer to “Specifying an I/O port in a module” on page 130.</td>
<td>The output hardware channel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PulseWidth</td>
<td>0.020 to 2000000</td>
<td>1</td>
<td>Pulse width, in seconds</td>
</tr>
<tr>
<td></td>
<td>OutputMode</td>
<td>Pulse or KYZ</td>
<td>Pulse</td>
<td>Full pulse or KYZ (transition pulse)</td>
</tr>
<tr>
<td></td>
<td>Polarity</td>
<td>Inverting or Non-Inverting</td>
<td>Non-Inverting</td>
<td>Inverted or non-inverted output</td>
</tr>
</tbody>
</table>

* Value depends on meter’s nominal current option.

Ensure that the module’s Port setup register matches the meter’s output you want to control. If the port you want to use does not appear in the Port setup register’s list, it means that port is in use by another module. Edit the Port setup register of the module using that port and set it to NOT USED – the port will then be available to other modules.

**Alarm LED**

The red (top) LED on the front panel of the meter is configured in the meter’s default template to flash if the meter does not complete its startup self tests. Contact Technical Support if this occurs.

**Indicator LED**

Use the green (middle) LED on the front panel of the meter for custom applications. It can be linked to a framework to provide event notification. Possible applications include sag/swell alarming, setpoint annunciation, and tariff notification. Like all outputs on the meter, this port can be controlled by a Digital Output, Pulser, or Calibration Pulser module.
Using the digital inputs

Use the meter’s digital inputs for status monitoring or pulse counting applications. Status monitoring can help you prevent equipment damage, improve maintenance, or track security breaches. Some common status monitoring applications are monitoring the closed/open positions of breakers, on/off status of generators, armed/unarmed conditions in a building alarm system, and over/under pressures of transformers.

Digital Input modules control the function of each status input, telling the meter how to interpret incoming signals. Digital Input modules can be linked with other modules for counting status changes.

Digital Input modules

The meter provides three default Digital Input modules for the status inputs. Configure the settings of the controlling module to match your requirements. Refer to the ION Reference for detailed module information.

The settings in the Digital Input modules are as follows:

NOTE

Confirm that your meter’s I/O option includes the digital inputs to determine if these settings apply to your meter.

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Available settings</th>
<th>Creation default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Input Mode     | Pulse, KYZ or A/C  | Pulse             | Complete pulse, KYZ transition pulse, or A/C input mode  
|                |                    |                   | Pulse: detects when the signal makes a complete pulse (changes from OFF to ON and back to OFF, or vice versa.  
|                |                    |                   | KYZ: detects when the signal changes from OFF to ON, or from ON to OFF.  
|                |                    |                   | A/C: detects analog signals (the ON condition is based on the presence of an AC signal with a frequency range of 5 to 210 Hz) |
| EvLog Mode     | Log Off or Log On | Log Off           | Whether or not to log status changes in the Event output register |
| Event Priority | 0 to 255           | 20                | The event priority of the status changes in the meter’s Event Log. To record status changes in the meter’s Event Log:  
|                |                    |                   | the EvLog Mode register must be set to LOG ON.  
|                |                    |                   | the Event Priority value must be greater than the value set in the Event Log Controller module’s Cutoff register.  
|                |                    |                   | If Event Priority is set to zero, status changes will not be logged. |
| Polarity       | Non-Inverting or Inverting | Non-Inverting | Non-inverted (or level) pulse |
| Debounce       | 0 to 65.525        | 0.000             | Mechanical contact bounce, in seconds |
| Port           | Refer to “Specifying an I/O port in a module” on page 130 | | The input hardware channel controlled |
Configuring inputs and outputs

Use ION software to configure the meter’s I/O framework. Your meter’s I/O option will determine which physical input and output port settings apply to your meter.

**WARNING**

HAZARD OF UNINTENDED OPERATION

Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury or equipment damage.

Using the front panel

You cannot configure I/O using the Front Panel.

Using ION Setup

You can use ION Setup to configure the Digital Input and Digital Output modules created in your meter’s default template.

1. Open the Setup Assistant for your meter. Refer to the ION Setup help for instructions.
3. Click the tab that corresponds to the digital input that you want to configure.
4. Select the parameter that you want to configure and click **Edit** (or double-click the parameter). Select the desired setting from the selection screens. Refer to “Using the digital inputs” on page 134 for details on the Digital Input module settings.
5. Select **Onboard I/O > Form C Outputs** to configure the Digital Output modules associated with the Form C digital output ports.
6. Click the tab that corresponds to the digital output that you want to configure.

7. Select the parameter you want to configure and click **Edit** (or double-click the parameter). Select the desired setting from the selection screens. Refer to "Using the digital outputs" on page 132 for more detail on Digital Output module settings. Click **OK** to send your changes to the meter.

8. Select **Onboard I/O > Form A Outputs** to configure the Digital Output module associated with the Form A digital outputs.

9. Select the parameter you want to configure and click **Edit** (or double-click the parameter). Select the desired setting from the selection screens. Refer to "Using the digital outputs" on page 132 for more detail on Digital Output module settings. Click **OK** to send your changes to the meter.

**Using Designer**

Open your meter in Designer and navigate to the Advanced Setup framework. Click on the appropriate grouping object (Digital Inputs or Digital Outputs) and right-click the module you want to edit.
Chapter 12  Energy pulsing

This chapter provides instructions for configuring energy pulsing on your meter through the meter’s front panel LEDs or through its digital output ports.

In this chapter

- **Introduction** ................................................. 138
- **Energy pulsing with infrared ports and LEDs** ............... 139
  - Configuring LED pulsing .................................. 139
  - Using the front panel ...................................... 140
  - Using ION Setup .......................................... 140
- **Energy pulsing with digital outputs** ......................... 141
  - Calibration Pulser module settings ...................... 141
  - Configuring energy pulsing ............................. 142
  - Using the front panel .................................... 142
  - Using ION Setup .......................................... 142
  - Using Designer ............................................. 143
Introduction

Your meter uses Calibration Pulser modules for energy pulsing.

The Calibration Pulser module is an energy pulser used for verifying accuracy on meters employed in billing applications. This module type serves as an intermediary between the power (kW, kvar or kVA) outputs of the Power Meter module and a device’s hardware output channel. Refer to the “Verifying accuracy” chapter for instructions on how to verify the accuracy of your meter.

NOTE

See the ION Reference for more information on this modules

There are two types of outputs used for energy pulsing: your meter’s front panel Wh and varh LEDs, and its digital outputs. Your meter’s default framework contains six Calibration Pulser modules. Two Calibration Pulser modules are completely configured and operate the front panel LEDs; you have to manually assign a digital output port to the other four Calibration Pulser modules to receive energy pulsing from your meter’s digital outputs.
Energy pulsing with infrared ports and LEDs

Two LEDs on the front panel are preconfigured for energy pulsing. Matching infrared outputs are located below each LED and pulse at the same rate.

The LED's pulse rate can be adjusted by modifying the Kt setup register in the Calibration Pulser module. The value entered defines how much energy the module accumulates before a pulse is sent to the hardware channel. The front panel Wh and varh LEDs are factory set to the same pulse rate (1 Watt-hour).

If the Wh or varh LEDs are not capable of pulsing quickly enough, they will remain on (not blink) and the pulse overload registers (shown on the LED pulsing screens in ION Setup) will indicate the LED pulsing has been suspended. You can reduce the LED pulse rate by modifying the pulse rate (Kt value).

**Wh – LED and varh – LED**

In the meter’s default framework, the Wh – LED is controlled by a Calibration Pulser module that has its Source input linked to the $kW\ del+rec$ output of the Arithmetic module labeled “kW del, rec”.

Similarly, the varh – LED is controlled by a Calibration Pulser module that has its Source input linked to the $kvar\ del+rec$ output of the Arithmetic module labeled “kvar del, rec”.

**Customizing energy pulsing**

Changing the value for the $Kt$ setup register of the controlling Calibration Pulser module lets you modify the pulsing rate of either channel. If you want to configure the LED port for a different pulsing application, you must re-link the Source input to the output register of a different instantaneous power quantity in one of the Arithmetic modules. Ensure that the quantity you choose originates from the MU (meter units) Power Meter module.

**Configuring LED pulsing**

Use ION Setup or ION Enterprise software to change your meter’s energy pulsing settings.
Using the front panel
You cannot configure LED pulsing using the front panel.

Using ION Setup
1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select Pulsing Outputs > LED Pulsing.
3. Click on the tab that corresponds to the LED that you want to configure.
4. Configure the settings as required. See “Calibration Pulser module settings” on page 141 for settings information.
5. Check that the pulse overload parameter reads PULSING NORMALLY to help ensure that the LED can pulse with the new settings.
Energy pulsing with digital outputs

The meter’s default framework includes four Calibration Pulser modules already configured for energy pulsing using the meter’s digital outputs, you just need to assign a value to their Port registers using ION Setup or the Designer component of ION Enterprise. It is recommended that these Calibration Pulser modules be configured as follows for energy pulsing applications:

### Calibration Pulser module settings

You can modify an LED, pulsing port or digital output’s pulsing rate by changing the value of the $K_t$ setup register of the Calibration Pulser module controlling them (see below).

Other register defaults vary depending on the Calibration Pulser module. Refer to the *ION Reference* for a detailed description of the Calibration Pulser module.

The following setup registers are available in the Calibration Pulser module:

<table>
<thead>
<tr>
<th>Calibration module</th>
<th>Setup registers</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>varh del pulse</td>
<td>Port</td>
<td>DO3 FormC</td>
</tr>
<tr>
<td></td>
<td>Int Mode</td>
<td>Forward</td>
</tr>
<tr>
<td>varh rec pulse</td>
<td>Port</td>
<td>DO4 FormC</td>
</tr>
<tr>
<td></td>
<td>Int Mode</td>
<td>Reverse</td>
</tr>
<tr>
<td>Wh del pulse</td>
<td>Port</td>
<td>DO1 FormC</td>
</tr>
<tr>
<td></td>
<td>Int Mode</td>
<td>Forward</td>
</tr>
<tr>
<td>Wh rec pulse</td>
<td>Port</td>
<td>DO2 FormC</td>
</tr>
<tr>
<td></td>
<td>Int Mode</td>
<td>Reverse</td>
</tr>
</tbody>
</table>

### NOTE

No hardware channel is pre-selected. To make use of these links, you must configure the Calibration Pulser modules’ Port setup registers to the appropriate hardware port that receives the output using ION Setup or the Designer component of ION Enterprise.

Using this configuration, the Calibration Pulser module labeled *varh rec pulse* controls port 4. By default, the module is linked to the $kW_{del+rec}$ output of the Arithmetic module labeled “del, rec” in the Demand Framework. This Arithmetic module is linked to the MU Power Meter module’s $MU_{kW tot}$ output. The port pulses for every 1 Wh accumulated (in Normal or TEST mode); this is the same pulsing rate as the middle LED on the front panel of the meter, and the front panel varh pulsing port and WH pulsing port (controlled by Calibration Pulser modules labeled “varh Pulse LED” and Wh Pulse LED). See “Calibration Pulser module settings” on page 141 for more information.
The appropriate Kt value depends on Scaled Rev Param, located on the Basic Setup tab of the ION Setup Assistant.

- If *Scaled Rev Param* is off, the Kt value must be the primary value and the Calibration Pulser module pulses based on primary kWh and kvarh.
- If *Scaled Rev Param* is on, the Kt value must be the secondary value, and the Calibration Pulser module pulses based on secondary kWh and kvarh.

### Configuring energy pulsing

<table>
<thead>
<tr>
<th><strong>Setup register</strong></th>
<th><strong>Function</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Width</td>
<td>This register specifies the width of the pulses sent to the hardware channel (in seconds). The Calibration Pulser module maintains a minimum duty cycle of 50% on the output pulse train.</td>
</tr>
<tr>
<td>Kt</td>
<td>The numeric bounded register defines how much energy (watt-hours) the module accumulates before a pulse is sent to the hardware channel.</td>
</tr>
<tr>
<td>Int Mode</td>
<td>Specifies the modes of integration that may be selected.</td>
</tr>
<tr>
<td>OutputMode</td>
<td>This register specifies whether the output is a complete pulse (Pulse) or a change of state transition (KYZ).</td>
</tr>
<tr>
<td>Port</td>
<td>This register specifies which hardware port the pulse/KYZ transition appears on. Only those hardware channels that are still available appear in this list. To make a hardware port available, you must first locate the module controlling the port and set its Port setup register to Not Used (or delete the module). The port now appears in the list.</td>
</tr>
</tbody>
</table>

The appropriate Kt value depends on Scaled Rev Param, located on the Basic Setup tab of the ION Setup Assistant.

- If *Scaled Rev Param* is off, the Kt value must be the primary value and the Calibration Pulser module pulses based on primary kWh and kvarh.
- If *Scaled Rev Param* is on, the Kt value must be the secondary value, and the Calibration Pulser module pulses based on secondary kWh and kvarh.

### Configuring energy pulsing

**CAUTION**

**HAZARD OF MISAPPLICATION (MISUSE)**

Because mechanical relays have limited lifetimes, mechanical KYZ relays are typically not suitable for energy pulsing applications. For energy pulsing applications, use a Form A output in KYZ mode.

Failure to follow these instructions can result in equipment damage.

Use ION Setup or ION Enterprise software to change your meter’s energy pulsing settings.

**Using the front panel**

You cannot configure Energy Pulsing using the front panel.

**Using ION Setup**

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select *Pulsing Outputs > Energy Pulsing.*
3. Click any of the tabs; each tab corresponds to a Calibration Pulser module. Configure the other default Calibration Pulser modules for energy pulsing applications, if required. By default, these modules are not linked to an output. See “Calibration Pulser module settings” on page 141 for settings information.

**NOTE**

You can also configure the Calibration Pulser and Pulser modules using Advanced Mode.

### Using Designer

Open your meter in Designer and navigate to the Energy Pulsing Setup framework. Right-click a module to edit.
Chapter 13  Logging

Your meter includes data logging and event recording capabilities. Data and event logs recorded by the meter are prioritized and stored onboard. This data is then retrieved periodically by the ION Enterprise ION Log Inserter Service or another third party application.

If you use ION Enterprise software, all retrieved data from your system is stored in an ODBC-compliant database. The information in the database can be viewed and analyzed using ION Enterprise software applications such as Vista (for viewing) or Web Reporter (for organizing and presenting data).

For more information on Vista and Web Reporter, see the online ION Enterprise Help.

In this chapter

- Data logging .................................................. 146
  Configuring data logging .................................... 146
  Default logging configuration — ION8800A Meter ................. 149
  Viewing data logs ............................................. 152
- Event logging .................................................. 153
  Displaying events .............................................. 154
- Logging and recording capacity ............................... 155
Data logging

Your meter ships with a comprehensive data-logging configuration that differs depending on your meter type. The data recording frameworks contain Data Recorder modules, Waveform Recorder modules (ION8800A meters only) and Periodic Timer modules.

Data Recorder and Waveform Recorder modules are responsible for logging the power system data, while Periodic Timer modules determine the recording frequency of the recorder modules to which they are linked.

To learn more about these modules, consult the ION Reference.

NOTE

Changing logging settings will reset logged values. Ensure that all important data has been recorded before you make changes.

See “Default logging configuration — ION8800A Meter” for more information about the pre-configured Data Recorder modules for feature set A.

Configuring data logging

Use ION Setup or ION Enterprise software to change your meter’s logging settings.

Using the front panel

You cannot configure Logging using the front panel.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.

2. Select Logging > Memory.

   Select the Log you want to configure and click Edit. You can change both the Log Duration (days) and the Log Size (records). Changing these parameters affects the meter memory allocated to that log.

3. Select Logging > Revenue Log to configure Data Recorder #1.

   ♦ Click the Channels tab to edit, link and unlink revenue parameters.

   ♦ Click the Interval/Depth tab to edit the interval and duration of the revenue log.

4. Select Logging > EnergyDemand Log.

   ♦ Click the Channels tab to edit, link and unlink energy demand log parameters.
◆ Click the **Interval/Depth** tab to edit the interval and duration of the revenue log.

**Changing the parameters that are logged**

The meter’s factory configuration logs a comprehensive set of energy, power and harmonics parameters. Changing which parameters are logged is an advanced procedure because you must configure the links to the module’s input registers. If you are comfortable editing module links, you can change the logged parameters by linking the output registers you want logged to the inputs of an Data Recorder module.

**NOTE**

Adding or deleting a log’s parameters is an advanced procedure, as it requires changes to the links between modules; use the Designer component of ION Enterprise (refer to the Designer section of the online ION Enterprise Help) or ION Setup.

**Changing waveform recording (if supported)**

The Waveform Recorder modules do not require changes to their default settings. If you want to change the format of the recorded waveforms, refer to the Waveform Recorder module description in the *ION Reference*.

**NOTE**

If you are generating COMTRADE waveform data records, the associated Waveform Recorder modules cannot be modified unless the COMTRADE module’s *Enable/Disable* register is set to *DISABLE*. If the Waveform Recorder modules are not configured identically (have the same setup register values) the COMTRADE module will not go online and COMTRADE waveform data will not be generated.
Default logging capacity — ION8800A meter

The table below summarizes the default recording depths and recording intervals of the various Data Recorders and Waveform recorders in the ION8800A meter.

### NOTE

Default logging depth is set differently for 5 MEG on-board memory ("one-month") and 10 MEG ("three-month") option meters. See the table below.

<table>
<thead>
<tr>
<th>Data Recorder number</th>
<th>Log name</th>
<th>Depth 5 MEG</th>
<th>Depth 10 MEG</th>
<th>Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Revenue Log</td>
<td>3360 (35 days)</td>
<td>9120 (95 days)</td>
<td>900 seconds (15 minutes)</td>
</tr>
<tr>
<td>2</td>
<td>Dip/Swell Log</td>
<td>100</td>
<td>3000</td>
<td>Triggered on demand</td>
</tr>
<tr>
<td>9, 13</td>
<td>Loss Log, Loss Log UII</td>
<td>3360 (35 days)</td>
<td>3360 (35 days)</td>
<td>900 seconds (15 minutes)</td>
</tr>
<tr>
<td>3, 4, 5</td>
<td>Historic Logs (3 data recorders)</td>
<td>3360 (35 days)</td>
<td>3360 (35 days)</td>
<td>900 seconds (15 minutes)</td>
</tr>
<tr>
<td>6</td>
<td>Transient Log</td>
<td>100</td>
<td>3000</td>
<td>Triggered on demand</td>
</tr>
<tr>
<td>7, 8</td>
<td>Harmonics Logs (2 data recorders)</td>
<td>840 (35 days)</td>
<td>840 (35 days)</td>
<td>3600 seconds (1 hour)</td>
</tr>
<tr>
<td>N/A</td>
<td>Waveform recording (6 data recorders)</td>
<td>30</td>
<td>50</td>
<td>Triggered on demand</td>
</tr>
<tr>
<td>N/A</td>
<td>COMTRADE records¹</td>
<td>1</td>
<td>1</td>
<td>Triggered by Waveform recording</td>
</tr>
<tr>
<td>10</td>
<td>Report Generator Log (EgyDmd Log)</td>
<td>3360 (35 days)</td>
<td>9120 (95 days)</td>
<td>900 seconds (15 minutes)</td>
</tr>
<tr>
<td>11-12, 17-16</td>
<td>EN50160 Logs (EN50160 ordering option only)</td>
<td>Varies²</td>
<td>Varies²</td>
<td>Daily, weekly, 10 minutes, ...</td>
</tr>
<tr>
<td>N/A</td>
<td>Event Log (Event Log Controller module)</td>
<td>100</td>
<td>500</td>
<td>Triggered on demand</td>
</tr>
<tr>
<td>14, 16, 37-38</td>
<td>4-30 logs (4 data recorders)</td>
<td>Varies³</td>
<td>Varies³</td>
<td>3 second, 10 minute, 2 hour</td>
</tr>
<tr>
<td>15</td>
<td>Interrupt log</td>
<td>2400</td>
<td>2400</td>
<td>Triggered on demand</td>
</tr>
</tbody>
</table>

1. See the COMTRADE and ION technology technical note for more details.
2. See “EN50160 compliance logging (EN50160 ordering option only)” on page 151 and the Power Quality: ION Meters and EN50160 technical note for more details.
3. See the 4-30 compliance and ION meters technical note for more details.

### Changing the log depths

Change the value in the Data Recorder’s Depth setup register to increase the number of records stored in the recorder. The RecordMode setup register controls how the Data Recorder overwrites old records; refer to the Data Recorder module description in the ION Reference before changing this setup register.
Changing the frequency of logging

The five Periodic Timer modules that control the frequency of different data recording are as follows:

- “Revenue Log Trg” controls the frequency of the logging of revenue values
- “Loss Log Trg” controls the frequency of Loss Compensation Data logging
- “EgyDmd Log Trg” controls the frequency of logging for the Energy and Demand Log (this log is used for generating reports using Reporter)
- “Hist Log Trg” controls the frequency of Historic Data logging
- “Harm Log Trg” controls the frequency of Harmonics logging

**NOTE**

Programming your meter to write any data recorder at continuous intervals lower than 60 seconds (heavy logging configuration) may cause loss of data in the event of a power failure. Use of an uninterruptible power supply (UPS) is recommended for such heavy logging configurations.

Change the value in the *Period* setup register to change the frequency of data logging (Period values are specified in seconds).

Default logging configuration — ION8800A Meter

The following sections describe each Data Recorder and the parameters it logs.

**Revenue Log**

The Revenue Log is configured for use with MV-90 billing software. The default values logged by the Revenue Log are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>kWh del int</td>
<td>Interval kWh delivered</td>
</tr>
<tr>
<td>kWh rec int</td>
<td>Interval kWh received</td>
</tr>
<tr>
<td>kvarh del int</td>
<td>Interval kvarh delivered</td>
</tr>
<tr>
<td>kvarh rec int</td>
<td>Interval kvarh received</td>
</tr>
</tbody>
</table>

**Historic data logging**

Three data recorders are used to record standard power system quantities, such as phase current, phase voltage and power factor. These recorders are labeled *Hist Mean Log*, *Hist High Log*, and *Hist Low Log*. By default, they log the following ION output register values:

<table>
<thead>
<tr>
<th>Hist mean log</th>
<th>Hist high log</th>
<th>Hist low log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ull 12 mean I avg mean</td>
<td>Ull 12 high I avg high</td>
<td>Ull 12 low I avg low</td>
</tr>
<tr>
<td>Ull 23 mean I 4 mean</td>
<td>Ull 23 high I 4 high</td>
<td>Ull 23 low I 4 low</td>
</tr>
</tbody>
</table>
## Loss logs

The *Loss Log* and the *Loss Log UII* recorders are configured to record loss values. The Loss Log is used for line-to-neutral values and logs the following ION parameters by default:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MU I1(^2)h int</td>
<td>Phase 1 interval current squared hours</td>
</tr>
<tr>
<td>MU I2(^2)h int</td>
<td>Phase 2 interval current squared hours</td>
</tr>
<tr>
<td>MU I3(^2)h int</td>
<td>Phase 3 interval current squared hours</td>
</tr>
<tr>
<td>MU Ul1 12(^2)h int</td>
<td>Phase 1 interval voltage line-to-neutral squared hours</td>
</tr>
<tr>
<td>MU Ul1 23(^2)h int</td>
<td>Phase 2 interval voltage line-to-neutral squared hours</td>
</tr>
<tr>
<td>MU Ul1 31(^2)h int</td>
<td>Phase 3 interval voltage line-to-neutral squared hours</td>
</tr>
</tbody>
</table>

The Loss Log UII is used for line-to-line values and logs the following ION parameters by default:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MU I1(^2)h int</td>
<td>Phase 1 interval current squared hours</td>
</tr>
<tr>
<td>MU I2(^2)h int</td>
<td>Phase 2 interval current squared hours</td>
</tr>
<tr>
<td>MU I3(^2)h int</td>
<td>Phase 3 interval current squared hours</td>
</tr>
<tr>
<td>MU Ul 12(^2)h int</td>
<td>Phase 1 interval voltage line-to-line squared hours</td>
</tr>
<tr>
<td>MU Ul 23(^2)h int</td>
<td>Phase 2 interval voltage line-to-line squared hours</td>
</tr>
<tr>
<td>MU Ul 31(^2)h int</td>
<td>Phase 3 interval voltage line-to-line squared hours</td>
</tr>
</tbody>
</table>

## Harmonics logging

Two recorders provide various harmonics logs, including K-factor and Total Harmonics Distortion (THD). These recorders are labeled *Harm Mean Log* and *Harm High Log*. By default, they log the following ION output register values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>U1 THD mean</td>
<td>I1 K Fac mean</td>
</tr>
<tr>
<td>U1 THD high</td>
<td>I1 K Fac high</td>
</tr>
</tbody>
</table>
Energy Demand Log
One recorder is configured to provide power system data for the Web Reporter component of ION Enterprise.

<table>
<thead>
<tr>
<th>EgyDmd Log</th>
<th>kWh del</th>
<th>kWh rec</th>
<th>kWh del-rec</th>
<th>kvarh del</th>
<th>kvarh rec</th>
<th>kvarh del-rec</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>kW A h del+rec</td>
<td>kW sd del-rec</td>
<td>kvar sd del-rec</td>
<td>kVA sd del+rec</td>
<td>PF sign mean</td>
<td></td>
</tr>
</tbody>
</table>

Dip/Swell and Transient logging
The meter logs the following ION output register values:

<table>
<thead>
<tr>
<th>Dip/Swell log</th>
<th>DistDur</th>
<th>DistU1Engy</th>
<th>DistU3Engy</th>
<th>DistU1Min</th>
<th>DistU3Min</th>
<th>DistU2Min</th>
<th>DistNominal</th>
<th>DistU1Max</th>
<th>DistU3Max</th>
<th>DistU2Max</th>
<th>SwellLim</th>
<th>DistU1Avg</th>
<th>DistU3Avg</th>
<th>DistU2Avg</th>
<th>SagLim</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Transient log</th>
<th>TranU1Dur</th>
<th>TranNominal</th>
<th>TranU2Max</th>
<th>PT Sec</th>
<th>TranU1Max</th>
<th>Threshold</th>
<th>TranU3Dur</th>
<th>CT Prim</th>
<th>TranU2Dur</th>
<th>PT Prim</th>
<th>TranU3Max</th>
<th>CT Sec</th>
</tr>
</thead>
</table>

EN50160 compliance logging (EN50160 ordering option only)
By default, 22 Data Recorders are used for logging EN50160 compliance parameters.
The meter logs EN50160 counter data for present and previous observation periods. EN50160 events are also logged. EN50160 parameter data logging (from seven “Prm” data recorders) is disabled by default. The EN50160 Parameter Logging enable is accessible in the default Power Quality Vista diagram.

For more information about EN50160 data logging, refer to the *Power Quality: ION Meters and EN50160* technical note.

### Viewing data logs

See “Reports” on page 203 for more information. You can also view Data Logs using ION Setup.

1. Open your meter in ION Setup, using Basic Mode. Refer to the ION Setup help for more information.

2. Navigate to View > Data Screens > Data Recorders. The following logs are available for viewing:
   - Average Harmonics
   - Energy & Demand
   - Historic Average, Historic Highs, Historic Lows
   - Maximum Harmonics
   - Revenue Log
   - Sags & Swells
   - Transformer Losses
   - Transients (if supported)
   - IEC 61000-4-30, four logs (if supported)
Event logging

Events produced by a meter’s various ION modules are prioritized and grouped to facilitate custom logging. Each event is assigned a priority group number based on its type and severity.

ION event priority groups

Some event groups are preset with a priority number as shown in the table below. You can also define your own priority number for some modules. Priority numbers from 128-191 appear in the global event log viewer in ION Enterprise software. Priorit numbers from 192-255 are logged, initiate a beep and cause the window to flash. You can customize these responses to display messages or perform netsend messages, for example.

<table>
<thead>
<tr>
<th>Event group</th>
<th>Description</th>
<th>Priority number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
<td>Module reset or re-synchronized</td>
<td>5</td>
</tr>
<tr>
<td>Setup Change</td>
<td>Module setup changes (setup register changes, label changes, input handle changes)</td>
<td>10</td>
</tr>
<tr>
<td>Input Register Change</td>
<td>Inputs of certain modules change value (ie, input to And/Or module changes)</td>
<td>15</td>
</tr>
<tr>
<td>I/O State Change</td>
<td>I/O state changes (ie, relay closes)</td>
<td>20</td>
</tr>
<tr>
<td>Information</td>
<td>Module produces important user information</td>
<td>25</td>
</tr>
<tr>
<td>Warning</td>
<td>Module produces a warning</td>
<td>30</td>
</tr>
<tr>
<td>EN50160 Event</td>
<td>An EN50160 Counter (N1 or N2) increases</td>
<td>50</td>
</tr>
<tr>
<td>Loss of Potential</td>
<td>Loss of Potential has occurred</td>
<td>128</td>
</tr>
<tr>
<td>Error Detected</td>
<td>An error has been detected</td>
<td>255</td>
</tr>
<tr>
<td>Setpoint</td>
<td>Setpoint condition goes Active or Inactive (ie, Sag/Swell module detects a disturbance)</td>
<td></td>
</tr>
</tbody>
</table>

The Event Log Controller module allows you to set a priority cutoff for event logging. Any events with a priority number greater than the cutoff value are logged and events with lower priorities are discarded. Refer to the individual module descriptions and the Event Log Controller module description in the ION Reference for more details.

External ION events

Some events are not produced by a specific module. These events are generated internally by the meter. Their associated priority levels are shown in the table below.
Displaying events

You can view events in the following locations:

<table>
<thead>
<tr>
<th>Application</th>
<th>Menu / Screen</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front panel</td>
<td>Event Log</td>
<td>ALT Display Mode &gt; Events Screen</td>
</tr>
<tr>
<td>ION Setup</td>
<td>Event</td>
<td>Display Mode &gt; Data Recorders folder &gt; Event</td>
</tr>
<tr>
<td>Vista</td>
<td>Meter Events</td>
<td>System &amp; Logs tab &gt; Meter Events object</td>
</tr>
<tr>
<td>WebMeter</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Event group

<table>
<thead>
<tr>
<th>Event group</th>
<th>Description</th>
<th>Priority number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning</td>
<td>Factory initialize performed</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Firmware or memory upgrade performed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Meter power-up or power-down</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Internal modem not responding or modem recovered</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Battery low</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Telnet or serial terminal locked out</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Security disabled or enabled</td>
<td></td>
</tr>
<tr>
<td>Failure</td>
<td>Communications fail to allocate required memory</td>
<td>255</td>
</tr>
</tbody>
</table>
Logging and recording capacity

The meter provides both data and event logs. The amount of memory required to store these logs depends on the number of parameters being logged and the frequency with which these parameters are logged.

The following equation can help determine the amount of memory required to store data and event logs:

\[
\text{each record consumes (in Bytes) = } [(\text{number of parameters} \times 5) + 8]\n\]

The meter can also perform waveform recording. It can simultaneously capture events on all channels to a maximum of 96 cycles each.

To calculate the waveform memory usage use the following formula:

\[
\text{waveform memory usage (in Bytes) = } [2^{*}(\text{number of samples per cycle}) + 10]*(
\text{number of cycles in waveform}) + 30
\]

**NOTE**

Round up to the next kilobyte after each of the above calculations.
Chapter 14 Revenue

This chapter provides instructions for configuring PT/CT correction, Transformer line Loss Compensation (TLC), and Time Of Use (TOU).

In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT/CT correction</td>
<td>158</td>
</tr>
<tr>
<td>Configuring PT/CT correction</td>
<td>158</td>
</tr>
<tr>
<td>Transformer Line Loss Compensation (TLC)</td>
<td>161</td>
</tr>
<tr>
<td>Configuring TLC</td>
<td>161</td>
</tr>
<tr>
<td>Time of Use</td>
<td>164</td>
</tr>
<tr>
<td>Configuring Time of Use</td>
<td>164</td>
</tr>
<tr>
<td>Time Of Use module settings</td>
<td>166</td>
</tr>
<tr>
<td>Displaying Time of Use</td>
<td>167</td>
</tr>
</tbody>
</table>
PT/CT correction

The primary application for PT/CT correction is to apply correction factors for ratio and phase angle inaccuracies in instrument transformers. Instrument transformer correction (ITC) reduces the need to replace transformers in installations where high-accuracy is required.

While ION8800 meters are shipped with ITC-capable firmware, its ITC modules (Instr Xformer Correction in the firmware) must be configured using accurate measurements to help ensure valid calculations. There is one Instr Xformer Correction module for each current and voltage input into the meter. The correction affects only the 1-second values in the Power Meter module. No high-speed, harmonics or waveform values are affected by the correction.

NOTE

The operation of this feature requires the correct configuration of the ITC modules according to your meter's power supply and operating ranges.

For details explanations of this module's inputs, setup registers and output registers, see the ITC module description in the ION Reference.

Configuring PT/CT correction

PT/CT Correction (the Instr Xformer module in the meter’s firmware) can be configured in the ION8800 via ION Setup or ION Enterprise software.

Using the front panel

You cannot configure PT/CT Correction using the front panel.

Using ION Setup

In the following ION Setup example, the PT/CT Correction Setup Assistant allows you to configure the Instr Xformer modules on the meter.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select Revenue > PT/CT Correction.
3. Select Active Correction and click Edit. The Transformer Correction Setup wizard is displayed.
4. Select the Voltage Inputs check box to turn on voltage (PT) correction and the Current Inputs check box to turn on current (CT) correction.

5. Enter the number of test points for each (four maximum) and the nominal voltage/current. Click Next to proceed.
6. On the Correction screen, select a U1 Test Point and click Edit. Enter the Test Point Info into the dialog box and click OK. Click Next.

7. Repeat previous step for each voltage and current phase. Click Next to finish.

Using Designer

Open your meter in Designer and navigate to the Advanced Setup > Core Modules folder. Right-click an ITC module to edit.
Transformer Line Loss Compensation (TLC)

Transformer Loss Compensation is used when a meter’s actual location is different from the electrical location where change of ownership occurs; for example, where meters are connected on the low-voltage side of power transformers when the ownership change occurs on the high-side of the transformer. This physical separation between meter and actual billing point results in measurable losses. Compensating for this loss - Loss Compensation - is the means of correcting this meter reading. Losses may be added to or subtracted from the meter registration.

Meters are usually installed on the low-voltage side of a transformer because it is more cost-effective. There are also cases where change of ownership may occur halfway along a transmission line where it is impractical to install a meter. In this case, power metering must again be compensated.

**NOTE**
Due to the variation in installations, advanced knowledge of power systems and connection methods is required before transformer loss compensation can be properly implemented. Data parameters should only be programmed by qualified personnel that have appropriate training and experience with Transformer Loss Compensation calculations.

See the Transformer / Line Loss Calculations technical note for more information.

**Configuring TLC**

Use ION Setup or ION Enterprise software to change your meter’s TLC settings.

**Using the front panel**

You cannot configure Transformer Line Loss Compensation using the front panel.

**Using ION Setup**

The Revenue Setup Assistant helps you configure TLC. The Transformer Loss screen allows you to enable/disable TLC, choose which method you prefer (1 or 2) and configure TLC settings.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select Revenue > Transformer Loss. Click the Method Selection tab.
3. Select Loss Comp Enable and click **Edit**.

![Image of Edit button](image)

4. Select Comp Enabled from the drop-down list and click **OK**.

5. Next choose the TLC method you want to use by selecting Comp Mthod Slct and clicking the **Edit** button.

   Select Method 1 to use the Test Sheet method and Method 2 to use the %Loss Constants method.

6. Finally, click the tab of the TLC method you chose in the previous step and configure the settings for that method.

**Using Vista**

1. Open your meter in Vista.

2. Select the **Setup/Diagnostic** tab.
3. Click **Loss Compensation**. The following window appears:

4. Configure your values as required.

See the *Transformer / Line Loss Calculations* technical note for more details on this feature.
Time of Use

The Time of Use module may only be important if you are using the meter in a billing application (i.e. you are a power provider), as the module contains the meter’s seasonal rate schedules. Typically, power consumers do not need to configure the Time Of Use module.

See the ION Reference for more information on the Time of Use module.

Configuring Time of Use

Use ION Setup or ION Enterprise software to change your meter’s Time of Use settings.

Using the front panel

You cannot configure Time of Use using the front panel.

Using ION Setup

The Time of Use Setup Assistant helps you configure the Time of Use module.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select Revenue > Time of Use.

3. Select a Time of Use program from the list (in this example, Sample TOU) and click Edit. The Time of User Setup wizard is displayed.
4. Follow the instructions in the Time of Use Wizard to configure your program and click Finish. Click Send to save the TOU program on your meter.
Using Designer

Open your meter in Designer and navigate to the Time-of-Use Setup Framework. Right-click the Time of Use module to edit.
Time Of Use module settings

The Time of Use module’s setup registers define your seasons’ start and end dates, the day types where your rates may differ, and the rate schedules for each season’s day types. The module compares the meter’s internal clock with the season, day, and time of day settings in these registers, and changes its output registers to reflect the current state of these settings.

Seasonal settings

The Time of Use module supports up to four separate seasons. Each season’s start and end dates are set into the appropriate Season setup register.

NOTE

Ensure that there is no date overlapping when defining seasons and that every day of the year is covered by your seasons. If there are gaps between seasons, the module returns an error message and will not function.

If your rates do not change between seasons, you do not need to configure the Season setup registers — Season 1 is the default, and all Season 1 rates are in effect all year.

If you have different seasons, enter their start and end dates into the appropriate setup registers. If your season is active on the same dates every year, you only need to enter a single range of dates in the appropriate Season setup register. If the active dates are different each year (for example, Season 3 becomes active every first Monday in August), the start dates must be individually specified for each year.

The Time of Use module is partially configured at the factory. Check the setup registers to ensure that the settings match your Time of Use schedules.

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Season 1-4</td>
<td>These setup registers define the dates for each active season. When a season is active, the Time of Use module will use the applicable rate schedules.</td>
</tr>
<tr>
<td>Season 1 - 4 Weekday Rates</td>
<td>These setup registers specify seasonal weekday rates.</td>
</tr>
<tr>
<td>Season 1 - 4 Weekend Rates</td>
<td>These setup registers specify seasonal weekend rates.</td>
</tr>
<tr>
<td>Season 1 - 4 Alt 1 Rates</td>
<td>These setup registers specify a season's daily rates during the days specified in the Alt 1 Days setup register.</td>
</tr>
<tr>
<td>Season 1 - 4 Alt 2 Rates</td>
<td>These setup registers specify a season's daily rates during the days specified in the Alt 2 Days setup register.</td>
</tr>
<tr>
<td>Season 1 - 4 Holiday Rates</td>
<td>These setup registers specify a season's daily rates during the days specified in the Holidays setup register.</td>
</tr>
</tbody>
</table>
Displaying Time of Use

View Time of Use module values in the following locations:

<table>
<thead>
<tr>
<th>Application</th>
<th>Menu</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front panel</td>
<td>Active TOU Rate, Active TOU Season and TOU Energy by Rate screens</td>
<td>ALT displays</td>
</tr>
<tr>
<td>ION Setup</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Vista</td>
<td>Time of Use Screen</td>
<td>Revenue tab &gt; Time of use object</td>
</tr>
<tr>
<td>WebMeter</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Chapter 15  Power quality

This chapter explains how to configure your meter's power quality functionality.

In this chapter

◆ Introduction ......................................................... 170
◆ Configuring power quality ........................................ 170
  Using the front panel .............................................. 170
  Using ION Setup .................................................. 170
  Using Designer .................................................... 171
  Sag/Swell module settings ................................. 171
  Transient module settings (ION8800A only) ............ 172
  Power quality standards compliance ...................... 173
    EN50160 settings (ION8800A and ION8800B) ...... 173
    4-30 settings (ION8800A and ION8800B) .......... 173
    COMTRADE settings (ION8800A only) .............. 173
Introduction

The power quality capabilities of your meter depend on the feature set ordered:

<table>
<thead>
<tr>
<th>Meter type</th>
<th>Sag/Swell</th>
<th>EN50160/IEC 61000-4-30</th>
<th>Transients and waveform capture</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>X</td>
<td>X^1</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>X</td>
<td>X^1</td>
<td>X</td>
</tr>
</tbody>
</table>

^1 The ION8800A complies with 4-30 edition 2 Class A, and the ION8800B complies with 4-30 edition 2 Class S.

Power quality configuration is provided by a number of modules, including the Sag/Swell module, the Transient module, and the Mains Signalling Evaluation modules. Your meter may not have all these modules. Refer to the ION Device Template Reference for a list of modules provided based on meter type and firmware version.

See the ION Reference for more information on these modules.

Configuring power quality

Use ION Setup or ION Enterprise software to change your meter’s power quality settings.

Using the front panel

You cannot configure power quality from the front panel.

Using ION Setup

The Power Quality Setup Assistant helps you configure the various power quality modules.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.

2. Select Power Quality.
3. Select the **Sag/Swell** tab to set sag and swell limits, configure sag/swell waveform recorder settings, enable COMTRADE waveform records, and, most importantly, record your system’s nominal voltage.

4. Select the **Transient** tab to configure various settings such as voltage deviation threshold, transient waveform recorder depth and frequency and enable COMTRADE waveform records.

**NOTE**
The meter features dual waveform capture: Sags are recorded at 32 samples x 54 cycles. Transients waveform capture at 256 samples x 7 cycles.

**NOTE**
COMTRADE Status must be **DISABLED** in order to change the Waveform format or Post Event Cycles values. Refer to the **COMTRADE and ION technology** technical note for more information about COMTRADE format waveform records.

### Using Designer

Open your meter in Designer and navigate to the Power Quality Setup framework. Right-click a module to edit.

### Sag/Swell module settings

The Sag/Swell module monitors voltage waveforms for sags and swells (i.e. ITI [CBEMA] Type 2 and Type 3 disturbances). It then reports each disturbance’s magnitude and duration. The Sag/Swell module can also detect sub-disturbances during a Sag/Swell event. Settings are as follows:

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swell Lim</td>
<td>This is the magnitude above which a voltage deviation is considered a swell (percentage of the nominal voltage).</td>
<td>106</td>
</tr>
</tbody>
</table>
The primary power system voltage is sometimes different than the PT Primary setup register value (i.e. when the PT Primary is used to indicate winding ratio rather than primary voltage). Besides NomVolts, the only setup registers that you may need to configure in the Sag/Swell module are Swell Lim and Sag Lim. Most applications are served by the default values entered into these registers. The Change Crit and EvPriority setup registers do not need to be changed for normal operation. Refer to the ION Reference for detailed information about the Sag/Swell module and its registers.

**NOTE**

If the Sag/Swell module’s Nom Volts setup register is set to zero, all Sag/Swell module functions are disabled. Nom Volts is typically set when the meter is put into service. If Nom Volts has not been set, enter a value for your system’s nominal voltage (i.e. 120, 277, or 347). The value you enter is also used by other modules for power quality functions.

### Transient module settings (ION8800A only)

The Transient module monitors voltage waveforms for transient activity (i.e. ITI [CBEMA] Type 1 disturbances). The Threshold setup register defines what voltage disturbance magnitude should be considered as transient activity. Threshold is interpreted as a percentage of the nominal system voltage, plus 100. For example, if you want transients recorded when voltage deviates from nominal by 20%, enter 120 into the Threshold setup register.

<table>
<thead>
<tr>
<th>Setup register</th>
<th>Function</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>This is the magnitude at which a voltage deviation is considered a transient.</td>
<td>125</td>
</tr>
<tr>
<td>EvPriority</td>
<td>The priority assigned to Sag/Swell and Transient module events (0 to 255, 255 is highest).</td>
<td>200</td>
</tr>
</tbody>
</table>
Power quality standards compliance

The ION8800 has additional frameworks and settings related to the power quality standards below.

**EN50160 settings (ION8800A and ION8800B)**

The EN50160 framework is composed of numerous ION modules including: Mains Signaling Evaluation, Harmonics Evaluation, Voltage Harmonics, Flicker, and more.

See “EN50160 compliance logging (EN50160 ordering option only)” on page 151 for information on EN50160 parameter logging.

See the *Power Quality: ION meters and EN50160* technical note for details.

**4-30 settings (ION8800A and ION8800B)**

The ION8800 meter complies with IEC 61000-4-30 edition 2 power quality standard: the ION8800A meets class A, and the ION8800B meets class S. 4-30 compliance is provided by a variety of ION modules including: Power Quality Aggregator, Harmonics Measurement, Symmetrical Components, Sag/Swell and more.

See the *4-30 compliance and ION meters* technical note for details.

**COMTRADE settings (ION8800A only)**

The meter can provide waveforms in COMmon format for TRAnsient Data Exchange (COMTRADE) format. COMTRADE records are created from the existing Waveform Recorder modules, which are connected to the COMTRADE module(s).

See the *COMTRADE and ION Technology* technical note for details.
Chapter 16 Displays

This chapter explains the available front panel displays. It also includes procedures for customizing displays using ION software.

In this chapter

- Introduction .................................................. 176
- Configuring front panel displays ..................... 176
  - Using the front panel ........................................ 176
  - Using ION Setup .............................................. 176
  - Using Designer ................................................ 177
- Default front panel display screens .................. 180
  - NORM mode display screens ............................. 180
  - ALT mode default display screens ..................... 180
  - TEST mode default display screens ................... 183
Introduction

The ION8800 ships with preconfigured display screens designed to suit the data needs of most users. Different types of screens are available depending upon the meter’s current mode of operation (see “Modes of operation” on page 26 for more information).

Front panel displays can also be customized on your meter to show virtually any measurement or calculation. For example, you could do one or all of the following:

- change displayed parameters, such as from $U_{ll}$ to $U_{ln}$ or $U_{ll12}$ to $U_{ln1}$
- adjust character size to be different on each screen
- change data display settings such as backlight timeout, automatic display scrolling, parameter update rate and display mode

Use ION Setup or ION Enterprise software to customize your front panel display screens.

Configuring front panel displays

Using the front panel

Display settings are located in the Display Setup menu. See “Display Setup menu” on page 32 for more information.

Using ION Setup

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Click Displays.
3. Click the Front Panel tab.
4. Select Displays and click Edit.
   ION Setup uploads your meter’s display information to the Display Editor. This may take a few moments.
5. Edit, rename, delete or rearrange displays as desired. You can also select in which mode the display will be shown.
6. If you choose to edit or create a new display, the Display Editor wizard contains three steps for creating or editing display screens.
7. Click **Send** to save the changes in the meter.

### Using Designer

**NOTE**

Before you reconfigure or delete a framework, you should make a copy. This ensures that you can restore the framework without having to reinitialize the factory configuration.

**To remove a data display screen:**

1. Launch Designer and navigate to the Display Setup framework.
2. Select the Display module responsible for the screen.
3. Press DELETE. This also deletes all links to that particular Display module. Click **OK** to save your changes.

If the display screen you are deleting is part of the automatic scrolling cycle, you should reconfigure the links from the Scroll module’s **Trigger** outputs to the remaining Display modules so that the following considerations hold true:

- The first Display module in the scrolling cycle is linked to the **Trigger 1** output of the Scroll module.
- The last Display module in the scrolling cycle (module $n$) is linked to the **Trigger $n$** output of the Scroll module. For example, if your scrolling cycle consists of 5 screens, then **Trigger 5** should be linked to the fifth module in the cycle.
◆ The Wraparound setup register of the Scroll module designates the last trigger output (Trigger n). Expanding on the previous example, since Trigger 5 is the last trigger, the Scroll module’s Wraparound setup register would have a value of 5.

To add a new display screen
1. Create a Display module.
2. Define the module’s characteristics (display format) by adjusting its setup registers.
3. Link any required data to the Source inputs of the Display module.

If you want your new screen to appear in the automatic scrolling cycle, then you must link the Show input of the Display module to a Trigger output of a Scroll module.

To create a Disk Simulator screen
1. Create a new Display module and set the type as Disk Simulator.
2. Connect the new Display module’s first input to the Calibration Pulser module’s Disk Position output that you want to monitor for its pulsing interval.
3. To include the newly added screen to the ALT screen list, connect the Display module’s Show1 and Show2 inputs to the Scroll module’s last available Trigger outputs in ALT SCROLL UP and ALT SCROLL DOWN (respectively).
   You can determine the last available Trigger by right-clicking on the output to discover the Triggers’ owners.
4. Increase the Scroll module’s Wraparound setup register by 1 to include the new screen.
5. Configure the remaining display settings according to your needs.
   Although the Disk Simulator display is intended to show the disk behavior of mechanical watt-hour meters, this feature can be used to monitor any accumulated meter quantity over the time. To do this, connect the Display module’s first input to the meter quantity and connect the second input to the maximum value that you expect the displayed quantity to be bounded by (this could be any ION output register or an External Numeric module register). In this case, (i.e. the Display module is not connected to a Calibration Pulser module) the Disk Simulator revolves from left to right.
   If the associated Calibration Pulser module is set for NET accumulation, and a negative value is accumulated and sent to the Disk Simulator display, the negative number on the display will be a negative accumulation, but the display disk will still go from left to right (forwards). To make the display disk go from right to left (backwards), set the associated Calibration Pulser module’s Int Mode register to REVERSE.

⚠️ NOTE

The inputs to the Disk Simulator display are always positive. If the value exceeds the maximum scale value assigned in the second input, then nothing is displayed except labels and the disk rectangle.
To configure leading zeros

The leading zeros and decimal point in a numeric display can be configured with the Display module setup register *Screen Resolution*. For example, the number 276.3443 can be configured in one of the following ways, depending on the selection you make in the *Screen Resolution* setup register:

<table>
<thead>
<tr>
<th>Value</th>
<th>Screen resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>276.3443</td>
<td>1.x = 276.3</td>
</tr>
<tr>
<td></td>
<td>1234.xx = 0276.34</td>
</tr>
<tr>
<td></td>
<td>123456. = 000276.</td>
</tr>
</tbody>
</table>

If the *Screen Resolution* setup register is set to DEFAULT, the Display module will use the resolutions defined in the Display Options module.

Last digit mode

The Display module setup register *Last Digit Mode* lets you specify whether to truncate or round a value’s last digit. Numbers round up at 5 or greater, and round down from 1 to 4. A truncated value disposes of any digits after the number of decimal places that you have specified in the *Screen Resolution* setup register.

<table>
<thead>
<tr>
<th>Screen resolution = 1.xxx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Rounded</td>
</tr>
<tr>
<td>Truncated</td>
</tr>
</tbody>
</table>

To configure parameter titles

The parameter value on a display screen is the value of an output connected to the Display module *Source* input register. By default, the displayed parameter’s title is the name of the output connected to the *Source* input. The Display module *Source Title* setup register lets you change the default to a title that better describes your system. For example, if “KWh Net” is linked to the first *Source* input, you could change its display name by setting *Source 1 Title* to “KWh Net West.” A maximum of 25 characters is permitted.

See “Changing TEST mode timeout” on page 189 for information on configuring TEST mode display timeouts.
Default front panel display screens

Each mode of operation (NORM, ALT and TEST) has its own display screens, providing various power system data and meter properties screens.

NORM mode display screens

The factory-configured ION8800 meter scrolls through nine displays detailed below. If the settings in the Scroll module have not been altered, each screen is displayed for five seconds if no front panel buttons are pressed.

Display scrolling is suspended when a front panel button is pressed, and you can manually scroll through the display screens using the Up or Down arrow buttons. If required, see “Front panel features” on page 20 for more instructions on using the front panel buttons.

- **kWh**: This screen displays kWh delivered and received values.
- **kvarh**: This screen displays kvarh delivered and received values.
- **kVAh**: This screen displays kVAh delivered and received values.
- **Peak Demand Delivered**: This screen displays the maximum delivered kW value and a timestamp of when the peak occurred. This value is a Sliding Window (Rolling Block) demand calculation.
- **Peak Demand Reset Count**: This screen displays a count of the number of Demand Resets executed as well as a timestamp of the latest Peak Demand Reset.
- **Q Metering**: This screen displays approximated varh measurements, one phase (60 degrees) behind the normal watthour connection (90° - 330° and 150° - 270°).
- **kWh Disk Simulator**: This display simulates the behavior of a mechanical watt-hour meter indicating power received or delivered by the direction of the pulse.
- **All Segments**: This is a screen test where a black screen showing all segments (all pixels on) indicates that the display is functioning properly.

ALT mode default display screens

The meter scrolls through the following ALT mode displays. If the settings in the Scroll module have not been altered, each screen is displayed for five seconds if no front panel buttons are pressed (until five minutes have elapsed).

Viewing ALT display modes

1. Press the Alt/Enter button once to toggle between the NORM and ALT display modes.
2. Press the Up or Down arrow buttons to scroll back or forth through the displays.

If no buttons are pressed the meter reverts back to NORM mode after five minutes.
NOTE

These screens vary depending on the firmware version on the meter and custom display configuration.

- **Name Plate 1**: The Name Plate 1 screen contains this information:
  - **Owner**
  - **TAG1 from Factory module**
  - **TAG2 from Factory module**
  - **Firmware revision of the meter**
  - **Battery life indicator**
  - **Meter serial number**

  TAG1 and TAG2 typically identify the meter’s user and installed location. The Owner and TAG registers are configurable with ION software. See “How to tag your meter” on page 36.

- **Name Plate 2**: This screen displays the following information for the current Sliding Window (Rolling Block) demand settings:

<table>
<thead>
<tr>
<th>CONFIG</th>
<th>Length of the demand period multiplied by the number of demand periods</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPDATE</td>
<td>Length of the demand period</td>
</tr>
<tr>
<td>SYNC</td>
<td>Clock synchronization source</td>
</tr>
<tr>
<td>MAX (kW)</td>
<td>Maximum kW Demand¹</td>
</tr>
</tbody>
</table>

¹ The MAX (kW) value is a maximum allowable demand level based on installed transformer configurations and nominal voltages and currents.

- **Event Log**: The Event Log screen displays up to four of the most recent, highest priority events (priority 255 only). The date, a timestamp, an event description, and an event code are provided for each event displayed.

  If more than four high priority events have been recorded, then the Event Log screen will indicate additional logs exist. See “Data logging” on page 146 for more information.

- **Vector Diagram**: This screen shows phasors and numeric values for each phase current and phase voltage measurement.

- **Instantaneous Voltage**: This screen shows average voltage, line-to-neutral and/or line-to-line voltage (depending on the meter’s service type).

- **Instantaneous Current**: This screen shows the phase current and average current values.

- **Instantaneous Power**: This screen shows kW total, kvar total, kVA total and signed Power Factor total values.

- **Instantaneous Demand**: This screen shows kW delivered and received from the Sliding Window (Rolling Block) demand calculation.

- **Voltage Harmonics**: These screens show histograms of the per phase voltage harmonic content.

- **Current Harmonics**: These screens show histograms of the per phase current harmonic content.
ALT mode Time of Use (TOU) display screens

Some ALT mode display screens are factory-configured to show Time of Use (TOU) data. The measurements displayed originate from frameworks of ION modules that are linked to a TOU module. For details about the TOU module, refer to the ION Reference.

By default, all demand values result from Sliding Window (Rolling Block) calculations.

- **Active TOU Rate**: This screen shows which of the valid TOU billing rates is active.
- **Active TOU Season**: This screen shows which TOU billing season is currently active.
- **TOU Energy by Rate**: This screen shows kWh delivered values for each TOU rate.
- **kW Peak Demand**: These screens display the maximum kW delivered value for each TOU rate. These values result from Sliding Window (Rolling Block) demand calculations.
- **Past Billing Energy**: This screen displays the kWh delivered values for each TOU rate in the previous billing period.

**NOTE**

PB = Past (Previous) Billing period. A billing period is the time between two consecutive meter readings for billing purposes by a utility.

- **Past Billing Peak Demand**: These screens display the maximum kW delivered value for each TOU rate in the previous billing period. These values result from Sliding Window (Rolling Block) demand calculations.
- **Past Season Energy**: This screen displays the kWh delivered for each TOU rate in the previous billing season. These values result from Sliding Window (Rolling Block) demand calculations.

**NOTE**

PS = Past (Previous) Season. Billing Seasons are defined in the TOU module description in the ION Reference.

- **Past Season Peak Demand**: These screens display the maximum kW delivered for each TOU rate in the previous billing season.
- **Past Billing/Season Energy**: These screens display the kWh delivered and received values in the previous billing period and billing season.
- **Past Bill/ Season Pk Demand**: These screens show the maximum kW sd received values in the previous billing period and billing season. These values result from a Sliding Window (Rolling Block) demand calculation.
- **Past Billing/Season Energy**: These screens display the kvarh delivered and received values in the previous billing period and billing season.
- **Past Bill/Season Pk Demand**: These screens display the kvar delivered and received values in the previous billing period and billing season. These values result from a Sliding Window (Rolling Block) demand calculation.

- **Past Billing/Season Energy**: These screens display the kVAh delivered and received values in the previous billing period and billing season.

- **Past Bill/Season Pk Demand**: These screens display the kVA delivered and received values in the previous billing period and billing season. These values result from a Sliding Window (Rolling Block) demand calculation.

- **Frequency**: This screen displays frequency information.

**TEST mode default display screens**

Values shown in the TEST mode display screens represent different accumulators than those shown in NORM mode (although they perform some of the same basic measurements). The TEST mode display values are for calibration checking purposes; they will only accumulate while the meter is in TEST mode.

**Viewing TEST mode**

There are two ways to switch the meter into TEST mode depending on the type of meter you have:

- **Unlocked meter**: You can use ION Setup or ION Enterprise software or press a button on the front panel; see “Switching to TEST mode” on page 186.

- **Hardware-locked meter**: You must open the cover on the meter and press the TEST Mode button.

Once the meter is in TEST mode the front panel cycles through the three TEST mode display screens summarized below.

- **kWh Test**: This screen shows TEST mode kWh delivered and received values.

- **kvarh/KVAh Test**: This screen shows TEST mode kvarh/KVAh delivered and received values.

- **Instantaneous Demand Test**: This screen shows TEST mode kW delivered and received values. Both quantities are produced from a Sliding Window (Rolling Block) demand calculation. This value is reset if the Demand Reset button is pressed while the device is in TEST mode.
Chapter 17  TEST Mode

This chapter describes your meter’s TEST mode and explains how to switch from Normal mode to TEST mode.

In this chapter

◆ Introduction .......................................................... 186
◆ Switching to TEST mode ......................................... 186
  Using the front panel (all meters) .......................... 186
  Using ION Setup (unlocked meter) ......................... 186
  Using ION Setup (hardware-locked meter) .............. 187
  Using Vista (unlocked meter) ............................... 187
  Using Vista (hardware-locked meter) .................... 188
◆ Changing TEST mode timeout ................................. 189
  Using the front panel ........................................... 189
  Using ION Setup .................................................. 190
  Using Designer .................................................... 190
◆ TEST mode default display screens ....................... 190
  TEST mode LED energy pulsing ............................ 191
Introduction

TEST mode is typically used for verifying meter calibration and function. The meter is usually reading data from a test power supply while these functions are performed.

Several things to note about TEST mode:

- All of the billing quantities that are recorded when the meter is in normal mode will stop accumulating when the meter is switched to TEST mode — the data is sent to special TEST mode registers instead.
- The values accumulated in these test registers are displayed on the front panel and in ION software.
- The regular normal mode billing registers are unaffected while the meter is in TEST mode; accumulation of this data continues as soon as you exit TEST mode.
- All test registers are reset to zero when you exit TEST mode.

NOTE

The meter will always return to NORM mode when you exit TEST mode, even if you entered TEST mode from ALT mode.

Switching to TEST mode

Place the meter into TEST mode using the front panel, ION Setup or Vista. The meter's front panel informs you when the meter is in TEST mode with a special display screen.

NOTE

You cannot place a hardware-locked meter in TEST mode using ION software. The meter must be placed in TEST mode by pressing the TEST Mode button.

Using the front panel (all meters)

The TEST Mode button on the meter is located under the meter cover. You must open the cover to access it. For sealed meters, you must first break the cover seal.

Once you have opened the outer cover, press the TEST Mode button.

Using ION Setup (unlocked meter)

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Click Verification.
3. Select TEST Mode from the **Verification** tab and click **Display**. If meter security is enabled, you are prompted for password. A dialog box informs you the meter is in TEST mode.

4. Click **OK**. The TEST Mode screen appears and test values are displayed.

5. Click on the tabs to perform various test-related tasks. See the **ION Setup** online help for more information.

6. Click **Close**. A dialog box informs you the meter is back in Normal Mode.

### Using ION Setup (hardware-locked meter)

You cannot place a hardware-locked meter in TEST mode using ION Setup or ION Enterprise software. The meter must be placed in TEST mode via the front panel. See “Switching to TEST mode” on page 186.

### Using Vista (unlocked meter)

1. Open the meter in Vista.

2. Navigate to **Setup/Diagnostics** and click the **General** button.
3. Select the TEST Mode radio button. You are prompted for the ION Enterprise user password. If standard meter security is enabled, you are also prompted for the meter password.

Use this screen to reset the registers that accumulate real-time data.

4. To view test mode values, navigate to the Revenue tab and click the Test Mode Values button.

For more information, see the Vista section of the online ION Enterprise Help.

**Using Vista (hardware-locked meter)**

You cannot place a hardware-locked meter in TEST mode using ION Setup or ION Enterprise software. The meter must be placed in TEST mode via the front panel. See “Switching to TEST mode” on page 186.
Changing TEST mode timeout

If no front panel buttons are pressed, the meter will exit TEST mode after 30 minutes (unless the default TEST mode timeout value has been changed). While in TEST mode, the value on the bottom right of the status bar indicates the amount of time before TEST mode times out. The meter always returns to NORM mode when the TEST mode timeout elapses.

You can change the value of the TEST mode timeout using ION Setup or ION Enterprise software or the front panel.

Using the front panel

Follow these steps if you are using the front panel:

1. Enter the Setup menu by holding down the Alt/Enter button.
2. Scroll through the menu items, highlight DISPLAY OPTIONS, and press the Alt/Enter button.
3. Scroll down and highlight the TEST MODE TO menu item. Press Alt/Enter.
4. The current TEST mode time-out is displayed. Use the Up or Down arrow buttons to change the value of the highlighted digit. Press the Up or Down arrow button to move the cursor left or right. When you have entered the new value of the TEST mode time-out in seconds, press the Alt/Enter button.
5. Select YES to confirm the change and enter the meter password, if required.
Using ION Setup

Follow these steps if you are using ION Setup:

1. Start ION Setup and connect to the meter in Advanced Mode.
2. Locate the Display Options module in the module list and double-click to open the module.
3. In the Display Options module, click the Setup Registers tab and double-click the **TEST Mode Timeout** setup register. The default setting for this setup register is 1800 seconds (30 minutes).
4. Choose from numeric bounded format or elapsed interval format and set the TEST mode timeout to the desired time.
5. Click **Send** to transmit the changes to the meter.

Using Designer

Follow these steps if you are using Designer:

1. Open Designer and connect to the desired meter.
3. Right-click on the Display Options module to access the setup registers. Select the **TEST Mode Timeout** setup register and click **Modify** to edit.
4. Set the TEST mode timeout to the desired time. You can choose from a numeric bounded format or an elapsed interval format.
5. Click **OK** to send the changes to the meter.

**TEST mode default display screens**

Values shown in the TEST mode display screens represent different accumulators than those shown in NORM mode (although they perform some of the same basic measurements). The TEST mode display values are for calibration checking purposes; they will only accumulate while the meter is in TEST mode.

Once the meter is in TEST mode the front panel cycles through three TEST mode display screens:

- **kWh TEST**: This screen shows TEST mode kWh delivered and received values.
- **kvarh/KVAh TEST**: This screen shows TEST mode kvarh/KVAh delivered and received values.
- **Instantaneous Demand TEST**: These screens show TEST mode kW delivered and received values. Both quantities are produced from a Sliding Window (Rolling Block) demand calculation. This value is reset if the Demand Reset switch is turned while the device is in TEST mode.
TEST mode LED energy pulsing

Below the display screen are two pairs of energy pulsing LEDs and infrared outputs. The LEDs and IR outputs are factory-configured to pulse while the meter is in TEST mode.

The energy pulsing LEDs provide an ideal interface for accuracy verification instruments. The Pulsing Contact Outputs label (bottom right corner) indicates the factory-configured pulsing rate. (You can change the energy pulsing frequency with ION Setup or ION Enterprise software.)

See “TEST mode” on page 27 for basic information about TEST mode.
Chapter 18    Resets

This chapter provides instructions for performing various meter resets.

In this chapter

◆ Performing a reset ........................................... 194
   Using the front panel ........................................... 194
      Performing a Master Reset from the front panel .............. 194
      Parameters affected by a Master Reset ......................... 194
   Performing a Demand Reset from the front panel ............... 195
   Hardware-locked meters and Master Reset ....................... 195
      Parameters affected by a Demand Reset ....................... 195
   Using ION Setup ............................................. 196
   Using Vista .................................................. 196
   Master Resets and hardware-locked meters ...................... 197
Performing a reset

Resets allow you to clear various accumulated parameters stored by the meter.

**NOTE**

Be sure to record any important data before performing a meter reset.

Using the front panel

The following resets can be performed via the front panel:

- **Master Reset:**
  - deletes most accumulated values and all derived revenue measurements from the meter.
- **Demand Reset:**
  - resets the peak demand values logged in the meter.

Performing a Master Reset from the front panel

The Master Reset button is recessed to avoid accidental activation. You must open the meter’s cover before you can perform a Master Reset:

1. Remove the cover seal (if applicable).
2. Open the meter cover.
3. Using a pencil or similar instrument, press the **Master Reset** button.
4. At the confirmation screen, select YES to confirm the reset.

**NOTE**

Do not configure or power down your meter until the meter’s front panel displays a message stating that the master reset is complete. If you configure or power down your meter during a master reset, the affected parameters may not be completely reset.

Parameters affected by a Master Reset

The Master Reset button resets many of the device’s measurements and logs. The following parameters are reset to zero:

- Energy and demand
- Peak demand
- Loss calculation
- Power quality disturbance counters
- Time of use
The following are cleared:

- Event log
- All data recorders
- All waveform recorders
- All COMTRADE waveform records (Ethernet meters only)

Performing a Demand Reset from the front panel

The Demand Reset button is recessed to avoid accidental activation. You must open the meter’s cover before you can perform a Demand Reset:

1. Remove the cover seal (if applicable).
2. Open the meter cover.
3. Using a pencil or similar instrument, press the Demand Reset button.
4. At the confirmation screen, select YES to confirm the reset.

Hardware-locked meters and Master Reset

A hardware-locked ION8800 meter must first be unlocked to perform a Master Reset. To perform a Master Reset on a hardware-locked meter, you must first unlock the meter via the ALT Config menu (refer to “ALT Config button (B3)” on page 22). Then you can continue the Master Reset using the previous instructions.

Parameters affected by a Demand Reset

The mode that the meter is in (for example, NORM mode or TEST mode) defines the values that will be reset. The following parameters are reset to zero:

- Revenue peak demand
- TOU peak demand
- TOU previous billing peak demand
- Test peak demand

If $PkDemandMnMaxReset$ is enabled, all long term Min\Max values will also be reset. Note that this setting is disabled by default.

Demand lockout timeout

The setup register labeled Demand Lockout Timeout (Display Options module) sets the minimum time allowed between consecutive Demand Resets; the meter ignores any attempts to reset the demand outside the bounds of the register.

The default value for the Demand Lockout timeout is 25 days. For more information on the Demand Lockout Timeout setup register, refer to “Display Setup menu” on page 32.

For more details on the Display Options module, see the ION Reference.
Using ION Setup

**NOTE**
You can only perform a Master Reset via software on unlocked meters.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Click **Verification**.
3. On the **Verification** tab, select Normal Mode and click **Display**.

4. Click the various tabs to access the following reset buttons:
   - **Energy** - Master Reset
   - **Rolling Demand** - Peak Reset and Master Reset
   - **Volts, Amps and Power** - Master Reset
   - **Power Quality** - Master Reset

Using Vista

Open your meter in Vista. You can perform several resets from within Vista:

**Performing a Peak Demand Reset**

1. Select the **Revenue** tab and click the **Demand Max** or **Demand Min** control object.
2. Click the **Peak Demand Reset** button to perform the reset.

**Performing a Master Reset**

**NOTE**
You can only perform a Master Reset via software on unlocked meters.
1. Select the **Setup/Diagnostics** tab and click the **General** object.
2. Click the **Master Reset** button to perform the reset.

**Performing a Min/Max reset**
1. Select the **Volts & Amps** tab and click the **Long-term Min/Max** object.
2. Click the **Min/Max Reset** button to perform the reset.

**Performing Harmonics Min/Max reset**
1. Select the **Power Quality** tab and click the **Harmonics Details** object.
2. Click the **Reset Min/Max** button to perform the reset.

### Master Resets and hardware-locked meters

A Master Reset on a hardware-locked meter can only be performed from the front panel. The meter must also be unlocked first.

**TEST mode**

In TEST mode, the following screen is displayed:

```
MASTER RESET
UNAVAILABLE IN TEST MODE
```
Chapter 19  Setpoints

This chapter provides instructions for configuring meter setpoints.

In this chapter

◆ Introduction ................................................................. 200
◆ Configuring setpoints .................................................... 200
  Using the front panel ................................................... 200
  Using ION Setup .......................................................... 200
  Using Vista .................................................................... 200
Relative Setpoint module settings ........................................ 201
  Fine tuning over condition monitoring .............................. 201
Introduction

The Relative Setpoint module provides extensive non-critical control, secondary protection, and analysis capabilities by allowing you to initiate an action in response to a specific condition. It is particularly useful for performing actions based on differences between a value (e.g. kW on phase 1) relative to a reference value (e.g., kW demand for all three phases). Use this module's outputs for demand control of equipment or any other applications requiring setpoint activity relative to a varying value. See the ION Reference for more information on the Relative Setpoint module.

Configuring setpoints

Use ION Setup or ION Enterprise software to change your meter’s setpoints.

Using the front panel

You cannot configure setpoints using the front panel.

Using ION Setup

1. Connect to your meter in ION Setup, using Advanced Mode.
2. Navigate to the Relative Setpoint module you want to configure.

Using Vista

Open your meter in Vista, and select the Setpoints tab. Click the Setup grouping object. Use the switches to turn various monitoring on and off (see circled below). Click the numeric boxes to edit condition settings.

<table>
<thead>
<tr>
<th>Over kW SWDemand</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce if the total kW SW Demand exceeds 0 kW. Click to change value, then press Enter.</td>
</tr>
<tr>
<td>Enable Over Demand Setpoint</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand 1 kW</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Over Current on phase 1, 2, 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce if the current on phase 1 exceeds 4 A.</td>
</tr>
<tr>
<td>Announce if the current on phase 2 exceeds 4 A.</td>
</tr>
<tr>
<td>Announce if the current on phase 3 exceeds 4 A.</td>
</tr>
<tr>
<td>Over I a,b,c</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 4 A</td>
</tr>
<tr>
<td>12 5 A</td>
</tr>
<tr>
<td>13 4 A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Over Voltage unbalance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce if the Voltage unbalance exceeds 0 %.</td>
</tr>
<tr>
<td>Enable Over Unbalance Setpoint</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unbalance 0.1 %</td>
</tr>
</tbody>
</table>
Relative Setpoint module settings

Several Relative Setpoint modules monitor the following for “over” conditions: phase current, kW demand, and voltage unbalance. Other modules are used only for EN50160 operation. See the table for details.

<table>
<thead>
<tr>
<th>Module</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative Setpoint 1</td>
<td>Over KW sd</td>
<td>When active, this annunciates when the total kW SWDemand exceeds a specified amount.</td>
</tr>
<tr>
<td>Relative Setpoint 2</td>
<td>Over I 1</td>
<td>When active, this annunciates when the current on phase 1 exceeds a specified amount.</td>
</tr>
<tr>
<td>Relative Setpoint 3</td>
<td>Over I 2</td>
<td>When active, this annunciates when the current on phase 2 exceeds a specified amount.</td>
</tr>
<tr>
<td>Relative Setpoint 4</td>
<td>Over I 3</td>
<td>When active, this annunciates when the current on phase 3 exceeds a specified amount.</td>
</tr>
<tr>
<td>Relative Setpoint 5</td>
<td>Over U unbal</td>
<td>When active, this annunciates if the voltage unbalance exceeds a specified percentage.</td>
</tr>
<tr>
<td>Relative Setpoint 8-16</td>
<td>&lt;voltage phase&gt; (±15%) -&lt;time period&gt;</td>
<td>These nine modules are used for EN50160 operation. For more information, see the Power Quality: ION Meters and EN50160 technical note.</td>
</tr>
</tbody>
</table>

**NOTE**

There is usually no need to change any of the Relative Setpoint modules’ setup registers for normal operation of the meter.

See the *ION Reference* for more information on the Relative Setpoint module.

Fine tuning over condition monitoring

If you want to fine-tune over condition monitoring, the only setup registers you should change are *SusUntlON* and *SusUntlOFF*.

*SusUntlON* determines how long the modules wait after an over condition is detected before reporting it. This gives the monitored value a short period to correct itself before the event is registered with the module so that very brief over conditions are ignored. Similarly, *SusUntlOFF* is the amount of time a normal value must be present before the module considers normal operation to be restored. Both *SusUntlON* and *SusUntlOFF* values are entered in seconds (the default value for both is 30 seconds).
Chapter 20  Reports

This chapter provides instructions for viewing various meter reports and logs.

In this chapter

◆ Introduction ......................................................... 204
◆ Viewing meter logs ............................................... 204
   Using the front panel ........................................... 204
   Using ION Setup ............................................... 204
   Using Vista .................................................... 206
Introduction

Accumulated meter values are saved in logs. These logs are acquired by your energy management software (ION Enterprise or third-party) and saved in its database for analysis and reporting.

The Web Reporter component of ION Enterprise is a database reporting application that lets you define, generate, and manage comprehensive reports based on the information in your system database.

For more information on reports, see the Web Reporter section of the online ION Enterprise Help.

Viewing meter logs

View meter logs using ION Setup or ION Enterprise software or the front panel.

Using the front panel

The front panel only displays recent high priority events (Event Log screen).

<table>
<thead>
<tr>
<th>DATE</th>
<th>TIME</th>
<th>EVENT</th>
<th>CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/08/2005</td>
<td>10:23:45</td>
<td>Shutdown</td>
<td>SD25</td>
</tr>
<tr>
<td>12/08/2005</td>
<td>10:42:03</td>
<td>Power Up</td>
<td>SD25</td>
</tr>
<tr>
<td>12/08/2005</td>
<td>11:19:26</td>
<td>Changed Setup</td>
<td>SD25</td>
</tr>
</tbody>
</table>

VIEW EVENT LOG THROUGH COMMUNICATIONS

9:36:54 12/09/2005 123 Q1 NORM

Press the Up and Down buttons to navigate to the Event Log.

Using ION Setup

Display various meter logs or reports using the Report Assistant.

1. Open the Setup Assistant for your meter. See the ION Setup help for instructions.
2. Select **Reports**.

![Image of Setup Assistant](image)

3. Select one of the logs or comparisons in the list and click **Display** to view the associated log.

4. Select which records you want to view (all, specific number, or date range) and click **OK**.

![Image of Upload Log Records](image)

Below is an example of an Event Log.

![Image of Event Log](image)

5. You can view, save, or print the logs or comparisons. Click **Close** to exit.
Using Vista

Open your meter in Vista and click on the various tabs available. Click a grouping object to view the associated logs. The following logs are available in Vista:

◆ Volts/Amps tab > Logs object:
  ◆ Voltage
  ◆ Current
  ◆ Power
  ◆ Power factor / Frequency
  ◆ Revenue data
  ◆ Meter events

◆ Power Quality tab:
  ◆ Transient & Dip/Swell statistics CBEMA
  ◆ Dip/swell
  ◆ Transients (if supported)
  ◆ Harmonics Log
  ◆ EN50160 (if supported)
Chapter 21  Verifying accuracy

All ION8800 meters are tested and verified at the factory according to ANSI (American National Standards Institute) and IEC (International Electrotechnical Commission) standards; however, before a new revenue meter is installed it is important to perform a final accuracy verification.

ION meters are digital and do not require calibration, only verification of their accuracy. This chapter outlines a procedure for accuracy testing ION8800 meters.

In this chapter

- **Introduction** .......................... 208
  - Accuracy standards .................... 208
  - Current ranges ........................ 208
  - Testing overview ..................... 208
- **Test procedure** ....................... 211
- **Connecting the test harness** ........ 213
- **Connecting the control equipment** .... 215
  - Option A: using the meter's front panel LEDs .......... 215
  - Using the meter's digital outputs ..................... 215
- **Configuring test settings** ............ 216
  - Test points ............................ 216
Introduction

The revenue-accurate ION meter is digital and therefore needs no servicing. It is tested for accuracy at the factory and remains accurate for the life of the meter. In contrast, electro-mechanical meters need mechanical adjustment before installation and periodic calibration thereafter. This procedure of ‘calibration testing’ is unnecessary for digital meters.

Digital meters require verification testing to help ensure the meter meets required accuracy specification. If you know your meter is within required accuracy specification before installation, errors observed in the field could be attributed to incorrect connections or instrument transformer ratio settings.

Accuracy standards

The meter conforms to the following accuracy standards:

- IEC 62053-22 Class 0.2S (for 1 A and 5 A)
- ANSI C12.20 Class 0.2

Current ranges

The meter meets the following current ranges:

- Compatible with CTs in the range of 10 mA to 10 A
- Over-range current of 14 A
- Starting current of 1 mA

Testing overview

The most common method for testing meters is to inject voltage and current from a stable power source in combination with a reference meter. Although meter shops use different methods for testing revenue meters, most test equipment requirements are similar. The sections below provide an overview and some test equipment guidelines for verifying the accuracy of your meter.

Test harness

A test harness is essential for non-socket meters. Ensure that the test harness for the meter is wired properly. Any current and voltage transformers must be accurately rated and must perform within specifications to provide accurate results.

Power source

It is important to have a steady power source. Power that energizes the meter must be reliable and provide: the rated voltage of the meter, unity power factor (1) and lagging power factor of 0.0 (for varh testing) or 0.5.
Test loads

There are three methods of current loading: customer’s load (a meter in service), resistance load (characteristics similar to a lighting load), and phantom loading (a test board). Your test load device or other loading circuit must be set within the current capacity ranges for the meter. The procedure outlined in this chapter describes verification using a phantom load or test board.

The meter will maintain its accuracy during signal source variations, but its energy pulsing output needs a stable test signal to produce accurate test pulses. The meter energy pulsing mechanism needs approximately three to four seconds to stabilize after every source adjustment; the meter measurements are accurate during the signal source transitions, but the pulse output should be allowed to stabilize before the start of every test to help ensure accuracy.

Control equipment

Control equipment is required for counting and timing the pulse outputs (revolutions) from the front panel LEDs. Most standard test benches have an arm with infrared sensors used for this purpose.

NOTE

The optical sensors on the test bench can be disrupted by strong sources of ambient light (such as camera flashes, fluorescent tubes, sunlight reflections, floodlights, etc.) and cause test errors. Use a hood if necessary to block out ambient light.

Environment

The meter should be tested at the same temperature as the testing equipment. The ideal temperature is about 22°C (73°F). Ensure the meter is warmed-up sufficiently before testing.

A warm up time of 30 minutes is recommended for meters before energy accuracy verification testing. At the factory, the meters are warmed up to their typical operating temperature before calibration. This pre-calibration warm up helps ensure that the meter will reach their optimal accuracy at operating temperature.

Most high precision electronic equipment requires a warm up time before it reaches its specified performance levels. Both ANSI C12.20 and IEC62053-22 energy meter standards allow the manufacturers to specify meter accuracy de-rating caused by ambient temperature changes and self-heating. The meter accuracy de-rating specifications exceed the requirements of both these energy meter standards.

Grounding

DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

Connect protective ground (earth) before turning on any power supplying this device.

Failure to follow these instructions will result in death or serious injury.

The ION8800 meter’s safety ground terminal must be connected to a low impedance grounding system to help ensure meter accuracy. The signal source
and the reference meter (or energy standard) should also be grounded as recommended by their respective manufacturers.

If the test configuration allows, the meter's neutral voltage terminal should be grounded in any test configuration with unbalanced phase voltages.

**Reference meter or energy standard**

To help ensure verification testing accuracy, it is recommended that a reference meter or a reference energy standard, with a specified accuracy of ±0.025% or better, be used.

Before the start of testing, the reference meter or energy standard should be warmed up as recommended by its manufacturer.

**NOTE**

Ensure the accuracy and precision of any measurement equipment you use (i.e. voltmeters, ammeters, power factor meters).
Test procedure

The following are guidelines for testing the meter. Your meter shop may have other testing methods:

1. Turn off all power to the test harness or other standard measuring device to help prevent hazardous voltages on meter terminals and connected equipment. Use a properly rated voltage sensing device to confirm power is off.

2. Place the meter into the test harness or other standard measuring device. Ensure all voltages are in parallel with the meter being tested and all currents are in series (see “Connecting the test harness” on page 213). Ensure the meter’s protective ground (earth) is connected to the installation’s protective ground (earth).

3. Connect the control equipment used for switching the voltage to the test standard device.

4. Connect the control equipment used for counting the standard output pulses using either method:
   - Align the infrared sensor on the standard test bench armature over the appropriate front panel LED pulser (Wh or varh).
   - Connect to the meter’s digital outputs (see “Connecting the control equipment” on page 215).

5. Apply the rated current and voltage to the terminals of the meter.

6. Before performing the verification test, let the test equipment power up the meter. Apply voltage for at least 20 seconds. The warm-up allows the internal circuitry and capacitors to stabilize.

7. Set the meter’s volts mode to 4W-WYE.

8. Place the meter in Test mode (see Test Mode chapter for more details). This allows the meter to enter the field with no kWh values in the registers. If you are performing field testing, put the meter in Test mode to avoid incorrect customer billing.

9. Perform testing on the test points (see “Test points” on page 216).
10. Run each test point for at least 30 seconds to allow the test bench equipment to read an adequate number of pulses. Allow 10 seconds of dwell time between test points.
Connecting the test harness

The WECO model 8CA-1 adapter provides an easy means of connecting an ION8800 meter to a WECO test machine.

⚠️ DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

- Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA or applicable local standards.
- This equipment must only be installed and serviced by qualified electrical personnel.
- Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
- Always use a properly rated voltage sensing device to confirm that all power is off.
- Connect protective ground (earth) before turning on any power supplying this device.
- Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

1. Turn off all power to the test harness to help prevent hazardous voltages on meter terminals and connected equipment. Use a properly rated voltage sensing device to confirm power is off.

2. Connect the harness wires to the meter’s voltage and current inputs:
3. Plug the adapter into the WECO test machine’s socket.
4. Ensure the meter’s ground terminal (earth) and the test set ground (earth) are connected to each other.
5. Apply power to the test harness.
6. Set the WECO machine to 9S.

**NOTE**

Non-specified connections can be left floating (not connected).
Connecting the control equipment

You can use either the meter’s front panel LEDs or the digital outputs for control purposes. Refer to the “Energy pulsing” chapter for detailed descriptions and instructions for configuring your meter’s front panel LEDs or digital outputs for energy pulsing applications.

Option A: using the meter’s front panel LEDs

1. Carefully position the test machine’s optical arm over the appropriate LED pulser (Wh or varh).
2. Set test machine to “adjust optics” and check to ensure that the meter’s LED pulses are being read.

NOTE
Refer to “Energy pulsing with infrared ports and LEDs” on page 139 for detailed information.

Using the meter’s digital outputs

Connect the meter’s form C solid-state digital outputs to the WECO test machine. The Essailec connectors are found on the rear of the meter. See your meter’s Installation guide for details on your specific I/O wiring configuration. Refer to the “Energy pulsing with digital outputs” on page 141 for information on configuring your meter’s digital output hardware ports for energy pulsing.
Configuring test settings

When testing the meter, ensure the test parameters are suited to your testing methods. You may need to adjust the energy pulsing outputs' pulse rate (Kt value), pulse width, and the test mode timeout.

Refer to the “Energy pulsing” chapter for information on how to modify your meter’s front panel Wh or varh LEDs or for instructions on how to configure your meter’s digital output hardware ports for energy pulsing. Refer to “Changing TEST mode timeout” on page 189 for instructions on how to modify your meter’s test mode timeout settings.

Test points

NOTE
It is recommended that you test the ION8800 meter at full and light Loads.

Wh test points
It is common practice to test these points:

<table>
<thead>
<tr>
<th>Wh test point</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full load</td>
<td>100% of the rated current, test voltage and rated frequency at unity power factor, or one (1).¹</td>
</tr>
<tr>
<td>Light load</td>
<td>10% of the rated current, test voltage and rated frequency at unity power factor, or one (1).</td>
</tr>
<tr>
<td>Lagging power factor</td>
<td>100% of the rated current, test voltage and rated frequency at 0.50 lagging power factor (current lagging voltage by 60° phase angle).</td>
</tr>
</tbody>
</table>

¹ The rated test current is found on the ION8800 meter front panel label.

varh points
It is common practice to test these points:

<table>
<thead>
<tr>
<th>kvarh test point</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full load</td>
<td>100% of the rated current, test voltage and rated frequency at zero power factor (current lagging voltage by 90° phase angle).</td>
</tr>
<tr>
<td>Light load</td>
<td>10% of the rated current, test voltage and rated frequency at zero power factor (current lagging voltage by 90° phase angle).</td>
</tr>
<tr>
<td>Lagging power factor</td>
<td>100% of the rated current, test voltage and rated frequency at 0.50 lagging power factor (current lagging voltage by 60° phase angle).</td>
</tr>
</tbody>
</table>
A
accuracy testing
control equipment 209, 215
environment 209
grounding 209
power source 208
test harness 208, 213
test loads 209
test points 216
test procedure 211
test settings 216
alarm LED 133
Alerting 15
ALT Config button 22
ALT Config menu 34, 75
alt mode
display screens 180
switching to 26
time of use screens 182
B
basic setup
configuring 46
basic setup menu 29
bus wiring 84
buttons
spare 22
using navigation 29
C
Calibration Pulser module 21, 141
CBEMA/ITI 172
clock
configuring 118
meter battery 119
timesync source setup 52
communications
available protocols 88
configuring 88
connections 81
Ethernet 86
internal modem 87
LEDs 97
optical 82
overview 80
RS-232 85
RS-485 83, 84
Communications module 88
COMTRADE 96
configuring leading zeros 178
configuring parameter titles 179
confirming setup changes 29
CTR-21 compliant modems 93
D
data logging 146
configuring 146
time-stamping 119
viewing 152
Data Recorder module 148
daylight savings time 32
demand forgiveness 124
demand reset button 22, 183, 195
Digital Input module 134
digital inputs 134
digital outputs 75, 132, 141
DIN rack 14
display setup menu 32
displays
disk simulator 25
histogram 24
nameplate and event log 24
numeric 23
phasor 24
status bar 23
time and date 25
time stamped 25
types 23
DNP 3.0 88
configuring 109
factory configuration 109
E
EEM 11
EN50160
logging 151
power quality 170
Relative Setpoint modules 201
report 206
energy pulsing
configuring 142
customizing 139
default configuration 141
varh LED 139
watt-hour LED 139
Essailec connector 81, 129, 215
EtherGate 87, 92, 102
Ethernet 29
configuration 91
connections 86
LEDs 97
network setup menu 31
using DNP 3.0 over 109
using Modbus over 101
Ethernet Communications module 91
ether setup 31
event codes 120
Event Log Controller module 153
event logging 153
displaying 154
event priority 153
external ION events 153
external modem connections 86
F
factory configuration 37
Factory module 36
Form A relays 17
Form C relays 17, 215
format setup menu 31
front panel
  accessing the setup menu 28
  Ack alarms 33
  ALT Config button 22
  ALT Config menu 34
  com ports setup 30
  configuring leading zeros 178
  configuring parameter titles 179
  configuring the meter with 28
demand reset button 22
  display setup 32
  ethernet setup 31
  features 20
  format setup 31
  LED pulsers 21
  Master Reset button 22
  modifying password 33
  navigation buttons 21
  operational LEDs 21
  optical port 21
  security setup 32
  TEST mode button 22
  web config 33
FTP 96
G
getting more information 18
H
harmonics displays 181
histogram displays 24, 181
historic data logging 149
I
I/O
  combinations 130
  configuring 130, 135
  digital inputs 16, 134
  digital outputs 17, 132
IEC 61850 15, 96, 111
  configuring additional data 112
  configuring I/O control 113
IEC61000-4-30 170
indicator LED 133
instantaneous measurements 181
internet connectivity 95
ION Enterprise 14
ION Enterprise reporting 151
IRIG-B 16, 119
L
LEDs
  alarm 133
  communications 97
  indicator 133
  operational 21
  pulsers 21
logging
  changing parameters 147
  default capacity 148
  default configuration 149
  dip/swell 151
  EN50160 151
  harmonics 150
  historical data 149
  recording capacity 155
  revenue 149
  transient 151
M
Mains Signalling Evaluation module 170
Master Reset button 22
measured parameters 12
memory usage 155
meter applications 10
meter battery 119
meter email 14, 95
meter feature sets 12
meter lock 34
Modbus
  configuring 102, 106
  meter as master 105
  meter as slave 101
  modules for mastering 105
  slave modules 104
  TCP 102
modem connections 87
modem initialization strings 93
ModemGate 94
modes of operation 26
MV-90 149
N
nameplate 24
navigation buttons 21
norm mode 26
  display screens 180
numeric displays 23
O
optical port 21, 82
out of range screen 29
over condition monitoring 201
P
password 32, 53, 104
passwords
to upgrade devices 42
peak demand displays 182
Periodic Timer module 149
phasor diagram 181
phasor diagram displays 24
Power Meter module 48, 138, 139
Pulser module 141
R
Relative Setpoint module 201
S
Sag/Swell module 171
seasons 166
security
  advanced 61
device access for software services 69
  disabling via front panel 33
  modifying password 33
  revenue metering 75
  standard 53
  time sync considerations 52
security setup menu 32
serial com settings 30
serial communications setup 89
setup menu
  accessing via front panel 28
  basic 29
  com ports 30
  configuring using navigation buttons 29
  confirming changes 29
  network setup 31
  returning to previous screen 29
  serial com settings 30
Sliding Window Demand module 123
spare button 22
status bar 23
T
test harness 213
TEST mode
  displays screens 183
  LED energy pulsing 183
  switching to 27, 183
  time out 189
TEST mode button 22
test points 216
test settings 216
Time of Use module 166
TOU displays 182
Transient module 172
U
unit ID 30, 90, 94
upgrading meter 40
V
vector diagram 181
W
Waveform Recorder module 147
web config 56
WebMeter 95
WECO 215
X
XML 14